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Unit-1 Introduction to 3D space 

Introduction 

Welcome to Blender, the free and Open Source 3D animation suite. Blender can be used to 

create 3D visualizations such as still images, video, and real-time interactive video games. 

Blender is well suited to individuals and small studios that benefit from its unified pipeline and 

responsive development process. It is a cross-platform and runs on Linux, macOS, and MS- 

Windows systems with less memory and disk footprint. Its interface uses OpenGL to provide 

a consistent experience across all supported hardware and platforms. 

 
Key Features 

 Blender is a fully integrated 3D content creation suite, offering a broad range of essential 

tools, including Modelling, Rendering, Animation, Video Editing, VFX, Compositing, 

Texturing, Rigging, many types of Simulations, and Game Creation.

 Cross platform, with an OpenGL GUI that is uniform on all major platforms (and 

customizable with Python scripts).

 High-quality 3D architecture enabling fast and efficient creation work-flow.

 Excellent community support from forums and IRC.

 Small executable size, optionally portable.
 

 
Title-Img 1. 1A rendered image being post-processed. 

 

 
Source- blender.org Link- 

https://docs.blender.org/manual/en/dev/getting_started/about/introduction.html 

Despite everything Blender can do, it remains a tool. Talented artists do not create masterpieces 
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by pressing buttons or manipulating brushes, however, by learning and practicing subjects such 

as human anatomy, composition, lighting, animation principles. 

 
3D Content Creation Software such as Blender has the added technical complexity and 

jargon associated with the underlying technologies. Terms like UV maps, Materials, Shaders, 

Meshes, and “Sub surf” are the mediums of the digital artist, and understanding them, even 

broadly, will help you to use Blender to its best. As this is a 3D based software, the navigation 

and the working pattern are very different unlike any other 2D based software. In this Unit, 

you will learn about the Interface of the software. 

 

Outcomes 

Upon completion of this unit you will be able to: 

 Interface and customize elements as the Info Editor (Top), a large 3D View, 

TimeLine(Bottom), Outliner (Top right), properties Editor (Bottom right) etc.

 Experience the Navigation within the 3D space using different Transformation tools and 

the creation of basic meshes (objects) in Blender

 Use Transformation tools in Blender

 Manage Navigation in Space

 Create Basic Primitives

 Work on the Interface

 Create Shortcuts and

 Identify Buttons and Controls

 

Terminology 
 

Header : Header contains various menus and controls based on the current mode. 

Menu : Menu offers tools to navigate in 3D space. 

Mode : 3D view has several modes used for editing different kinds of data. 

Viewport shading : Allows you to change the way objects are displayed in the viewport. 

Transform 

Manipulator: 

: These handy selectors allow you to rotate or move objects by grabbing 

(clicking with your mouse) their controls and moving your mouse in 

the axis. 

Snap : Controls the snapping tools that help with transforming and modelling 

objects. 

Tool Shelf : Tool shelf is a context-sensitive region containing tools depending on 
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  the current mode. 

Properties Region : Properties Region contains properties of the active object and selected 

objects. 

Grid Floor : The grey squares forming a floor mark the zero height of the world. 

Orbit : Rotate the view around the point of interest. 

Roll : Rotate the viewport camera around its local Z axis in 15° discrete steps. 

Introduction to 3D view 

3D View is used to interact with 3D scene for a variety of purposes, such as modeling, 

animation, texture painting, etc. 

Main Region 

One region, which is always visible, is known as the Main Region and is the most prominent 

part of the editor. 

Each editor has a specific purpose, so the main region and the availability of additional regions 

are different between editors. 

Header 

The header contains various menus and controls based on the current mode. 
 

Title-Img 1. 2. 3D View header Attribution 

Attribution- Source- blender.org 

Link-https://docs.blender.org/manual/en/dev/editors/3dview/introduction.html 

Menus 

View This menu offers tools to navigate in 3D space. 

Select Contains tools for selecting objects. 

Add Gives a list of different objects types that can be added to a scene. 

Object This menu appears when in Object Mode. It contains tools to edit objects. In edit mode, 

it will change to the appropriate menu with editing tools. 

Controls Modes The 3D view has several modes used for editing different kinds of data: 
 
 

Object Mode The default mode, available for all object types, as it is dedicated to object data- 

block editing 

Edit Mode A mode available for all renderable object types, as it is dedicated to their “shape” 

Object 
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Pose Mode An armature only mode, dedicated to armature posing. 

Sculpt Mode A mesh-only mode, that enables Blender’s mesh 3D-sculpting tool. 

Particle Edit A mesh-only mode, dedicated to particle systems, useful with editable systems 

(hair). 

 
Arranging the Screen 

Blender uses a novel screen-splitting approach to arrange areas. The idea is that you split up 

the big application window into many number of smaller (but still rectangular) non- 

overlapping areas. That way, each area is always fully visible, and it is very easy to work in 

one area and hop over to work in another. 

 
Changing the Size 

 
You can resize areas by dragging their borders with LMB. Simply move your mouse cursor 

over the border between two areas, until it changes to a double-headed arrow, and then click 

and drag. 

 Splitting and Joining

 Area Split Widget
 

 

 
Title-Img 1. 3. Changing the size Attribution- 

Source- blender.org 

Link-https://docs.blender.org/manual/en/dev/interface/window_system/areas.html 
 

 
In the upper right and lower left corners of an area are the area split widgets, and they look like 

a little ridged thumb grip. It bothsplits and combines areas. When you hover over it, your cursor 

will change to a cross (✛). (Refer Img 1.3) LMB and drag it inward split the area. You define 

the direction of that border by either dragging horizontally or vertically. In order to join two 

areas LMB click and drag the area splitter outward. They must be the same dimension (width 

or height) in the direction you wish to join. This is so that the combined area space results in a 

rectangle. 
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Title-Img 1. 3 Properties Editor is being merged “over” the Outliner. Attribution- 

Source- blender.org 

 
Link- https://docs.blender.org/manual/en/dev/interface/window_system/areas.html 

The area that was closed gets a dark overlaid with an arrow. Now you can select the area to be 

closed by moving the mouse over it. Release the LMB to complete the join. If you press Esc 

or RMB before releasing the mouse, the operation will be aborted. 

 
Area Options 

RMB on the border opens the Area Options. Split Area Shows an indicator line that lets you 

select the area and position where to split. Tab switches between vertical/horizontal. Join Areas 

Shows the join direction overlay. Confirm or cancel works as described above. 

 
Toggle Maximize Area 

 
 

 Menu: View ‣ Toggle Maximize Area

 
 Hotkey: Ctrl-Up, Shift-Spacebar

 
 

The maximized area fills the whole application window. It contains the Info Editor and the 

select area. You can maximize an area with the View ‣ Toggle Maximize Area menu entry. 

To return to normal size use again menu entry, or RMB on the editor’s header and select 

Maximize Area and Tiled Area to return. In the Info Editor header, the Back to Previous button 

on the right of the menus also returns to tiled areas. A quicker way to achieve this is to use the 
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shortcuts: Shift-Spacebar, Ctrl-Down or Ctrl-Up to toggle between maximized and normal 

areas. 

 
Tabs & Panels 

 
 

Tabs 

 
Tabs are overlapping sections in the user-interface. The Tabs header can be vertical (Tool 

Shelf) or horizontal (Properties Editor, User Preferences). Vertical tabs can be switched with 

the Wheel within the tab header and Ctrl-Wheel changes tabs from anywhere in the region. 

 
 

 
Title-Img 1. 4Tools tab (selected), Create, etc 

Source- blender.org 

Link- https://docs.blender.org/manual/en/dev/interface/window_system/tabs_panels.html 
 

 

 

 
Title-Img 1. 5 Horizontal tab header Attribution- Source- blender.org 

Link- https://docs.blender.org/manual/en/dev/interface/window_system/tabs_panels.html 

Panels 

 
The smallest organizational Unit in the user interface is a Panel. Panels can be collapsed to 

hide its contents. They are used in the Properties Editor, but also for example in the Tool Shelf 
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and the Properties region. In the image on the right there are three panels: 
 
 

1. Transform 

 
2. Edit 

 
3. History 

 
The Edit panel is expanded and the other two panels are collapsed. 

 

 

 
Title-Img 1. 6 Tool Shelf panels. Orange: Panel Headers Attribution- 

Source- blender.org 

Link- https://docs.blender.org/manual/en/dev/interface/window_system/tabs_panels.html 

 
Collapsing and expanding 

 
 

A triangle on the left of the title shows the expanded (▼) and collapsed (►) state of the panel. 

 A click with the LMB on the panel header expands or collapses it.

 Pressing A expand/collapses the panel under the mouse pointer.

 A Ctrl-LMB click on the header of a specific panel will collapse all other panels and make 

this the only expanded one.

 Dragging with LMB over the headers will expand or collapse many at once.
 
 

Panel Position 
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You can change the position of a panel within its region by clicking and dragging it with the 

LMB on the grip widget (::::) in the upper right corner. 

 
Pinned Panel Often it is desirable to view panels from different tabs at the same time. This has 

been solved by making panels pinnable. A pinned panel remains visible regardless of which 

tab has been selected. You can pin a panel by Shift clicking its header, or by RMB clicking on 

the header and choosing Pin in the context menu. In the image shown to the right, is an example 

of the Mesh Options pinned in the tools tab. 

 
Zoom 

The zoom factor of a whole region with panels can be changed by Ctrl-MMB clicking and 

moving the mouse anywhere within that region or use the Numpad Plus and Numpad Minus 

to zoom in and out the contents. Pressing Home (Show All) will reset the zooming at the 

screen/panel focused by the mouse pointer. 

 
Alignment 

The alignment of the panels in the Properties Editor can be changed between vertical and 

horizontal. To do this, click with RMB somewhere within the main region of the Properties 

Editor and choose either Horizontal or Vertical from the appearing menu. Keep in mind though 

that the panels are optimized for vertical alignment. 

 
Viewport Shading 

It allows you to change the way objects are displayed in the Viewport. 

Header: Viewport Shading 
 

 

 
Title-Img 1. 7The Viewport Shading menu Attribution- Source- blender.org 

Link- https://docs.blender.org/manual/en/dev/editors/3dview/properties/shading.html 
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Bounding Box 

Only shows rectangular boxes that outline an object’s size and shape. 
 
 

Wireframe 

Objects appear as a mesh of lines representing the edges of faces and surfaces. 
 
 

Solid 

The default drawing mode using solid coloured surfaces and simple lighting. 
 
 

Textured 

Shows meshes with an image applied using the mesh’s active UV Map. For Cycles materials, 

the image is the last one selected in the Node Editor. For other render engine’s, the UV Map’s 

applied face texture will be shown. 

 
Material 

A fast approximation of the applied material. 

 
Rendered 

An accurate representation using the selected Render Engine and lit with the visible scene 

lights. 

Keyboard Shortcut 

 Shortcuts Switches between Wireframe and Solid draw modes. Z

 Switches between the current and Rendered draw modes. Shift-Z

 Switches between Solid and Textured draw modes. Alt-Z
 
 

Except for Rendered, these shading modes are not dependent on light sources in the scene. 

Instead they use a simple default lighting adjusted by the Solid OpenGL Lights controls on the 

System tab of the User Preferences editor. 

The viewport shading controls the appearance of all objects in a scene, but this can be 

overridden for individual objects using the Display panel in their Object Properties. 

3D Space Navigation 

 
Navigating in 3D space is done with the use of both mouse movement and keyboard shortcuts. To 

be able to work in the three-dimensional space that Blender uses, you must be able to change your 

viewpoint as well as the viewing direction of the scene. While describing 3D View editor, most of 



11  

the other editors have similar functions. For example, it is possible to translate and zoom in the 

UV/Image editor. 

 

Orbit 

 Mode: All modes

 
 Menu: View ‣ Navigation ‣ Orbit

 
 Hotkey: MMB, Numpad2, Numpad4, Numpad6, Numpad8, Ctrl-Alt-Wheel

 
Rotate the view around the point of interest. Click and drag MMB on the viewport’s area. If 

you start in the middle of the area and move up and down or left and right, the view is rotated 

around the middle of the area. 

 
To change the viewing angle in discrete steps, use Numpad8 and Numpad2 (which correspond 

to vertical MMB dragging, from any viewpoint), or use Numpad4 and Numpad6 (or Ctrl-Alt- 

Wheel) to rotate the scene around the global Z axis from your current point of view. Finally, 

Numpad9 switches to the opposite side of the view. 

 
Alternatively, if the Emulate 3 button mouse option is select in the User Preferences you can 

press and hold Alt while dragging LMB in the viewport’s area. 

 
Roll 

 Mode: All modes

 Menu: View ‣ Navigation ‣ Roll

 Hotkey: Shift-Numpad4, Shift-Numpad6, Ctrl-Shift-Wheel

Rotate the viewport camera around its local Z axis in 15° discrete steps. 
 

 
Panning 

 
 Mode: All modes

 Menu: View ‣ Navigation ‣ Pan

 Hotkey: Shift-MMB, Ctrl-Numpad2, Ctrl-Numpad4, Ctrl-Numpad6, Ctrl-Numpad8 

Move the view up, down, left and right. To pan the view, hold down Shift and drag MMB in 

the 3D View. For discrete steps, use the hotkeys Ctrl-Numpad8, Ctrl-Numpad2, Ctrl-Numpad4
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and Ctrl-Numpad6 as with orbiting (note: you can replace Ctrl by Shift). For those without a 

middle mouse button, you can hold Shift-Alt while dragging with LMB. 

 
Zooming 

 
 

 Mode: All modes 

 
 Menu: View ‣ Navigation ‣ Zoom 

 
 Hotkey: Ctrl-MMB, Wheel, Numpad Plus, Numpad Minus 

 
 
 

Move the camera forwards and backwards. You can zoom in and out by holding down Ctrl 

and dragging MMB. The hotkeys are Numpad Plus and Numpad Minus. The View  ‣

Navigation sub-menu holds these functions too as well. Refer to the 3D View’s View menu 

image above for more information. If you have a wheel mouse, you can zoom by rotating the 

Wheel. 

 
Zoom Border 

 
 

 Mode: All modes 

 
 Menu: View ‣ Zoom Border 

 
 Hotkey: Shift-B 

 
The Zoom Border tool allows you to specify a rectangular region and zoom in so that the region 

fills the 3D View. You can access this through the View menu, or the shortcut Shift-B, then 

LMB click and drag a rectangle to zoom into. Alternatively you can zoom out using the MMB. 
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Dolly Zoom 
 
 

 Mode: All modes 

 
 Hotkey: Ctrl-Shift-MMB 

 
In most cases its sufficient to zoom the view to get a closer look at something, however, you 

may notice that at a certain point you cannot zoom any closer. This is because, Blender stores 

a view-point that’s used for orbiting and zooming. It works well in many cases, however 

sometimes you want to move the view-point to a different place. This is what Dolly supports, 

allowing you to transport the view from one place to another. You can dolly back and forth by 

holding down Ctrl-Shift and dragging MMB. 

 

Transform Manipulators 

 
These handy selectors allow you to rotate or move objects by grabbing (clicking with your 

mouse) their controls and moving your mouse in the axis. 

 

 

 

 
Title-Img 1. 8 Transform Manipulators Attribution- 

Source- blender.org 

Link-https://docs.blender.org/manual/en/dev/editors/3dview/object/editing/transform/control/manipulators.html 
 

 

 Mode: Object and Edit Modes 

 
 Menu: 

 
 Hotkey: Ctrl-Spacebar 

 
The Transformation manipulator widgets allow mouse controlled translation, rotation and 

scaling in the 3D View. There is a separate manipulator for each operation. Each manipulator 

can be used separately or in combination with the others. 
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Title-Img 1. 9 The different Manipulators Attribution- 

Source- blender.org 

Link- 

https://docs.blender.org/manual/en/dev/editors/3dview/object/editing/transform/control/manipulators.html 
 
 
 
 

Header Controls 

Manipulators can be accessed through the header of the 3D View. 

Axis : Enable/disable the manipulators Ctrl-Spacebar. 

Manipulators: Toggles each of the manipulators. Clicking with Shift-LMB on multiple 

manipulator icons will combine the manipulators. 

Arrow: Translation. 

Arc: Rotation. 

Box: Scale. 
 
 

Basic Transformations 

 
Grab/Move 

 Mode: Object Mode, Edit Mode, and Pose Mode 

 
 Panel: Tool Shelf ‣ Tools ‣ Transform ‣ Translate 

 
 Menu: Object type ‣ Transform ‣ Grab/Move 

 
 Hotkey: G 

 

 
In Object Mode, the grab/move option lets you translate (move) objects. Translation means 

changing location of objects. It also lets you translate any elements that make up the object 
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within the 3D space of the active 3D View. Pressing G activates “Grab/Move” transformation 

mode. The selected object or element then moves freely according to the mouse pointer’s 

location and camera. 

 
You can also move an object by clicking and holding RMB on the object to move it. To confirm 

the action, press LMB. 

 
Rotate 

 
 

 Mode: Object and Edit Modes 

 
 Panel: Tool Shelf ‣ Tools ‣ Transform ‣ Rotate 

 
 Menu: Object/Mesh/Curve/Surface ‣ Transform ‣ Rotate 

 
 Hotkey: R 

 
Rotation is also known as a spin, twist, orbit, pivot, revolve, or roll and involves changing the 

orientation of elements (vertices, edge, face, Object etc.) around one or more axes or the Pivot 

Point 

 
Scale 

 
 

 Mode: Object and Edit Modes 

 
 Panel: Tool Shelf ‣ Tools ‣ Transform ‣ Scale 

 
 Menu: Object/Mesh/Curve/Surface ‣ Transform ‣ Scale 

 
 Hotkey: S 

 
Scaling means changing proportions of objects. Pressing S will enter the Scale transformation 

mode where the selected element is scaled inward or outward according to the mouse pointer’s 

location. The element’s scale will increase as the mouse pointer is moved away from the Pivot 

Point and decrease as the pointer is moved towards it. If the mouse pointer crosses from the 

original side of the Pivot Point to the opposite side, the scale will continue in the negative 
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direction and flip the element. 
 

 

 

 
Title-Img 1. 10 Basic scale usage 

Source- blender.org 

Link- https://docs.blender.org/manual/en/dev/editors/3dview/object/editing/transform/basics.html 

From left to right, the panels show: the original Object, a scaled down Object, a scaled-up 

Object and a scale-flipped Object. 

 
Transform Orientations 

 
 

 Mode: Object and Edit Modes 

 
 Panel: Properties region ‣ Transform Orientations 

 
 Hotkey: Alt-Spacebar 

 
 
 

Orientations affect the behaviour of Transformations: Location, Rotation, and Scale. You will 

see an effect on 3D Manipulator (the widget in the centre of the selection), as well as on 

transformation constraints (like axis locking). This means that, when you press G-X, it will 

constrain to the global X-axis, but if you press G-X-X it will constrain to your Transform 

Orientations X-axis. 

 

 

 
Title-Img 1. 11Transform Orientations selector Attribution- 

Source- blender.org 
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Link- https://docs.blender.org/manual/en/dev/editors/3dview/object/editing/transform/control/orientations.html 

The Orientations options can be set through the Orientation selector in 3D View header, with 

Alt-Spacebar, or in the Transform Orientations panel in the Properties region. 

 
Orientations Global 

The manipulator matches the global axis. When using the Global orientation, the orientation’s 

XYZ matches world’s XYZ axis. When this mode is selected, the local coordinates of the 

object are subjected to the Global coordinates. This is good to place objects in the scene. To 

constrain an axis, press G and the desired axis. To constrain to a local axis, press the desired 

axis two times. The difference between Global and Local, is more noticeable when you have 

an object in which the origin is not located at the exact center of the object, and does not match 

the Global coordinates. 

Local 

The manipulator matches the object axis. 
 
 

Notice that, here, the Manipulator is at a slight tilt (it is most visible on the object’s Y-axis, the 

green arrow). This is due to our 15° rotation of the object. This demonstrates the difference 

between local coordinates and global coordinates. If we had rotated the object 90° along its X- 

axis, we would see that the object’s “Up” is the world’s “Forward” – or the object’s Z-axis 

would now be the world’s Y-axis. This orientation influences many parts of the interface, so it 

is important to understand the distinction. 

 
Normal 

The Z-axis of the manipulator will match the normal vector of the selection. 
 
 

In Object Mode, this is equivalent to Local Orientation, in Edit Mode, it becomes more 

interesting. 

 
As you see, the light blue lines indicate the faces’ normals, and the darker blue lines indicate 

the vertex normals (these were turned on in the N Properties region under Mesh Display  ‣

Normals ‣ Face and Vertex). Selecting any given face will cause our Manipulator’s Z-axis to 

align with that normal. The same goes for Vertex Select Mode. Edge Select is different – A 

selected Edge has the Z-axis aligned with it (so you will have to look at the Manipulator widget 

to determine the direction of X and Y). If you select several elements, it will orient towards 

the average of those normals. 
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A notable example of how this is useful is in Vertex Select Mode: Pick a vertex and then do 

G, Z, Z to tug it away from the mesh and shove it into the mesh. To make this even more 

useful, select a nearby vertex and press Shift-R to repeat the same movement – except along 

that second vertex’s normal instead. 

 
Gimbal 

Uses a Gimbal behaviour that can be changed depending on the current Rotation Mode. 
 

 
Creating Basic Primitives 

 
 

 Mode: Object Mode and Edit Mode 

 
 Panel: Tool Shelf ‣ Create ‣ Add Primitive/Mesh 

 
 Menu: Add ‣ Mesh 

 
 Hotkey: Shift-A 

 
 
 

A common object type used in a 3D scene is a Mesh. Blender comes with several “primitive” 

mesh shapes that you can start modelling from. You can also add primitives in Edit Mode at 

the 3D cursor. If the created object can be removed by hitting delete key. 

 
Undo Hotkey: Ctrl-Z 

Redo Hotkey: Ctrl-Shift-Z 
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Title-Img 1. 12 Blender’s standard primitives Attribution- 

Source- blender.org 

Link- https://docs.blender.org/manual/en/dev/modeling/meshes/primitives.html 
 
 

Unit summary 
In this Unit, you have learnt what is 3D Interface and how to 

 
 

 Work effectively and navigate in 3D space within Blender to manage the work flow 

 
 Customize the user interface to limit the tools and option required for the user in 

Blender. 

 
 Use Hot keys 

 
 Identify buttons and controls 

 
 Interact with 3D scene using 3D View for a variety of purposes, such as modeling, 

animation, texture painting, etc. 

 
 Use the Info Editor at the top, a large 3D View, TimeLine at the bottom, Outliner at the 

top right, properties Editor at the bottom right etc. 
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After learning this Unit, you can download the Open Source Software available on the internet 

for free of cost to practice the possibilities of creating 3D Interface. 

 

Assignment 
 Create a Dining Table with a table lamp using the basic primitives. 

 

Assessment 
 Explain 3D Navigation in Blender 

 Define Primitives. 

 Write a brief note on Transform Manipulator. 

 Describe the types of Viewport Shading. 

 Write a brief note on Track Panel. 

 How are the splitting and arranging widgets used? 

 
Fill in the Blanks 

 
 

1.  allows you to change the way objects are displayed in the viewport. 

2.  tool is used to rotate the view around the point of interest. 

3. Pressing  expand/collapses the panel under the mouse pointer. 

4. In  mode, objects appear as a mesh of lines representing the edges of 

faces and surfaces. 

5. The short cut can be used to grab and move object. 
 
 

Resources 
While studying this Unit, you can browse the internet links for online tutorials and several 

books and training DVDs available in theBlender Storeand on theBlender Cloud. 

 wiki.blender.org 

 archive.org 

 www.blender.org 

 docs.blender.org 
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Unit-2 Introduction to Modeling 

Introduction 

In this Unit, you will learn about the important Tools, which support the work flow in 

Modelling and the many ways of Selecting an Object, Duplicating, Mirroring, etc. Common 

use of Mirroring is to model Half an Object, duplicate it and then use the mirror transform to 

create a reversed version to complete the model. You will also learn how to organize 3D scenes 

by using Layers, as it often becomes exponentially more confusing as they grow more 

complex. Sometimes the artist also needs precise control over how individual Objects are lit, 

and does not want lights for one Object to affect nearby Objects. 

 

Outcomes 

Upon completion of this unit you will be able to: 

 Draw with Selection Tools 

 Select, duplicate and mirror an Object 

 Create Multiple Objects with Mirror and Duplicate 

 Edit Pivot Point 

 Use Snap Tool 

 Organize 3D Scenes using Layers 

 

Terminology 
 

 
Active Object In Object Mode, the last (de)selected item is called the “Active Object” 

Point selection Selecting the Object in the viewport with a RMB. 

Border select With Border Select, you can draw a rectangle while holding down LMB. 

Lasso select Lasso select is used to draw a dotted line around the pivot point of the 

Objects, in Object Mode. 

Circle select Circle Select is used to move with dotted circle through Objects with 

LMB. 

Mirror Mirroring an Object or Mesh selection will create a reversed version of 

the selection. 

Duplicate This will create a visually-identical copy of the selected Object(s). 

Edge Ring In Edge select mode, holding Ctrl-Alt while selecting an edge selects a 

sequence of edges that are not connected. 
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Selection to 

grid 

Snaps the currently selected Object(s) to the nearest grid point. 

Cursor to 

Selected 

Moves the cursor to the centre of the selected Object(s). 

Layers Objects can be placed into one or more “layers” using Object layers. 

Cursor to 

center 

Moves the cursor to the center of the grid. 

 
Work Flow of Modeling 

Object Selection Selections and the Active Object Blender distinguishes between 

two different states of selection: 
 

 

 
Title- Img 2. 1 Unselected Object in black, selected Object in orange, and active Object in yellow. 

 

 
Source-Blender.org 

Link-https://docs.blender.org/manual/en/dev/editors/3dview/object/select ing/introduction.html 
 

 
 In Object Mode, the last (de)selected item is called the “Active Object” and is outlined in 

yellow (the others are orange). There is exactly one active Object at any time (even when 

nothing is selected).

 Many actions in Blender use the active Object as a reference (for example linking 

operations). If you already have a selection and need to make a different Object the active 

one, simply re-select it with Shift-RMB.

 All other selected Objects are just selected. You can select any number of Objects.
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Point Selection 

 The simplest form of Object selection consists of using RMB on it.

 To add to the selection, use Shift-RMB on more Objects.

 If the Objects are overlapping in the view, you can use Alt-RMB to cycle through 

possible choices.

 If you want to add to a selection this way, then the shortcut becomes Shift-Alt-MB.

 To activate an Object that is already selected, click Shift- RMB on it.

 
 To deselect an active Object, click Shift-RMB one time and hence, two clicks if the Object 

is not active. Note that this only works if there are no other Objects under the mouse. 

Otherwise it just adds those to the selection. There appears to be no workaround for this 

bug.

Border Selection 

 Mode: Object Mode and Edit Mode

 
 Menu: Select ‣ Border Select

 
 Hotkey: B

With Border Select you draw a rectangle while holding down LMB. Any Object that lies 

even partially within this rectangle becomes selected. 

 For deselecting Objects, use MMB or Border Select again with holding Shift.

 
 To cancel the selection use RMB.

 

 
Example 

 

 
Title-Img 2. 2 Border selecting in three steps 
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Source-Blender.org 

Link-http://blender-manual- i18n.readthedocs.io/ja/latest/modeling/objects/selecting.html 
 

 
Border Select has been activated in the first image and is indicated by showing a dottedcross- 

haircursor. In the second image, the selection region is being chosen by drawing a rectangle 

with the LMB. The rectangle is only covering two cubes. Finally, in the third image, the 

selection is completed by releasing LMB. 

Notice in the third image, the bright color of left-most selected cube. This means it is the “Active 

Object”, the last selected Object prior to using the Border Select tool. 

 

Lasso Select 

 Mode: Object Mode and Edit Mode

 Menu: no entry in the menu

 Hotkey: Ctrl-LMB
 
 

Lasso select is used by drawing a dotted line around the pivot point of the Objects, in 

Object Mode. 

 

Circle Select 

 Mode: Object Mode and Edit Mode

 Menu: Select ‣ Circle Select

 Hotkey: C

 
Circle Select is used by moving with dotted circle through Objects with LMB. You can select 

any Object by touching of circle area. It is possible to dynamically change the diameter of circle 

by scrolling MMB as seen in Img 2.3 and Img 2.4. Deselection is under the same principle - 

MMB. To cancel the selection use RMB or key Esc. 
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Title- Img 2. 3 Circle selection 

Source-Blender.org 

Link-https://wiki.blender.org/index.php/Doc%3A2.6/Manual/Modeling/Objects/Selecting 
 
 

 

 
 

Title-Img 2. 4 with huge circle 
 
 

Source-Blender.org 

Link-https://wiki.blender.org/index.php/Doc%3A2.6/Manual/Modeling/Objects/Selecting 

 
Menu Selection 

The selection methods described above are the most common. There are also many 

more options accessible through the Select menu of the 3D View. 

Select Grouped 

 Mode: Object Mode
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 Menu: Select ‣ Grouped

 
 Hotkey: Shift-G

 
 

There are two ways to organize the Objects in relation to one another. 

1. Parenting 
 
 

2. Simple grouping 
 
 

Select Grouped uses the Active Object as a base to select all others. 
 

 

Title-Img 2. 5 Select Grouped menu 

 
Source-wiki.Blender.org 

Link-https://wiki.blender.org/index.php/File:25-Manual-Object-Selection-Grouped.png 

 

Mirror Object 

 Mode: Object and Edit Modes

 Menu: Object/Mesh‣ Mirror

 Hotkey: Ctrl-M
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Mirroring an Object or Mesh selection will create a reversed version of the selection. The 

position of the mirrored version of the selection is determined by the Pivot Point. A common 

use of mirroring is to model halfan Object, duplicate it and then use the mirrortransform to 

create a reversed version to complete the model. 

 

 
 

Title- Img 2. 6 Mirroring a Selection 
 
 

 
Source-Blender.org 

Link- https://docs.blender.org/manual/en/dev/editors/3dview/object/editing/transform/mirr or.html 
 
 

 

Duplicate Object 

 
This will create a visually-identical copy of the selected Object(s). The copy is created at the 

same position as the original Object and you are automatically placed in Grab mode. 

This copy is a new Object, which shares some data-blocks with the original Object (by default, 

all the Materials, Textures, and F-Curves), but which has copied others, like the mesh, for 

example. Therefore, this form ofduplicationissometimescalled“shallowlink”, becausenotall 

data- blocks are shared; some of them are “hard copied”! 

 Mode: Edit and Object Modes

 Menu: Object ‣ Duplicate

 Hotkey: Shift-D

 
This will create a visually-identical copy of the selected Object(s). The copy is created at the 

same position as the original Object and you are automatically placed in Grab mode. See the 

example below (Img 2.7). 
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Examples 
 

Title-Img 2. 7 The MeshCone.006 of Object Cone.002 is being edited. 

Source-Blender.org 

Link- https://docs.blender.org/manual/en/dev/editors/3dview/object/editing/duplica tion.html 

The mesh’s unique data-block ID name is highlighted in the Outliner. 
 

The cone in the middle has been 

(1) link duplicated to the left and 

(2) duplicated to the right. 

The duplicated right cone is being edited; the original cone in the middle remains 

unchanged. The Mesh data has been copied not linked. 

Likewise, if the right cone is edited in Object mode, the original cone remains unchanged. The 

new Objects transform properties or data-block is a copy, not linked. 

When the right cone was duplicated, it inherited the material of the middle cone. The material 

properties were linked, not copied. 

Snapping 

 
 Mode: Object and Edit Mode 

 Hotkey: Shift-S 

 

Transform Snapping 
 

Title-Img 2. 8 Magnet icon in the 3D View header (red when enabled) 

Source-Blender.org 
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Link- https://docs.blender.org/manual/en/dev/editors/3dview/object/editing/transform/cont rol/snap.html 

 
The ability to snap Objects and Mesh element to various types of scene elements during 

a transformation is available by toggling the magnet icon (which will turn red) in the 3D 

View’s header buttons. 

Snap Element 

 

Title-Img 2. 9 Snap Element menu 

 
Source-Blender.org 

Link- https://docs.blender.org/manual/en/dev/editors/3dview/object/editing/transform/cont rol/snap.html 

Volume 

Snaps to regions within the volume of the first Object found below the mouse cursor. Unlike 

the other options, this one controls the depth (i.e. Z-coordinates in current view space) of the 

transformed element. By toggling the button that appears to the right of the snap target menu 

(Refer Img 2.10), target Objects will be considered as whole, when determining the volume 

center. 

Face 

Snap to the surfaces of faces in Mesh Objects. It is useful for retopologizing the surface of the 

geometry. 

Edge 

Snap to edges of Mesh Objects. 

 
Vertex 

Snap to vertices of Mesh Objects. 
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Increment 

Snap to grid points. When in Orthographic view, the snapping incrementchangesdepending on 

zoom level. 

 

 

 
Title-Img 2. 10 Various Snap Option 

 

 
Source-Blender.org 

Link- https://docs.blender.org/manual/en/dev/editors/3dview/object/editing/transform/cont rol/snap.html 

 
Pivot Points 

Origin of the 3D model, which is therefore not the physical center of gravity of the Object, but 

rather the pivot point that will identify the location coordinates of the Object in 3D space, and 

in toward which operations (such as rotation and scaling of the entire Object) will be carried 

out, in Object Mode. 

 Mode: Object Mode and Edit Mode 

 Menu: Drop list in the header of the 3D View 
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Title-Img 2. 11 Pivot Point modes 

3D Cursor 

 Mode: Object Mode and Edit Mode 

 Menu: Select from the icon in the 3D View header. 

 Hotkey: . 

The 3D cursor is the most intuitive of the pivot points. With the 3D cursor selected as the 

active pivot point (from either the Editors Header or via.), simply position the 3D cursor and 

then do the required transformation. All rotation and scaling transformations will now be done 

relative to the location of the 3D cursor. The image below shows the difference when rotating an 

Object around the median point (left) and around the 3D cursor (right). 

 

Title- Img 2. 12 Rotation around the 3D cursor compared to the median point. 

Attribution- Source-Blender.org 

Linkhttps://docs.blender.org/manual/en/dev/editors/3dview/object/editing/transform/control/ 

pivot_point/3d_cursor.html 
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Individual Origins 

 Mode: Object Mode and Edit Mode 

 Menu: Select from the pivot-icon icon in the 3D View header. 

 Hotkey: Ctrl-. 

In Object Mode 
 
 

 

Title-Img 2. 13 Rotation around individual origins. 
 

 
Source-Blender.org 

Link- 

https://docs.blender.org/manual/en/dev/editors/3dview/object/editing/transform/control/pivot_point/individual_origins.html?highli 

ght=rotation%20around%20individual%20 origins 

 

 
The OriginofanObjectisshown in the 3D Viewbya smallorangecircle. This is highlighted in 

the image to the right by the red arrow. The origin tells Blender the relative position of that 

Object in 3D space. What you see in the 3D View (vertices, edges etc.) is what makes up the 

Object. 

While the Origin is equivalent to the center of the Object, it does not have to be located in the 

center of the Mesh. This means that an Object can have its center located on one end of the 

Mesh or even completely outside the mesh. For example, the orange rectangle in the image has 

its Origin located on the far left of the mesh. 

Now let us examine: Rotation around the individual origins: 

 The blue rectangle has its Origin located in the center of the mesh, while the orange 

rectangle has its Origin located on the left-hand side. 

 When the Pivot Point is set to Individual Origins, the center of each Object (indicated by 

the red arrow) remains in place while the Object rotates around it in the path shown by the 

black arrow. 
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Title-Img 2. 14 Rotation around individual origins (middle) compared to the median point 

(right) 

 
Source-Blender.org 

Link- 

https://docs.blender.org/manual/en/dev/editors/3dview/object/editing/transform/control/pivot_point/individual_origins.html 
 

 

Title-Img 2. 15 Scaling around individual origins (middle) compared to the 

median point (right). 

Source-Blender.org 

Link- https://docs.blender.org/manual/en/dev/editors/3dview/object/editing/transform/control/pivot_point/individual_origins.html 

Working with Layers 

3D scenes often become exponentially more confusing as they grow more complex. 

Sometimes the artist also needs precise control over how individual Objects are lit, and does 

not want lights for one Object to affect nearby Objects. For this and other reasons below, 

Objects can be placed into one or more “layers”. Using Object layers, you can: 

Selectively display Objects from certain layers in your 3D View, by selecting those layers in 

the 3D View header. This allows you to speed up interface redrawing, reduce virtual-world 

clutter, and help improve your workflow. 

Mode: Object Mode 
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 Panel: Object ‣ Relations 

 Menu: Object ‣ Move to Layer... 

 Hotkey: M 
 

 

Viewing layers 

Blender provides twenty layers whose visibility can be toggled with the small unlabelled buttons 

in the header (Refer Img 2.16, 3D View layer buttons). To select a single layer, click the 

appropriate button with LMB; to select more than one, use Shift-LMB - doing this on an already 

active layer will deselect it. 

 

Title-Img 2. 16 3D View layer buttons. 

 
Source-Blender.org 

Link- https://docs.blender.org/manual/en/dev/editors/3dview/object/properties/rela tions/layers.html 
 
 

To select layers via the keyboard, 

 Step 1: press 1 to 0 (on the main area of the keyboard) for layers 1 through 10 (the top row 

of buttons), and 

 Step 2: Alt-1 to Alt-0 for layers 11 through 20 (the bottom row). Use Shift for multiple 

(de)selection works for these shortcuts too. 

You can select or deselect all Scene Layer buttons at once by pressing \. 

Locking to thescene 

By default, the lock button directly to the right of the layer buttons is enabled. This means that 

changes to the viewed layers affect all other 3D Views locked to the scene 



35  

Multiple Layers 

An Object can exist on multiple layers. For example, a lamp that only lights Objects on a 

shared layer could “be” on layers 1, 2, and 3. An Object on layers 3 and 4 would be lit, whereas 

an Object on layers 4 and 5 would not. There are many places where layer-specific effects 

come into play, especially lights and particles. 

 
Moving Objects between layers 

 

 
Title-Img 2. 17 Layer selection. Source-Blender.org 

Link- https://docs.blender.org/manual/en/dev/editors/3dview/object/properties/relations/la yers.html 
 

To move selected Objects to a different layer, press M and then select the layer you want from 

the pop-up menu. Objects can also be on more than one layer at a time. To have an Object 

on multiple layers, hold Shift while clicking. 
 

Title-Img 2. 18 Selection in the Object tab Source-Blender.org 

Link- https://docs.blender.org/manual/en/dev/editors/3dview/object/properties/relations/la yers.html 
 

 
Another way to view or change a selected Object layer is via the Relations panel, in the Object 

tab. 

 
 
 
 
 
 
 

Title-Img 2. 19 Layers in Object tab, Relations panel. Source-Blender.org 

Link- https://docs.blender.org/manual/en/dev/editors/3dview/object/properties/relations/la yers.html 

 
You will then see the layer buttons in the Relations panel – as before – the Object can be 

displayed on more than one layer by clicking Shift- LMB. 
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Objects in Blender 

The geometry of a scene is constructed from one or more Objects. These Objects can range 

from lamps to light your scene, basic 2D and 3D shapes to fill it with models, armatures to 

animate those models, to cameras to take pictures or video of it all. 

Object Types 

Mesh 

Meshes are Objects composed of Polygonal Faces, Edges and/or Vertices, and can be edited 

extensively with Blender’s Mesh editing tools. 

Curve 

Curves are mathematically defined Objects which can be manipulated with control handles or 

control points (instead of vertices), to manage their length and curvature. 

Surface 

Surfaces are patches that are also manipulated with control points. These are useful for simple 

rounded forms and organic landscapes. 

Metaball 

Meta Objects (or Metaballs) are Objects formed by a mathematical function (with no control 

points or vertices) defining the 3D volume in which the Object exists. Metal Objects have a 

liquid-like quality, where when two or more Metaballs are brought together, they merge by 

smoothly rounding out the connection, appearing as one unified Object. 

Text 

Text Objects create a two-dimensional representation of a string of characters. 

 
Armature 

Armatures are used for rigging 3D models in order to make them poseable and animateable. 

 
Lattice 

Lattices are non-renderable wireframes, commonly used for taking additional control over 

other Objects with help of the Lattice Modifier. 

Empty 

Empties are null Objects that are simple visual transform nodes thatdonotrender.Theyareuseful 
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forcontrollingtheposition or movement of other Objects. 

Speaker 

Speaker brings to scene source of sound. 

Camera 

This is the virtual camera that is used to determine what appears in the render. 

 
Lamp 

These are used to place light sources in the scene. 

 
Force Field 

Force Fields are used in physical simulations. They give simulations external forces, creating 

movement, and are represented in the 3D View editor as small control Objects. 

Group Instance 

Let’s you select from a list of existing Object groups. Once selected, an Empty Object will be 

created, with an instance of the selected group (group duplication active). 

Objects 

The geometry of a scene is constructed from one or more Objects. These Objects can range 

from lamps to light your scene, basic 2D and 3D shapes to fill it with models, armatures to 

animate those models, to cameras to take pictures or video of it all. 

Unit Summary 

In this Unit, you have learnt how to 

 Work with 3D modelling using various options 

 Channelize your work flow that helps you to bring down the complexities of the 

software. 

 Create basic Objects, selection, duplication and mirroring Objects 

 Load the Objects to layers to ensure an organised way of handling complex scenes. 

 Create Object with the knowledge of the pivot 

 Manipulate the pivot using various options to develop more complicated duplication of 

Objects. 

 Arrange the Object precisely using one of the most important features of the software 

“snap” which gives us more flexibility. 



38  

After learning this Unit, you can download the Open Source Software available on the internet 

for free of cost to practice the possibilities of creating 3D Objects 

Assignment 

 Create “House model” with proper interiors using the basic primitives looking at 

the given image. 

No need to add colors to the model. (you can do it after learning the texturing unit)The total 

length of the video should be 2-5 minutes. 

Assessment 

1. Explain the various Selection Modes in Blender. 
 

2. Describe the Method of Duplication and Mirror. 
 

3. Describe the Uses of Layers. 
 

4. Why do we need Snap Tool, explain? 
 

5. Write a brief note on the Object Types in Blender. 
 

6. Explain any three types of Snap Options. 

Fill in the Blanks 
 

1. In Object Mode, the last (de)selected item is called the . 

2. The simplest form of Object Selection consists of using  on it. 

3. The icon is used to Snap Objects and Mesh element to several types of scene 

elements. 

4.  will identify the location coordinates of the Object in 3D space. 

5. Circle Select is used by moving with dotted circle through Objects with 

 . 

Resources 

While studying this Unit, you can browse the internet links for tutorials and several books and 
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training DVDs available in the Blender Store and on the Blender Cloud. 

 wiki.blender.org 

 archive.org 

 www.blender.org 

 docs.blender.org 
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Unit-3  Inorganic Modeling 
 

Introduction 

Curves and Surfaces are very important for Modeling. 

Curves and Surfaces are types of Blender Objects. They are expressed by mathematical 

functions rather than a series of points. Using the specific features of both Bezier and NURBs 

curves, you will create a model in 3D, and explore how they are computed behind the scenes 

than how they appear from a modeler’s perspective. 

Bezier curves are generally more intuitive because they start and end at the control points that 

you set, but NURBs curves are more efficient for the computer to calculate when there are 

many twists and turns in a curve. 

Curves are 2D objects, and Surfaces are their 3D extension. Note however, that in Blender, 

you only have NURBS Surfaces, no Bezier. Even though curves and Surfaces share the same 

object type, they are not the same thing; For example, you cannot have in the same object both 

curves and Surfaces. 

In this Unit, you will learn the usage of Curves and Surfaces for modeling. 

Outcomes 

Upon completion of this unit you will be able to: 

 Create and work with Curves.
 

 Edit the Curves using different Modes.
 

 Working Surface modeling.
 

 Create Objects using Curves and
 

 Prepare Curve Deformation and Curve Extrusion
 
 

Terminology 

Bezier Curve: Adds an open 2D Bezier curve with two control points. 

Bezier Circle: Adds a closed, circle-shaped 2D Bezier curve (made of four control 
points). 

NURBS Curve: It adds an open 2D NURBS curve, with four controls. 

NURBS Circle: It adds a closed, circle-shaped 2D NURBS curve (made of eight control 
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points). 

Path: It adds a NURBS open 3D curve made of five aligned control points, with Endpoint 
knots and the Curve Path setting enabled. 

NURBS: Non-Uniform Rational B-Splines. 

Extrude: Will extrude the curve along both the positive and negative local Z axes. 

Bevel Depth: Changes the size of the bevel. 

Subdividing: Curve subdivision simply subdivides all selected segments by adding one or 
more control points between the selected segments. 

Duplication: This command duplicates the selected control points, along with the curve 
segments implicitly selected (if any). 

Separating Curves: Curve objects that are made of multiple distinct, curves can be separated 
into their own objects by selecting the desired segments. 

Fill: Fill determines the way a Curve is displayed when it is bevelled. 

 

Introduction to Curves and Surfaces Curves 

Bézier Curves 

 
The main elements used in editing Bezier Curves are the Control Points and Handles. 

Control Points 

A Segment (the actual Curve) is found between two Control Points. 

In the image below (Img 3.1), the Control Points can be found in the middleofthepinkline 

while the Handles comprise the extensions from the Control Point. 

By default, the arrows on the Segment represent the direction and relative speed and direction 

of movement Objects will have when moving along the curve. This can be altered by defining 

a custom F- Curve. 

Title-Img 3. 1 Bezier Curve in Edit Mode. 

Source-Blender.org 

Link-http://blender-manual- i18n.readthedocs.io/ja/latest/modeling/curves/introduction.html?highlight=Bezier%20C  

urve%20in%20Edit%20Mode. 
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Editing Bézier Curves 

A Bézier curve can be edited by moving the locations of the Control Points and Handles: 

 Step 1: Add a Curve by Shift-A to bring up the Add menu, followed by

Curve ‣ Beziers. 

 Step 2:Press Tab to enter Edit Mode.

 Step 3: Select one of the Control Points and move it around. Use LMB to confirm the 

new location of the Control Point, or use RMB to cancel.

 Step 4: Now select one of the Handles and move it around. Notice how this change the 

curvature of the curve. 

To add more Control Points: 

 Step 1: Select at least two adjacent Control Points. 
 

 Step 2: Press Wand select Subdivide. 

 
Optionally, you can press F6 immediately after the subdivision to modify the number 

of subdivisions 

 
 

Handles 

 
There are Four Bézier Curve Handle types. They can be accessed by pressing V and selecting 

from the list that appears, or by pressing the appropriate hotkey combination. Handles can be 

rotated, moved, scaled and shrunk/fattened like any vertex in a Mesh. 

Bézier Curve Handle Types 

1. Automatic V-A 

 
This handle has a completely automatic length and direction which is set by Blender to ensure 

the smoothest result. These handles convert to Aligned handles when moved. 

 

 
Title-Img 3. 2 Bezier handle type. 

Source- 
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Link-http://blender-manual- i18n.readthedocs.io/ja/latest/modeling/curves/introduction.html?highlight=Bezier%20C  

urve%20in%20Edit%20Mode. 

2. Vector V-V 

Both parts of a handle always point to the previous handle or the next handle which allows you 

to create curves or sections thereof made of straight lines or with sharp corners. Vector handles 

convert to free handles when moved. 

 

Title-Img 3. 3 Bezier handle type. 
 
 

Source-Blender.org 

Link-http://blender-manual- i18n.readthedocs.io/ja/latest/modeling/curves/introduction.html?highlight=Bezier%20C  

urve%20in%20Edit%20Mode. 
 

 
3. Aligned V-L 

 
These handles always lie in a straight line, and give a continuous curve without sharp angles. 

 
 

Source-Blender.org 

Link-http://blender-manual- i18n.readthedocs.io/ja/latest/modeling/curves/introduction.html?highlight=Bezier%20C  

urve%20in%20Edit%20Mode. 

 
4. Free V-F 

 
The handles are independent of each other. 

 

Title-Img 3. 5 Bezier handle type. 

Source-Blender.org 

Link-http://blender-manual- i18n.readthedocs.io/ja/latest/modeling/curves/introduction.html?highlight=Bezier%20C  

urve%20in%20Edit%20Mode. 
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Additionally, the V-T shortcut can be used to toggle between Free and Aligned handle 

types. 

 

NURBS Curves 

One of the major differences between Bézier Objects and NURBS Objects is that Bézier 

Curves are approximations. 

For example, a Bézier circle approximates a circle, whereas a NURBS circle is an exact 

circle.In practice, many of the Bézier curve operations discussed above apply to NURBS 

curves in the same manner. The following text will concentrate only on those aspects that are 

unique to NURBS curves. 

 

Editing NURBS Curve 

A NURBS Curve is edited by moving the location of the Control Points: 

 Step 1: Place a Curve by Shift-A to bring up the Add menu, followed by

Curve ‣ NURBS curve. 

 Step 2:Press Tab to enter Edit Mode. 

 Step 3: Select one of the Control Points and move it around. Use LMB to confirm the 

new location of the Control Point, or use RMB to cancel.

To add additional Control Points 

 Step 1: select both the Control Points

 Step 2: press Wand

 Step 3: select Subdivide.

 Step 4: Press F6 immediately after to determine how many subdivisions to make.

 

Transform Tools 
 

Deforming Tool 

 Mode: Edit Mode

 Menu: Curve ‣ Transform

 
The Shear, Warp and Push/Pull transform tools are described in the Transformations sections. 

The two other tools, Tilt and Shrink/Fatten Radius are related to Curve Extrusion. 
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Smoothing Tool 

 Mode: Edit Mode

 Hotkey: W ‣ smooth

 
Curve smoothing is available through the specials menu. For Bézier curves, this smoothing 

operation reduces the distance between the selected control point/s and their neighbors, while 

keeping the neighbors anchored. Does not affect control point tangents. 

 
 

Mirror Tool 

 Mode: Edit Mode

 Menu: Curve ‣ Mirror

 Hotkey: Ctrl-M

 
The Mirror tool is also available, behaving exactly as with Mesh vertices. Set Bézier 

Handle Type 

 Mode: Edit Mode 

 Panel: Curve Tools ‣ Handles 

 Menu: Curve ‣ Control Points ‣ Set Handle Type 

 Hotkey: V 

 
Handle types are a property of Bézier curves that can be used to alter features of the curve. 

For example, switching to Vector handles can be used to create curves with sharp corners. 

Read the Bézier curves page for more details. 

Extending Curves 

 Mode: Edit Mode 

 Menu: Curve ‣ Extrude 

 Hotkey: Ctrl-LMB, E 
 
 

Once a curve is created you can add new segments (in fact, new control points defining new 

segments), either by extruding, or placing new handles with Ctrl-LMB. Each new segment is 

added to one end of the curve. The Bézier curve can only be extend at the endpoints. Ctrl- 

LMB on inner control points will make unconnected duplicates. 
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Subdivision 

 Mode: Edit Mode

 Panel: Curve Tools

 Menu: Surface tools ‣ Modeling ‣ Subdivide

 Hotkey: W

Curve subdivision simply subdivides all selected segments by adding one or more control 

points between the selected segments. To control the number of cuts, press W to make a 

single subdivision. Then press F6 to bring up the Number of Cuts menu. 

Duplication 

 Mode: Edit Mode

 Menu: Curve ‣ Duplicate

 Hotkey: Shift-D

This command duplicates the selected control points, along with the curve segments implicitly 

selected (if any). The copy is selected and placed in Grab mode, so you can move it to another 

place. 

Joining Curve Segments 

 Mode: Edit Mode

 Menu: Curve ‣ Make Segment

 Hotkey: F

Two open curves can be combined into one by creating a segment between the two curves. 

To join two separated curves, select one end control point from each curve then press F. The 

two curves are joined by a segment to become a single curve. 

Separating Curves 

 Mode: Edit Mode

 Menu: Curve ‣ Separate

 Hotkey: P

 
Curve objects that are made of multiple distinct curves can be separated into their own objects 

by selecting the desired segments and pressing P. Note, if there is only one curve in a Curve 

object, pressing P will create a new Curve object with no control points. 

Deleting Elements 

 Mode: Edit Mode

 Menu: Curve ‣ Delete...
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 Hotkey: X, Delete

 Selected: This will delete the selected control points, without breaking the curve (i.e. 

the adjacent points will be directly linked, joined, once the intermediary ones are 

deleted).

 
 Segment: This option is somewhat the opposite to the preceding one, as it will cut the 

curve, without removing any control points, by erasing one selected segment.

 
Opening and Closing a Curve 

 Mode: Edit Mode

 Menu: Curve ‣ Toggle Cyclic

 Hotkey: Alt-C

This toggles between an open curve and closed curve (Cyclic). Only curves with at least one 

selected control point will be closed/open. The shape of the closing segment is based on the 

start and end handles for Bézier curves, and as usual on adjacent control points for NURBS. 

The only time a handle is adjusted after closing is if the handle is an Auto one. Open and 

Closed curves is the same Bézier curve open and closed. 

 
Curve Extrution 

 Mode: Object or Edit Mode

 Panel: Curve and Surface

 Extrude

Turns a one-dimensional curve into a two-dimensional curve by giving it height. Note that 

this is not related to Extrude used in Mesh edit-mode. With a scale of one, an Extrusion of 0.5 

will extrude the curve 0.5 BU in both directions, perpendicular to the curves normals. 

Title-Img 3. 6 Curve Extrution 

Attribution- Source-Blender.org 

Link-https://easyblend.org/html/modeling/curves/editing/extrude.html 
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Tilt This setting controls how the normals (visualization: arrows) twist around each control 

point – so it is only relevant with 3D curves! You set it using the Tilt transform tool in the T 

tool shelf, the N ‣ transform ‣ Mean tilt, or Curve ‣ Transform ‣ Tilt. 

You can also reset it to its default value (i.e. perpendicular to the original curve plane) with 

Alt-T, Curve ‣ Control Points ‣ Clear Tilt. 

With NURBS, the tilt is always smoothly interpolated. However, with Bézier, you can 

choose the interpolation algorithm between Linear, Ease, B-Spline, and Cardinal, in the 

Properties Editor ‣ Object Data ‣ Active Spline ‣ Tilt 

 

 

 
Title-Img 3. 2 30-degree Mean Tilt of all control points. 

 
 

Source-Blender.org 

Link-https://easyblend.org/html/modeling/curves/editing/extrude.html 

Bevel Depth 

This will add a bevel to the Extrusion. Refer Img 3.8 for its effects... Note that the bevel makes 

the Extrusion wider and higher. If set to 0.0, there is no bevel. 
 

Title-Img 3. 3Bevel depth of 0.25, fill set to full, zero Mean Tilt. 
 
 

Source-Blender.org 
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-1 Offset, 0.5 Extrusion, 0.25 Bevel Depth, 
10 Bevelresolutions 

Link-https://easyblend.org/html/modeling/curves/editing/extrude.html 
 
 

Bevel Resolution 

It controls the resolution of the bevel created by a Bevel Depth higher than zero. Ifset theto0 

(thedefault), thebevelisasimple“flat”Surface. Higher values will smooth, round off the bevel, 

similar to the resolution settings of the curve itself. 
 

 
Title-Img 3. 4 Bevel resolution set to 10. 

 
 

Source-Blender.org 

Link-https://easyblend.org/html/modeling/curves/editing/extrude.html 

 
 

Offset 

Offset Moves the Extrusion parallel to the curve normal. Almost like scaling 
 

Radius 

The Radius allows you to directly control the width of the Extrusion along the “spinal” 

curve. The Radius of the points is set using the Shrink/Fatten Radius transform tool Alt- 

S, the Curve ‣ Transform ‣ 

Shrink/Fatten Radius, or the N ‣ transform ‣ Radius. 
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Title-Img 3. 5 One control point radius set to zero 

 

 
Source-Blender.org 

Link-https://easyblend.org/html/modeling/curves/editing/extrude.html 

 
 

Three Sub-Classes ofCurve: 

 
We have three sub-classes of results, depending on whether the curve is open or closed or 

3D. 

 

Open 2D Curve 

The Extrusion will create a “wall” or “ribbon” following the curve shape. If using a Bevel 

Depth, the wall becomes a sort of slide or gutter. If your normals are facing the wrong way 

you can switch their direction as shown here. 

Title-Img 3. 6 Open 2D Curve with Alt-C, fill set to none, zero offset, 0.5 Extrusion, 0.25 Bevel 

Depth, 10 Bevel resolution. 

 
Source-Blender.org 

Link-https://docs.blender.org/manual/en/dev/modeling/curves/properties/geometry.html 
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Closed 2D Curve 
 

This is probably the most useful situation, as it will quickly create a volume, with (by default) 

two flat and parallel Surfaces filling the two sides of the extruded “wall”. You can remove one 

or both faces by choosing the fill mode: both, front, back, or none. 

The optional bevel depth will always create a 90 degree bevels here. 
 

 

 
Title-Img 3. 7 Closed 2D Curve, 0.5 extrude, 0.25 Bevel Depth, 10 Bevel resolution, Fill: Both. 

 
 

Source-Blender.org 

Link-https://docs.blender.org/manual/en/dev/modeling/curves/properties/geometry.html 

 
Advanced Extrution 

These Extrusions use one or two additional curve objects, to create very complex organic 

shapes. 

To enable this type of Extrusion, you must type a valid curve object name in the Bevel Object 

field of the curve you are going to use as the “spinal column” of your Extrusion. The “bevel” 

curve will control the cross section of the extruded object. Whether the Bevel Object curve is 

2Dor 3D hasnoimportance, butifitisclosed, itwillcreatea“tube-like” Extrusion; otherwise you 

will get a sort of gutter or slide object... 

The object is extruded along the entire length of all internal curves. By default, the width of the 

Extrusionisconstant, but you have two ways to control it, 

1. Radius property of control points 

2. Taper Object. 
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Taper Curve 

 
Taper Curve is evaluated along the local Xaxis, using the local Y axis for width control. Note 

also that: 

It must be an open curve. 

The taper is applied independently to all curves of the extruded object. 

Only the first curve in a Taper Object is evaluated, even if you have several separated 

segments. 

The scaling starts at the first control-point on the left and moves along the curve to the last 

control-point on the right. 

Negative scaling, (negative local Y on the Taper Curve) is possible as well. However, 

rendering artifacts may appear. 

It might need to increase the curve resolution to see more detail of the taper. 

With closed curves, the Taper Curve in Taper Object acts along the whole curve (perimeter of 

the object), not just the length of the object, and varies the Extrusion depth. In these cases, you 

want the relative height of the Taper Object Taper Curve at both ends to be the same, so that 

the cyclic point (the place where the endpoint of the curve connects to the beginning) is a 

smooth transition. 

Let us taper a simple curve circle extruded object using a Taper Curve. 

 Step 1: Add a curve, 

 Step 2: Then exit Edit Mode. 

 Step 3: Add another one (a closed one, like a circle); 

 Step 4: Call it “Bevel Curve”, 

 Step 5: Enter its name in the Bevel Object field of the first curve (Curve and Surface 

tab). We now have a pipe. 

 Step 6: Add a third curve while in Object Mode and 

 Step 7: Call it “Taper Curve”. 

 Step 8: Adjust the left control-point by raising it up about 5 units. 

 Step 9: Now return tothe Object tab, 

 Step 10: Edit the first curve’s Taper Object field in the Curve and Surface panel to 

reference the new Taper Curve which we called “Taper Curve”. 

When you hit enter the Taper Curve is applied immediately, with the results shown in Img  

3.13 Circle curve set as Bevel Object. 
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Title-Img 3. 8Taper curve 
 

Source-Blender.org 

Link-https://docs.blender.org/manual/en/dev/modeling/curves/properties/geometry.html 
 

 
You can see the Taper Curve being applied to the extruded object. Notice how the pipe’s 

volume shrinks to nothing as the Taper Curve goes from left to right. If the Taper Curve went 

below the local Y axis the pipe’s inside would become the outside, which would lead to 

rendering artifacts. Of course, as an artist, that may be what you are looking for! 

Taper Examples 

 

Title-Img 3. 9Taper example 1. 
 

 
Source-Blender.org 

Link-  https://docs.blender.org/manual/en/dev/modeling/curves/properties/geometry.html 

 

 
In Taper example 1 (Img 3.14), You can clearly see the effect the left Taper Curve has on the 

right curve object. Here the left Taper Curve is closer to the object center and that results in a 

smaller curve object to the right. 
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Title-Img 3. 10Taper example 2. 

 

 
Source-Blender.org 

Link-  https://docs.blender.org/manual/en/dev/modeling/curves/properties/geometry.html 

 
In Taper example 2 (Img 3.15), A control point in the Taper Curve to the left is moved away 

from the center and that gives a wider result to the curve object on the right. 
 

Title-Img 3. 11 Taper example 3. 
 

 
Source-Blender.org Link- 

https://docs.blender.org/manual/en/dev/modeling/curves/properties/geometry.html 

 
In Taper example 3 (Img 3.16), We see the use of a more irregular Taper Curve applied to a 

curve circle. 

 
 
 
 
 
 
 
 
 
 

 
Title-Img 3. 12 Bevel Extrusion with Tilt example. 

Source-Blender.org 
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Link-https://docs.blender.org/manual/en/dev/modeling/curves/properties/geometry.html 

Surfaces 

Surface Editing 

 
Curves are 2D objects, and Surfaces are their 3D extension. Note however, that in Blender, 

you only have NURBS Surfaces, no Bezier (you have the Bezier knot type, though; see below), 

nor polygonal (but for these, you have Meshes!). Even though curves and Surfaces share the 

same object type (with texts also...), they are not the same thing; for example, you cannot have 

in the same object both curves and Surfaces. 
 

Title-Img 3. 13Nurbs Surface in edit mode 

Source-Blender.org 

Link-https://docs.blender.org/manual/en/dev/modeling/surfaces/introduction.html 

 
Nurbs Surface in Edit Mode 

You may ask yourself “The Surface appears to be 3D, why is it only 2D?” In order to be 3D, 

the object needs to have “Volume”, and a Surface, even when it is closed, does not have volume; 

it is infinitely thin. If it had a volume the Surface would have a thickness (its third dimension). 

Hence, it is only a 2D object, and has only two interpolation dimensions or axes or coordinates 

(if you know a bit of math, think of non-euclidean geometry – well, Surfaces are just non- 

euclidean 2D planes...). 
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Primitives 

To get started in creating Surfaces, there are four preset NURBS Surfaces, found in the Add 

‣ Surface as 

1. NURBS Surface 

 
2. NURBS Tube 

 
3. NURBS Sphere 

 
4. NURBS Torus 

 

 
Title-Img 3. 14 NURBSSurface primitives. 

Source-Blender.org 

Link- https://docs.blender.org/manual/en/dev/modeling/surfaces/primitives.html#comm on-options 

Properties 
 

Title-Img 3. 15 Surface Properties. 
 

 
Source-Blender.org 

Link-https://docs.blender.org/manual/en/dev/modeling/surfaces/properties.html 
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Shape 

 

Title-Img 3. 16 Shape panel. 
 

 
Source-Blender.org 

Link-https://docs.blender.org/manual/en/dev/modeling/surfaces/properties.html 

 
You can adjust the resolution separately for both preview and render, to not slow things 

down in the viewport, but still get good render results. 

Preview 

U, V 

 
Render 

U, V 

Bezier Endpoint 

Just like with NURBS curves, NURBS Surfaceshavetwoknotvectors, one for each U and V axis. 

Here again, they can be one of Cyclic, Endpoint, or Bezier, with the same properties as for 

curves. And as with curves, only Open Surfaces (in the relevant direction) are affected by this 

setting. 

 

Title-Img 3. 17Endpoint U. 
 

 
Source-Blender.org 

Link-https://docs.blender.org/manual/en/dev/modeling/surfaces/properties.html 
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In Img 3.22 Endpoint U, the Uinterpolation axis islabeled as “U” andthe V interpolation axis is 

labeled as “V”. The U’s interpolation axis has been set to Endpoint and as such the Surface now 

extends to the outeredges from E1 to E2 along the U interpolation axis. 

Adding or Extruding 

 Mode: Edit Mode 

 Menu: Surface ‣ Extrude 

 Hotkey: E, Ctrl-LMB 

 
Unlike Meshes or curves, you cannot generally directly add new control points to a Surface 

(with Ctrl-LMB clicks), as you can only extend a Surface by adding a whole U- or V-row at 

once. The only exception is when working on a NURBS Surface curve, i.e. a Surface with only 

one control point on each U- or V-row. In this special case, all works exactly as with curves. 

Most of the time, only Extrusion is available. As usual, once the tool is activated the Extrusion 

happens immediately and you are placed into Grab mode, ready to drag the new extruded 

Surface to its destination. 

There are two things very important to understand: 

Surfaces are 2D objects. So, you cannot extrude anything inside a Surface (e.g. “inner” row); it 

wouldnotmakeanysense! 

 
The control “grid” must remain “squarish”, which means that youcanonlyextrudeawholerow,not 

partsofrowshereand there. 

To summarize, the Extrude tool will only work, when only one whole border row is selected, 

otherwise nothing happens. 

Examples 

Selecting control-point to show a typical Extrusion along the side of a Surface. 

In Img 3.23, Selecting control-point and Shift-R, a border row of control points was 

highlighted by selecting a single control point, and then using the handy row select tool Shift- 

R to select the rest of the control points. 
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Title-Img 3. 18 Selecting control point 

Source-Blender.org 

Link-https://docs.blender.org/manual/en/dev/modeling/surfaces/editing.html 
 

 
The edge is then extruded using E as shown in Img 3.24 Extruding. Notice how the Mesh has 

bunched up next to the highlighted edge. That is because the new extruded Surface section is 

bunched up there as well. 

 

 

Title-Img 3. 19 Extruding 

Source-Blender.org 

Link-https://docs.blender.org/manual/en/dev/modeling/surfaces/editing.html 
 

 
By moving the new section away from the area, the Surface begins to “un-bunch”. 

You can continue this process of extruding or adding new Surface sections until you have 

reached the final shape for your model. 
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Deleting Elements 

 Mode: Edit Mode 

 Menu: Curve ‣ Delete... 

 Hotkey: X, Delete 

 
The Erase pop-up menu of Surfaces offers an option: 

 Selected 

 
This will delete the selected rows, without breaking the Surface (i.e. the adjacent rows will be 

directly linked, joined, once the intermediary ones are deleted). The selection must abide by 

the following rules: 

Whole rows, and only whole rows must be selected. Only rows along the same axis must be 

selected (i.e. you cannot delete both U- and V-rows at the same time). 

 

 
Example 

 

 

Title-Img 3. 20 Before and After 
 

Source- Blender.org 

Link-https://docs.blender.org/manual/en/dev/modeling/surfaces/editing.html 

 
In Img 3. 21 Before and after (left) a row of control points has been selected by initially selecting 

the one control point and using Shift-R to select the remaining control points. Then, using the 

Delete Menu X, the selected row of control points is erased, resulting in Img 3. 22 Before and after 

(right). 
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Joining or Merging Surfaces 

 Mode: Edit Mode 

 Menu: Surface ‣ Make Segment 

 Hotkey: F 

 
This command is equivalent to creating edges or Faces for Meshes (hence its shortcut), and so 

it only works in Edit Mode. The selection must contain only border rows of the same 

resolution (with the same number of control points), else Blender will try to do its best to guess 

what to merge with, or the merge will fail (either silently, or stating that Resolution does not 

match if rows with different number of points are selected, or that there are too few selections 

to merge if you only selected points in one Surface). 

Examples 

Title-Img 3. 23 Before and After 

 
Source-Blender.org 

Link-https://docs.blender.org/manual/en/dev/modeling/surfaces/editing.html 

Unit summary 

In this Unit, you have learnt what is 3D Interface and how to 

 Create Objects and work with Curves and Surfaces in Blender

 Edit the Curves and Surfaces using different Modes in Blender

 Work with Surface modelling

 Work with Nurbs modelling

 Work effectively with 2D shapes

 Prepare Curve Deformation and Curve Extrusion

After learning this Unit, you can download the Open Source Software available on the 

internet for free of cost to practice the possibilities of creating 3D Interface. 

Assignment 
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 Create a Flower Vase, a Wine Glass and a Cup using Nurbs curves

Assessment 

 Explain Nurbs Modelling.

 Write a brief note on the Editing methods in Curve.

 Explain Bezier handle types.

 Describe the properties of 2D and 3D shapes. Write a brief note on Extending curves 

Explain the types of Curve Extrusion

Fill in the Blanks 

1.  are the most commonly used curves for designing letters or logos. 

 
2.  turns a one-dimensional curve into a two-dimensional curve by giving it 

height. 

3.  moves the Extrusion parallel to the curve normal. 

 
4.  allows you to directly control the width of the Extrusion along the 

“spinal” curve. 

5.  handle has a completely automatic length and direction which is set by 

Blender to ensure the smoothest result. 

 

Resources 

While studying this Unit, you can browse the internet links for online tutorials and several 

books and training DVDs available in the Blender Store and on the Blender Cloud. 

 wiki.blender.org 

 archive.org 

 www.blender.org 

 docs.blender.org 



63  

Unit 4 Organic Modeling 
 

Introduction 

In this Unit, you will learn the creation of a 3D scene and the usage of three key 

components to create the real-time geometry Modelling in Blender. 

You will also learn to use the specific features of your chosen 3D software, each one of these 

Primitives can be manipulated to produce an Object. You will create a model in 3D, and 

explore the various modelling methods used in the production. 

There are three basic methods that will be used to create a 3D model, and you will understand 

how to create a model using each technique. 

 

Outcomes 

Upon completion of this unit you will be able to: 

 Create Object with 3D Primitives 

 Edit the Object with different Modes 

 Mesh Modelling 

 Create Polygon Objects 

 Analyse the Mesh 

 

Terminology 
 

Structure: With Meshes, everything is built from three basic structures: Vertices, Edges 
and Faces. 

Vertices: A vertex is primarily a single point or position in 3D space. 

Edges: An edge always connects two vertices by a straight line. 

Faces: Faces are used to build the actual surface of the Object. 

Loops: Edge and Face Loops are sets of faces or edges that form continuous 
“loops”. 

Edge Lops: Loops (1 and 2) in Img 4. 1 Edge and Face Loops are edge Loops. 

Face Lops: These are a logical extension of Edge Loops in that they consist of the 
faces between two Edge Loops. 
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Edge Ring: In Edge select mode, holding Ctrl-Alt while selecting an edge selects a 
sequence of edges that are not connected. 

 
Subdividing: 

 
Technique for adding more geometry to a Mesh. It creates new vertices on 
subdivided edges, new edges between subdivisions and new faces based on 
new edges. 

 
Tessellation: 

 
The tiling of a plane using one or more geometric shapes usually 
resulting in Micro polygons. 

Coplanar: Refers to any set of elements that are all aligned to the same 2D plane in 
3D space. 

Modeling Modes 

3D View has three principal modes that allow for the creation, editing and manipulation of 

the Mesh models. Each of the three modes has a variety of tools. Some tools may be found in 

one or more of the modes. 

Modes used forModeling 

Creation of a Mesh Primitive typically starts by adding a Mesh Object in Object Mode. Limited 

types of editing such as size, location, and orientation can be accomplished in Object Mode. 

Object Mode also provides the means to Join and Group Multiple Mesh Primitives. 

 Object Mode 

 Edit Mode 

 Sculpt Mode 

More detailed editing of the Mesh model shape is done in Edit Mode, and Sculpt Mode. The 

nature of these three modes determines the tools that are available within the various panels of 

3D View. Switching between modes while Modelling is common. Some tools may be available 

in more than one mode while others may be unique to a particular mode. 

You can work with Geometric Objects in two modes. 

Object Mode 

Object Mode Operations in Object Mode affect the whole Object. Object Mode has the 

following header in 3D View: 

 

Title-Img 4. 1 Object Mode Header. 
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Source-Blender.org 

Link-https://docs.blender.org/manual/en/dev/modeling/meshes/introduction.html 

 
Edit Mode 

Operations in Edit Mode affect only the geometry of an Object, but not global properties such 

as location or rotation. Edit Mode has the following header in 3D View: 

 

Title-Img 4. 2 Edit Mode Header. 

Source-Blender.org 
Link-https://docs.blender.org/manual/en/dev/modeling/meshes/introduction.html 

 
Visualization 

 

Title-Img 4. 3 One cube selected 

Source-Blender.org 
Link-https://docs.blender.org/manual/en/dev/modeling/meshes/introduction.html 

 

Title-Img 4. 4 Two cube selected before entering edit mode 
 

 
Source-Blender.org 

Link-https://docs.blender.org/manual/en/dev/modeling/meshes/introduction.html 
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By default, Blender highlights selected geometry in orange in both Object Mode and Edit 

Mode. 

 In Object Mode with Wireframe shading enabled Z, Objects are displayed in black when 

unselected and in orange when selected. If more than one Object is selected, all selected 

Objects except the active Object, typically the Object last selected, are displayed in a 

darker orange color. Similarly, in Edit Mode, unselected geometry is drawn in black 

while selected faces, edges, or vertices are drawn in orange. The active face is highlighted 

in white. 

 In Edit Mode, only one Mesh can be edited at the time. However, several Objects can be 

joined into a single Mesh (Ctrl-J in Object Mode) and then separated again (P in Edit 

Mode). If multiple Objects are selected before entering Edit Mode, all the selected Objects 

remain highlighted in orange indicating that they are part of the active selection set. 

If two vertices joined by an edge are selected in Vertex selection mode, the edge between them 

is highlighted too. Similarly, if enough vertices or edges are selected to define a face, that face 

is also highlighted. 

 

Tool Shelf 
 
 

Title-Img 4. 5 The Tool Shelf panel in edit mode. 

Attribution- Source-Blender.org 

Link-https://docs.blender.org/manual/en/dev/modeling/meshes/introduction.html 

 
Open/Close the Mesh Tools panel using T. When entering Edit Mode, several Mesh tools 

become available. 
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Most of these tools are also available as shortcuts (displayed in the Tooltips for each tool) 

and/or in the Specials Menu W, the Edge menu Ctrl-E, and Face menu Ctrl-F. The properties 

of each tool are displayed in the operator panel at the bottom of the ToolShelf. 

 

Properties Region 
 

Title-Img 4. 6 The Properties Region in edit mode. 

Source-Blender.org 

Link-https://docs.blender.org/manual/en/dev/modeling/meshes/introduction.html 

 
Open/close the Properties Region using N. 

In the Properties Region, panels directly related to Mesh editing are the Transform panel, where 

numeric values can be entered, and the Mesh Display panel, where for example normals and 

numeric values for distances, angles, and areas can be turned on. 

With Meshes, everythingisbuiltfrom threebasicstructures: Vertices, Edges and Faces. 
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Title-Img 4. 7 Example of Mesh structure. 

Source-Blender.org 

Link-https://docs.blender.org/manual/en/dev/modeling/meshes/structure.html 

 
Vertices 

A vertex is primarily a single point or positionin 3D space. It is usually invisible in rendering 

and in Object Mode. Do not mistake the center point of an Object for a vertex. It looks similar, 

but it is bigger and you cannot select it. Refer Vertex example (Img 4.8). Shows the center 

point labelled as “A”; “B” and “C” are vertices. 

 

Title-Img 4. 8 Vertex example 

Source-Blender.org 

Link-https://docs.blender.org/manual/en/dev/modeling/meshes/structure.html 

 
A simple way to create a new vertex is to click Ctrl-LMB in Edit Mode. Of course, as a 

computer screen is two-dimensional, Blender cannot determine all three vertex coordinates 
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from a single mouse click, so the new vertex is placed at the depth of 3D cursor. Using the 

method described above (Img 4.8), any vertices selected previously are automatically 

connected to the new ones by an edge. In the image above, the vertex labelled “C” is a new 

vertex added to the cube with a new edge added between “B” and “C”. 

 
Edges 

An Edge always connects two vertices by a straight line. The edges are the “wires” you see 

when you look at a Mesh in wireframe view. They are usually invisible on the rendered image. 

They are used to construct faces. Create an edge by selecting two vertices and pressing F. 

Face 

A Face is defined as the area between either three (triangles), four (quadrangles) or more 

(ngons) vertices, with an edge on every side. These are often abbreviated to tris, quads & 

ngons. 

Triangles are always flat and therefore easy to calculate. On the other hand, quadrangles 

“deform well” and are therefore preferred for subdivision Modelling. 

While you could build a cube with triangular faces, it would just look more confusing in Edit 

Mode. 

Loops 
 

 
Title-Img 4. 9 Edge and Face Loops 

Source-Blender.org 

Link- https://docs.blender.org/manual/en/dev/modeling/meshes/structure.html#fig- mesh-topo-loop 
 

Edge and Face Loops are sets of faces or edges that form continuous “loops” as shown in Img 

4. 9. 
 

Edge and Face Loops: 
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 Top row (1 - 4) shows a solid view, 

 Bottom row (5 - 8) a wireframe view of the same loops. 

 
In the image above (Img 4. 9), loops that do not end in poles are cyclic(1 and 3). They start and 

end at the same vertex and divide the model into two partitions. Loops can be a quick and 

powerful tool to work with specific, continuous regions of a Mesh and are a prerequisite for 

Organic Character Animation. 

Edge Loops 

 
Loops (1 and 2) in Img 4. 9Edge and Face Loops are edge Loops. They connect vertices so 

that each one on the loop has exactly two neighbours that are not on the loop and placed on 

both sides of the loop (except the start and end vertex in case of poles). 

Edge Loops are an important concept especially in organic (subsurface) Modelling and 

character animation. When used correctly, they allow you to build models with relatively 

few vertices that look very natural when used as subdivision surfaces and deform very well in 

animation. 

Face Loops 

 
These are a logical extension of Edge Loops in that they consist of the faces between two Edge 

Loops, as shown in loops (3 and 4) in Img 4. 9 Edge and Face Loops. Note that for non-circular 

loops (4) the faces containing the  poles  are  not  included  in  a  Face  Loop. (Refer 

Img 4. 9) 

 
Selection Mode 

Select Mode Header Widgets 

 Mode: Edit Mode 

 Menu: 3D View Header ‣ Select Mode 

 Hotkey: Ctrl-Tab 
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In Edit Mode, there are three different selection modes. You can enter the different modes by 

selecting one of the three buttons in the header. 
 

Title-Img 4. 6 Edit Mode selection buttons 
 

 
Source-Blender.org 

Link- https://docs.blender.org/manual/en/dev/modeling/meshes/selecting/introduction.html 

 
Vertices 

In this mode, vertices are drawn as points. 

 Selected vertices are drawn in orange, 

 Unselected vertices in black 

 Active or last selected vertex in white 

 
Edges 

In this mode, the vertices are not drawn. Instead, 

 Selected edges are drawn in orange, 

 Unselected edges black, 

 Active or last selected edge in white. 
 
 

Faces 

In this mode, the faces are drawn with a selection point in the middle which is used for 

selecting a face. 

 Selected faces and their selection point are drawn in orange,

 Unselected faces are drawn in black,

 Activeor last selected face is highlighted in white.

 
Almost all tools are available in all three Mesh selection modes. So, you can Rotate, Scale, 

Extrude, etc. in all modes. Of course, rotating and scaling a single vertex will not do anything 
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useful (without setting the pivot point to another location), so some tools are applicable in 

some modes. 

 

Selection Loops 

You can easily select loops of components: 

Edge Loops and Vertex Loops 

 Mode: Edit Mode –> Vertex or Edge select mode 

 
 Menu: Select ‣ Edge Loop or Mesh ‣ Edges ‣ Edge Loop 

 
 Hotkey: Alt-RMB or Ctrl-E‣ Edge Loop 

 
Holding Alt while selecting an edge selects a loop of edges that are connected in a line end to 

end, passing through the edge under the mouse pointer. Holding Alt-Shift while clicking adds 

to the current selection. 

Edge loops can also be selected based on an existing edge selection, using either Select ‣ Edge 

Loop, or the Edge Loop Select option of the Edge Specials Menu Ctrl-E. 

 

 
Title-Img 4. 7 Longitudinal and latitudinal edge loops 

Source-Blender.org 

Link- https://docs.blender.org/manual/en/dev/modeling/meshes/selecting/advanced.html 

 
Face Loops 

 Mode: Edit Mode –> Face or Vertex select modes 

 Hotkey: Alt-RMB 

 
In face select mode, holding Alt while selecting an edge selects a loop of faces that are 
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connected in a line end to end, along their opposite edges. 

In vertexselectmode, the same can be accomplished by using Ctrl-Altto select an edge, which 

selects the face loop implicitly. 
 

Title-Img 4. 8 Face loop selection 

Source-Blender.org 

 
Link- https://docs.blender.org/manual/en/dev/modeling/meshes/selecting/advanced.html 

 

 
This face loop was selected by clicking with Alt-RMB on an edge, in face select mode. The 

loop extends perpendicular from the edge that was selected. 
 

Title-Img 4. 9Alt versus Ctrl-Alt in vertex select mode 
 

 
Source-Blender.org 

Link- https://docs.blender.org/manual/en/dev/modeling/meshes/selecting/advanced.html 

 
A face loop can also be selected in Vertex select mode. Technically Ctrl- Alt-RMB will select 

an Edge Ring, however, in Vertex select mode, selecting an Edge Ring implicitly selects a 

Face Loop since selecting opposite edges of a face implicitly selects the entire face. 

Edge Ring 

 Mode: Edit Mode –> Edge select mode 
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 Menu: Select ‣ Edge Ring or Mesh ‣ Edges ‣ Edge Ring 

 Hotkey: Ctrl-Alt-RMB or Ctrl-E ‣Select ‣ Edge Ring 

 
In Edge select mode, holding Ctrl-Alt while selecting an edge selects a sequence of edges that 

are not connected, but on opposite sides to each other continuing along a face loop. 

As with edge loops, you can also select edge rings based on current selection, using either 

Select ‣ Edge Ring, or the Edge Ring Select option of the Edge Specials Menu Ctrl-E. 
 

Title-Img 4. 10 A selected edge loop, and a selected edge ring 
 

 
Source-Blender.org 

Link- https://docs.blender.org/manual/en/dev/modeling/meshes/selecting/advanced.html 
 

In Img 4.14, A selected edge loop, and a selected edge ring. The same edgewasclickedon, but 

twodifferent“groupsofedges” wereselected, based on the different commands. One is based 

on edges during computation and the other is based on faces. 

Duplicating / Mesh EditingTools 

This section covers Mesh editing tools that add additional geometry by duplicating existing 

geometry in some way. 

Duplicate Geometry 

Extrusion 

Spin 

Screw 

Duplicate Geometry Tool 

 Mode: Edit Mode

 Menu: Mesh ‣ Duplicate

 Hotkey: Shift-D
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This tool simply duplicates the selected elements, without creating any links with the rest of 

the Mesh (unlike extrude, for example), and places the duplicate at the location of the original. 

Once the duplication is done, only the new duplicated elements are selected, and you are 

automatically placed in grab/move mode, so you can translate your copy elsewhere. 

Extrude Tool 

 
Extrude Region 

 Mode: Edit Mode

 Panel: Mesh Tools ‣ Extrude

 Menu: Mesh‣ Extrude Region

 Hotkey: E or Alt-E

 
One tool of paramount importance for working with Meshes is the Extrude tool. It allows you 

to create parallelepipeds from rectangles and cylinders from circles, as well as easily create 

such things as tree limbs. ExtrudeisoneofthemostfrequentlyusedModellingtoolsinBlender 

The selection is extruded along the common normal of selected faces. In every other case the 

extrusion can be limited to a single axis by specifying an axis (e.g. X to limit to the X axis or 

Shift-X to the YZ plane. When extruding along the face normal, limiting movement to the 

global Z axis requires pressing Z twice, once to disable the face normal Z axis limit, and once 

to enable the global Z axis limit. 

Selected face During extrude Set to Z axis 
 

Title-Img 4. 15 Extrude face 

Source-Blender.org 

Link-  https://docs.blender.org/manual/en/dev/modeling/meshes/editing/duplicating/extrude.html 

 
Ext Mode: Edit Mode 

 Panel: Mesh Tools ‣ Extrude Individual 

 Menu: Mesh ‣ Extrude Individual 

 Hotkey: Alt-E 
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Extrude Individual allows you to extrude a selection of multiple faces as individuals, instead 

of as a region. The faces are extruded along their own normals, rather than their average. 

This has several consequences: first, “internal” edges (i.e. edges between two selected faces) 

are no longer deleted (the original facesare). 

 

Title-Img 4. 11 Selection of multiple faces, extruded using extrude region and 

Extruded using Extrude Individual 

Source-Blender.org 

Link-  https://docs.blender.org/manual/en/dev/modeling/meshes/editing/duplicating/extrude.html 

 
Extrude Edges and Vertices Only 

 Mode: Edit Mode, Vertex and Edge 

 Hotkey: Alt-E 

 
If vertices are selected while doing an extrude, but they do not form an edge or face, they will 

extrude as expected, forming a non-manifold edge. Similarly, if edges are selected that do not 

form a face, they will extrude to form a face. 

 

Title-Img 4. 12 Single vertex extruded. Single edge extruded 
 

 
Source-Blender.org 

Link-  https://docs.blender.org/manual/en/dev/modeling/meshes/editing/duplicating/extrude.html 
 
 

Title-Img 4. 13Single edge extruded. Edge only extrude 
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Source-Blender.org 

Link-  https://docs.blender.org/manual/en/dev/modeling/meshes/editing/duplicating/extrude.html 

Inset Tool 

 Mode: Edit Mode 

 Menu: Mesh ‣ Faces ‣ Inset 

 Hotkey: I 

This tool takes the currently selected faces and creates an inset of them, with adjustable 

thickness and depth. The tool is modal, such that when you activate it, you may adjust the 

thickness with your mouse position. You may also adjust the depth of the inset during the 

modal operation by holding Ctrl. 
 

Selection to inset Selection with inset 

Title-Img 4. 14Single vertex extruded. Single edge extruded 

Source-Blender.org 

Link- https://docs.blender.org/manual/en/dev/modeling/meshes/editing/duplicating/inset.html 

 
Spin Tool 

 Mode: Edit Mode

 Panel: Mesh Tools

Use the Spin tool to create the sort of Objects that you would produce on a lathe (this tool is 

often called a “lathe”-tool or a “sweep”-tool in the literature, for this reason). In fact, it does a 

sort of circular extrusion of your selected elements, center on 3D cursor, and around the axis 

perpendicular to the working view... 

The point of view will determine around which axis the extrusion spins. 

The position of 3D cursor will be the center of the rotation. (Refer Img. 4.20) 
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Example 
 

Title-Img 4. 15Glass profile 

Source-Blender.org 

Link-https://docs.blender.org/manual/en/dev/modeling/meshes/editing/duplicating/spin.html?highlight=glass%20profile 

 
First, create a Mesh representing the profile of your Object. If you are Modelling a hollow 

Object, it is a good idea to thicken the outline. Img.4.20 Glass profile Shows the profile for a 

wine glass we will model as a demonstration. 

Go to the Edit Mode and select all the vertices of the Profile with A. 

We will be rotating the Object around the cursor in the top view, so switch to the top view with 

Numpad7. 
 

Title-Img 4. 16 Glass profile, top view in Edit Mode, just before spinning. 

Source-Blender.org 

Link- 

https://docs.blender.org/manual/en/dev/modeling/meshes/editing/duplicating/spin.html?highlight=glass%20profile 
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Place the cursor along the center of the profile by selecting one of the vertices along the center, 

and snapping 3D cursor to that location with 

Mesh ‣ Cursor ‣ Selection. (Img 4. 171 Glass profile, top view in Edit Mode, just before 

spinning.) Shows the wine glass profile from topview, with the cursor correctly positioned. 

Click the Spin button. If you have more than one 3D View open, the cursor will change to an 

arrow withaquestionmark and you will have to click in the area containing the top view before 

continuing. If you have only one 3D View open, the spin will happen immediately. Img 4. 18 

Spun profile Shows the result of a successful spin. 

Angle 
 

Title-Img 4. 19 Spun Profile with an angle of 360 and 120. 

Source-Blender.org 

Link- 

https://docs.blender.org/manual/en/dev/modeling/meshes/editing/duplicating/spin.html?highlight=glass%20profile 
 

 

Result of spin operation Resultof Duplienabled 

 
Title-Img 4. 20 Result of spin and Dupli 

Source-Blender.org 

Link-https://docs.blender.org/manual/en/dev/modeling/meshes/editing/duplicating/spin.html?highlight=glass%20profile 

 
Merge Duplicates 
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Title-Img 4. 21Duplicate Vertices 

Source-Blender.org 

Link- 

https://docs.blender.org/manual/en/dev/modeling/meshes/editing/duplicating/spin.html?highlight=glass%20profile 
 

 
The spin operation leaves duplicate vertices along the profile. You can select all vertices at the 

seam with Box select B shown in Img 4. 24 Duplicate vertices. Seam vertex selection and 

perform a Remove Doubles operation. 

Bevel Tool 

 Mode: Edit Mode 

 Menu: Mesh ‣Edges ‣Bevel or Ctrl-E‣Bevel 

 Usage 

The Bevel tool works only on selected edges. It will recognize any edges included in a vertex 

or face selection as well, and perform the bevel the same as if those edges were explicitly 

selected. In “vertex only” mode, the Bevel toolworksonselectedverticesinsteadofedges. The 

Bevel tool smooths the edges and/or “corners” (vertices) by replacing them with faces 

making smooth profiles with a specified number of segments (see the options below Img 4. 25 

for details about the bevel algorithm). 

Use Ctrl-B or a method listed above to run the tool. Move the mouse to interactively specify 

the bevel offset, and scroll the Wheel to increase or decrease the number of segments. (See Img 

4. 25) 
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Edge before 

beveling 
Edge Bevel Vertex bevel 

 
Title-Img 4. 22Bevel 

Source-Blender.org 

Link- https://docs.blender.org/manual/en/dev/modeling/meshes/editing/subdividing/bevel.html 

 
Merge Vertices 

This tool allows you to merge all selected vertices to a unique one, deleting all others. You 

can choose the location of the surviving vertex in the menu this tool pops up before executing. 

Unit summary 
 

 Create Object with 3D Mesh / Primitives 

 Edit the Object with different Modes 

 Work with Mesh Modelling 

 Create Polygon Objects 

 Analyse the Mesh 

 
After learning this Unit, you can download the Open Image Source Software available on the 

internet for free of cost to practice the possibilities of creating 3D Objects. 

 

 

Assignment 
 

Createa flowervase, a wineglassand acupusing Nurbscurves. 

Assessment 
1. Explain the Modelling Modes in Blender 

2. Write a brief note on the Structure of a Mesh 

3. Explain the Loops used in Polygon Modelling 
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4. Describe the types of selection modes in Mesh modelling 

5. Write a brief note on Edge/Face tool 

6. How is Mirror Editing tool used? 

Fill in the Blanks 

1.  is available in either Edit Mode or Object Mode. 

 
2. Selected vertices are drawn in color, unselected vertices in  color. 

 
3. Pressing Key when selecting a higher selection mode, all elements 

touching the current selection will be added. 

4. A is primarily a single point or position in 3D space. 

 
5. Operations in effect only the geometry of an Object. 

Resources 
While studying this Unit, you can browse the internet links for online tutorials and several 

books and training DVDs available in the Blender Store and on the Blender Cloud. 

 wiki.blender.org

 archive.org
 

 www.blender.org
 

 docs.blender.org
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BCADES-304 

3D ILLUSION-1 
Block – 2: 3D Shading 
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Unit-1 Introduction to Materials and Shaders in Blender 

Introduction 

Materials in Blender define how an object appears visually, simulating real-world surfaces 

such as metal, fabric, or glass. These properties can include color, transparency, reflectivity, 

and texture. Materials can vary across an object’s surface or between different faces of an 

object. In this Unit, you will learn about Materials and Shader in Blender. 

 
Outcomes 

Upon completion of this unit you will be able to: 

 Apply Materials and Shaders to your 3D Scenes

 Demonstrate the utility of Material Panel and its Slots

 Use Multiple Materials

 Practice Material Operations like Naming and Linking

 

Terminology 
 

BSDF: Bidirectional Scattering Distribution Function is defined as how light is 

reflected and refracted at a surface. 

Reflection: BSDF Reflects an incoming ray on the same side of the surface. 

Transmission: 
 
 
Refraction: 

BSDF Transmits an incoming ray through the surface, leaving on the 

other side.  

BSDF refraction is a type of Transmission, transmitting an incoming ray 

and changing its direction as it exists on the other side of the surface. 

 
How Blender Simulates Light 
Blender’s rendering engine simulates light by tracing rays from the camera into the scene. 

When a ray hits a surface, Blender calculates how light interacts at that point to determine the 

final color. 

The Rendered Image you create with Blender is a projection of the scene onto an imaginary 

surface called the Viewing Plane. The viewing plane is analogous to the film in a traditional 

camera, or the rods and cones in the human eye, except that it receives simulated light, not 

real light. 

To render an image of a scene, you must first determine what light from the scene is arriving 

at each point on the viewing plane? The best way to answer this question is to follow a straight 

line (the simulated light ray) backwards through that point on the viewing plane and the focal 
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point (the location of the camera) until it hits a renderable surface in the scene, at which point 

you can determine what light would strike that point. (Refer image 1.1) 

The surface properties and Incident Light Angle tell us how much of that light would be 

reflected along the IncidentViewing Angle (Rendering engine Basic Principle). 

 

Two basic types of phenomena would take place at any point on a surface when a light ray 

strikes it: 

1. Diffusion 

 
2. Specular Reflection 

 

Diffusion and Specular reflection are distinguished from each other mainly by the relationship 

between the Incident Light Angle and the Reflected Light Angle. 

The shading (or coloring) of the object during render will then consider the base color (as 

modified by the diffusion and specular reflection phenomenon) and the light intensity. 

Using the Internal Ray Tracer, other (more advanced) phenomena could occur. 

In Ray-Traced Reflections, the point of a surface struck by a light ray will return the color of 

its surrounding environment, according to the rate of reflection of the material (mixing the 

base color and the surrounding environment) and the viewing angle. 

On the other hand, in Ray-Traced Refractions, the point of a surface struck by a light ray will 

return the color of its background environment, according to the rate of transparency (mixing 

the base color and the background environment along with its optional filtering value) of the 

material and the optional index of refraction of the material, which will distort the viewing 

angle. Of course, shading of the object hit by a light ray will be about mixing all these 

phenomena at the same time during the rendering. 

Title- Img 1. 1 Rendering Engine Basic Principle 
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Advanced Rendering Techniques 

Ray-Traced Reflections simulate how surfaces reflect their surroundings. Ray-Traced Refractions 
simulate how transparent materials distort light passing through. 

 

Material Settings 

While rendering, the appearance of the object depends upon many inter-related settings: 

 World (Ambient color, Radiosity, Ambient Occlusion) 

 Lights 

 Material settings (including ambient, emission, and every other setting on every 

panel in that tab) 

 Texture(s) and how they are mixed 

 Material Nodes 

 Camera 

 Viewing Angle 

 Obstructions and transparent occlusions 

 Shadows from other opaque/transparent objects 

 Render settings 

 Object dimensions (SS settings are relevant to dimensions) 

 Object shape (refractions, Fresnel effects) 
 

As stated above, the material settings usually determine the surface properties of the object. 

There are several ways in which materials can be set up in Blender. Generally, these are not 

compatible. 

You must choose which method you are going to use for each particular object in your scene: 
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Step 1: you can set the Properties in the various Material Panels. 

Step 2: you can use Nodes; a Graphical Nodes Editor is available. 

Step 3: you can directly set the colour of object surfaces using various special effects. 

 

Strictly, these are not the materials at all, however they are included here because they will 

affect the appearance of your objects. These include 

 Vertex Painting, 
 

 Wire Rendering, 
 

 Volume Rendering, and 
 

 Halo Rendering 
 

 
The exact effect of Material settings can be affected by the number of system settings. 

1. First and foremost is the Render Engine used: Cycles and the Blender Render Engine 

(aka Blender Internal or BI) require quite different illumination levels to achieve similar 

results, and even then, the appearance of objects would be quite different. 

2. Also, the material properties settings can be affected by the Texture Method used (Single 

Texture, Multitexture or GLSL). 

So, it is always recommended to select the appropriate system settings before starting the 

design of materials. 
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Introduction to Shaders 
 

Materials define the appearance of meshes, curves and other objects. They consist of Three 

Shaders, which define the appearance of the 

1. Surface of the mesh, 

 
2. Volume inside the mesh, and 

 
3. Displacement of the surface of the mesh. 

 

 
Title- Img 1. 2 Materials with shaders 

 

 
Shaders control how light interacts with an object’s surface, interior, and geometry. They 
include surface, volume, and displacement shaders. 
 

 
 
 



89  

Materials Tab ‣ Materials Panel 

 

Unit-2 Working with Materials in Blender 
Surface Shader 

The Surface Shader defines the light interaction at the surface of the mesh. One or more 

BSDFs specify if incoming light is reflected back, refracted into the mesh, or absorbed. 

Emission defines how light is emitted from the surface, allowing any surface to become a 

light source. 

 
Material Panel 

 
Materials can be linked to Objects and Object’s data in the 

 

Here, you can manage how materials are linked to objects, meshes, etc. and activate a material 

for editing in the rest of the panels. (Refer 1.3) 

Title-Img 1.3 Material panel 
 

 
Source- Blender.org 

Link-  https://docs.blender.org/manual/en/dev/render/blender_render/materials/ma  terial_panel.html 

 
 Material slots - Active Material

 
Theobject’s material slots are displayed in a List View. (Refer 1.4) 

 
 Specials

 Copy and paste the selected material slot.
 

 Multiple materials

 Meshes can handle having more than one material. Materials can be mapped 

on a per-face basis, as detailed on the Multiple Materials. In edit mode, the 
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following tools appear:

 Assign
 Assign the material in the selected material slot to selected vertices.

 
 Select

 Select vertices assigned to the selected material slot.
 

 Deselect

Deselect vertices assigned to the selected material slot. 
 

 
Materials Slots 

 
The object’s material slots are displayed in a List View.  

 
List View 

 

Title-Img 1. 4 List view 
 

 
Source- Blender.org 

Link-  https://docs.blender.org/manual/en/dev/interface/controls/templates/list_pre  sets.html#ui-list-view 

 
This control is useful to manage lists of items. They can be found in example in the object 

data properties. 

 
Select 

To select an item, LMB on it. 

 Rename

By double clicking on an item, you can edit its name via a text field. This can also be 

achieved by pressing Ctrl-LMB over it. 

 Resize

The list view can be resized to show more or fewer items. Hover the mouse over the handle 

(==) then click and drag the handle to expand or shrink the list. 

 Filter

Click the Show filtering options button (+) to toggle filter option buttons. 
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Search Type part of a list item’s name in the filter text field to filter items by their name. 

 

Filter Include When the magnifying glass icon has a + sign then only items that match 

the text will be displayed. 

Filter Exclude When the magnifying glass icon has a - sign then only items that do not 

match text will be displayed. 

 Sort

Sort list items. 

Alphabetical This button switches between alphabetical and non-alphabetical ordering. 

Inverse Sort objects in ascending or descending order. This also applies to alphabetical 

sorting, if selected. 

On the right of the list view are additional buttons: 

 Add +

Adds a new item. 

 Remove -

To remove the selected item. 

 Specials

The down arrow on dark background opens a pop-up menu with operators’ context- 

sensitive to the item type. i.e. copy paste, or operations on all items. 

 Move Up

The button showing an up arrow moves the selected item up one position. 

 Move Down
 

The down arrow moves the item down. 

Presets 
 

 
Title-Img 1. 5 Presets without and with specials 

Attribution- Source- Blender.org 

Link-  https://docs.blender.org/manual/en/dev/interface/controls/templates/list_presets.html#ui-list-view 

 Selector

A list of available presets. A selection will override the included properties. 

 Add +
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New presets can be added based on the preset included properties, which will be saved for later 
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re-use. A pop-up opens, where you can set a name after which you can select it from the list 

and in some cases additional settings. 

 
 Remove -

Deletes the selected preset. 

 Specials
 

The down arrow on dark background opens a pop-up menu with operators’ context-sensitive 

to the preset type. i.e. copy paste. 

Multiple Materials 

 
Normally, different colors or patterns on an object are achieved by adding textures to your 

materials. However, in some applications you can obtain multiple colors on an object by assigning 

different materials to the individual faces of the object. 
 

 
Title-Img 1. 4Add new material 

Attribution- Source- Blender.org 

 
Link- https://docs.blender.org/manual/en/dev/render/blender_render/materials/assigning_a_material.html 

 
To apply several materials to different faces of the same object, you use the Material Slots options 

(3) in the Materials Header Panel. (Refer 1.6) 
 

Title-Img 1. 5 Material menu in edit mode 

 
Attribution- Source- Blender.org 
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Link- https://docs.blender.org/manual/en/dev/render/blender_render/materials/assigning_a_material.html 

 
The workflow for applying a Second Material to some faces of an object covered by a Base 

Material is as follows: 

Step 1: 

In Object Mode, apply the Base Material to the whole object (as shown in Assigning a 

material) 

Step 2: 

 
Create/select the Second Material (the whole object will change to this new material). 

 
Step 3: 

 
In the Active Material box (2), re-select the base material. 

 
Step 4: 

 
 
 

 
Step 5: 

 
 

Step 6: 

Go to Edit Mode and Face Select (a new box appears above the Active Material box with 

Assign/Select/Deselect). 

 
Select the face/faces to be coloured with the second material. 

In the Object Material Slots box (3), click the Plus to create a new slot, and while this 

is still active, click on the second material in the Available Materials list. 

Step 7: 

Click the Assign button, and the second material will appear on the selected object 

faces. 

You can also make this new material a copy of an existing material by adding the data-block: 

 Select the object, 

 get the material, 

 (R Click) and Copy data to clipboard. 

When you have renamed the material, 

 click“Link: Data” to link to the existing material. 
 

 Proceed to assign faces as required. 

 
Note: If you change the material on the original object, the new object color changes too. 

Meshes can handle having more than one material. Materials can be mapped on a per-face 

basis, as detailed on the Multiple Materials. In Edit Mode, the following tools appear: 

 Assign



95  

Assign the material in the selected material slot to selected vertices. 

 Select

Select vertices assigned to the selected material slot. 

 Deselect

Deselect vertices assigned to the selected material slot. 

Material Naming and Linking 

 Material

The Material Data-Block Menu for the selected material slot. 

 Nodes

Toogle that designates this material to be a material node setup, and not from the Material 

/Ramps / Shaders settings. 

 Data-block Links

It specifies whether the material is to be linked to the Object or to the Object Data. The Link 

selector has two choices: 1. Data and 2. Object. These two menu choices determine whether 

the material is linked to the object or to the data, (i.e. a mesh or curve). 

 The Data Menu Item determines that this material will be linked to the mesh’s data-block 

which is then linked to the object’s data-block.

 The Object Menu Item determines that the material will be linked to the object’s data-block 

directly.

This will have consequences, of course. For example, different objects may share the same mesh 

data-block. Since this data-block defines the shape of the object, any change in “Edit Mode” will 

be reflected on all those objects. Moreover, anything linked to that mesh data-block will be shared 

by every object that shares that mesh. So, if the material is linked to the mesh, every object will 

share it. 

On the other hand, if the material is linked directly to the object data-block, the objects can have 

different materials and still share the same mesh. 

Brief explanation: If connected to the object, you can have several instances of the same Object Data 

using different materials. 
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Unit 3 Introduction to Shader  
 

Introduction 

Materials can have a Wide Array of Properties. It is the combination of things that define the 

way how the Material looks, and how objects will appear when rendered. These properties 

are set using the various panels in the Material tab. 

Remember that the appearance of your Materials is affected by the way that they are rendered 

(surface, wire, volume or halo), and by the rendering engine (Blender, Cycles, or Game) used. 

Most properties for images rendered using Cycles can only be controlled using the Node 

system. 

 

Outcomes 

In this Unit, you will learn about how to design Materials and Shaders. 
 

Upon completion of this unit you will be able to: 

 Design suitable Materials and Shaders to your 3D Scenes 

 Utilize Materials effectively to shade the 3D Objects 

 Create Color Ramps, Specular, Transparency, Reflection and Refraction 

 Use Material properties and 

 Practice Material Operations on 3D Scenes. 

 
Terminology 

 

Preview: A Preview of the current Material mapped on 

to one of the basic objects. 

Diffuse Shaders: The basic color of the Material, together with different models for 

dispersion. 

Specular Shaders: The reflected highlights: color, strength and different models for 

dispersion. 

 
Color ramps: 

How to vary the base color over a surface in both Diffuse and 

Specular Shaders. 

 
Shading: 

Properties of various characteristics of the shading model for the 

Material. 
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Transparency: Sets options for objects in which light can pass through. 

 
Mirror: 

 
(Only Blender Render): Reflective properties of the Material. 

 

Subsurface 

scattering: 

(Only Blender Render): Simulates semi- translucent objects in 

which light enters, bounces around, then exits in a different place. 

Strand: (Only Blender Render): For use when surfaces are covered with 

hair, fur, etc. 

 
Options: 

Various options for shading and colouring the object. 

 
Shadow: 

Controls how objects using this Material cast and receive shadows. 

 
Game settings: 

(Only Blender Render): Controls settings for real-time rendering of 

Game Engine objects. 

 

 
Diffuse Shaders 

A Diffuse Shader is determined by the General Color of a Material when light shines on 

it. Most Shaders that are designed to mimic reality give a smooth falloff from bright to dark from 

the point of the strongest illumination to the shadowed areas, however Blender also has other 

Shaders for various special effects. 

Common Options 

All Diffuse Shaders have the following options: 

Color 
 

Select the base Diffusecolor of the Material. 

Intensity 

The Shader’s brightness, or more accurately, the amount of incident light energy that is 

Diffusely reflected towards the camera. 

Ramp 

Allows you to set the range of colors for the Material, and define 

how the range will vary over a surface. 
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Technical Details 

Light striking a surface and then re-irradiated via a Diffusion phenomenon will be scattered, 

i.e., re-irradiated in all directions isotopically. This means that the camera will see the same 

amount of light from that surface point no matter what the incident viewing angle is. This 

quality makes Diffuse light viewpoint independent. Of course, the amount of light that strikes 

the surface depends on the incident light angle. If most of the light striking a surface is reflected 

Diffusely, the surface will have a matte appearance (Light re-irradiated in the diffusion 

phenomenon). 

 

Title- Img 2. 1 Light re-irradiated in the diffusion phenomenon. 
 
 

 
Source- blender.org 

Link https://docs.blender.org/manual/en/dev/render/blender_render/materials/properties/diffuse_shaders.html 

Types of Diffuse Shaders 
 

 

 
 

Lambert Shader 
 
 

Source- blender.org 

 
Title- Img 2.2 Lambert Shader. 

Link-https://docs.blender.org/manual/en/dev/render/blender_render/materials/properties/diffuse_shaders.html 

 
This is Blender’s default Diffuse Shader, and is a good general all- around workhorse for 
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Materials showing low levels of Specular reflection. 

Johann Heinrich Lambert (1728-1777) was a Swiss mathematician, physicist and 

astronomer who published the works on the reflection of light, most notably the Beer-Lambert 

Law, which formulates the law of light absorption. 

 
This Shader has only the default option, determining how much of available light is reflected. 

Default is 0.8 to allow other objects to be brighter. 
 

Title- Img 2.3 The Lambert Diffuse Shader settings. 

 
Source-blender.org 

Link-https://docs.blender.org/manual/en/dev/render/blender_render/materials/p    roperties/diffuse_shaders.html 

 
Oren-Nayar Shader 

Title- Img 2.4 Oren-Nayar Shader. 

 
Source-blender.org Link- 

https://docs.blender.org/manual/en/dev/render/blender_render/materials/p  roperties/diffuse_shaders.html 
 

Oren-Nayar has taken a somewhat more ‘physical’ approach to the diffusion phenomena as 

it considers the amount of microscopic roughness of the surface. 

Michael Oren and Shree K. NayarTheir reflectance model developed in the early 1990s, is 

a generalization of Lambert’s law now widely used in Computer Graphics. 

Options 

Roughness 

The roughness of the surface, and hence, the amount of Diffuse scattering. 
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Title-Img 2.5 The Oren-Nayar Diffuse Shader settings. 

 
 

Source-blender.org 

Link-https://docs.blender.org/manual/en/dev/render/blender_render/materials/p    roperties/diffuse_shaders.html 

 
Toon Shader 

 

Title- Img2.6 Toon Shader, Different Spec. 

Source-blender.org 

Link-https://docs.blender.org/manual/en/dev/render/blender_render/materials/properties/diffuse_shaders.html 
 

 
 
 

 
Title-Img 2.7 Toon Shader Variations. 

Source-blender.org 

Link-https://docs.blender.org/manual/en/dev/render/blender_render/materials/properties/diffuse_shaders.html 
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Toon Shader is a very ‘un-physical’ Shader that is not meant to fake reality, however to 

produce cartoon cell styled rendering, with clear boundaries between light and shadow and 

uniformly lit/shadowed regions. 

Options Size 

The size of the lit area. 

Smooth 

The softness of the boundary is between lit and shadowed areas. 
 

 
Title-Img 2.8 Toon Diffuse Shader settings. 

Source-blender.org 

Link-https://docs.blender.org/manual/en/dev/render/blender_render/materials/properties/diffuse_shaders.html 

MinnaertShader 

 

Title- Img 2.9 Minnaert Shader. 
 
 

Source-blender.org 

Link-https://docs.blender.org/manual/en/dev/render/blender_render/materials/properties/diffuse_shaders.html 
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Minnaert Shader works by darkening parts of the standard Lambert Shader. 

So, if Dark is 1, you get exactly the Lambertian result. 

Higher darkness values will darken the center of an object (where it points towards the viewer). 

Lower darkness values will lighten the edges of the object, making it look somewhat 

velvet. 

Marcel Minnaert (1893-1970) was a Belgian astronomer interested in the effects of the 

atmosphere on light and images who in 1954 published a book entitled “The Nature of Light 

and Color in the Open Air”. 

Options 

Dark 

Thedarknessof the ‘lit’ areas(higher) orthedarkness of the edges pointing away from the light 

source (lower). 

 

 

Title-Img2.10 Minnaert Diffuse Shader settings. 

 
Fresnel Shader 

Source-blender.org 

Link-https://docs.blender.org/manual/en/dev/render/blender_render/materials/p    roperties/diffuse_shaders.html 

 
Reference 

Mode: All Modes 

Panel: Shading/Material Shaders 



103  

 

Title- Img 2. 11 Various settings for the Fresnel Shader, Cook-Torr Specular Shader 

kept at Intensity 0.5, Hardness: 50. 

 
Source-blender.org 
Link-https://docs.blender.org/manual/en/dev/render/blender_render/materials/properties/diffuse_shaders.html 

 
 
 
 
 

Title-Img2.12 Fresnel Shader, Different Spec. 
 
 

Source-blender.org Link- 
https://docs.blender.org/manual/en/dev/render/blender_render/materials/p  roperties/diffuse_shaders.html 

 

 
With a Fresnel Shader, the amount of Diffuse reflected light depends on the incidence angle, 

i.e. from the direction of the light source. 

Areas pointing directly towards the light source appear darker; Areas perpendicular to the incoming 

light become brighter. 

Augustin-Jean Fresnel (1788-1827) was a French physicist who contributed significantly to 

the establishment of the theory of wave optics. 
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Options 
 

Title- Img 2.13 The Fresnel Diffuse Shader settings. 

Source-blender.org Link- 

https://docs.blender.org/manual/en/dev/render/blender_render/materials/p  roperties/diffuse_shaders.html 

 
Fresnel 

Power of the Fresnel effect, 5.0 is max. 

 
Factor: Blending factor of the Fresnel factor to blend in, 5.0 

 
Emit: 

Amount of light to emit 

Ambient 

Amount of global ambient color the Material receives 

Translucency 

Amount of Diffuse shading on the back side 

Shadeless 

Make this Material insensitive to light or shadow 

Specular Shaders 

Tangent Shading 

Use the Material’s tangent vector instead of the normal for shading – for 

anisotropic shading effects (e.g. soft hair and brushed metal). 

 
Specular Shaders create the bright highlights that one would see on a glossy surface, 

mimicking the reflection of light sources. Unlike Diffuse shading, Specular reflection is 

viewpoint dependent. According to Snell’s Law, light striking a Specular surface will be 

reflected at an angle which mirrors the incident lightangle(withregardtothesurface’snormal), 

whichmakesthe viewing angle very important. 
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Common Options 

Each Specular Shader shares the following common options: 

Specular Color 

The color of the Specular highlight 

Intensity 

The intensity, or brightness  of the Specular highlight. This has a range of [0-1]. 

Ramp 

Allows you to set a range of Specularcolors for Material, and define how the range will vary 

over a surface. 

As a result, a Material has at least two different colors, a Diffuse, and a Specular one. The 

Specular color is normally set to pure white (the same “pure white” as the reflected light 

source), however, it can be set to different values for various effects (e.g. metals tend to have 

colored highlights). 

 
Technical Details 

Title- Img 2.14 Specular Reflection. 

 
Source-blender.org 

Link- 

https://docs.blender.org/manual/en/dev/render/blender_render/materials/properties/specular_shaders.html?highlig 

ht=specular%20reflection 
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In reality, the quality of Diffuse and Specular reflection is generated during the same process 

of light scattering, however are not the same. Diffusion is actually subsurface scattering at a 

very small scale. 

Imagine that a surface is made up of extremely microscopic semi- transparent, reflective facets. 

The sharpness of Specular reflection is determined by the distribution of the angle of these 

microfacets on the surface of an object. The deeper and jagged these facets are, the 

more the light spreads when it hits the surface. When these facets are flatter against the “macro 

surface”, the surface will have a tighter reflection, closer to a mirror. This is a condensed 

explanation of the generally accepted microfacet theory of reflectance, which is the basis of all 

modern BRDFs (Bi-directional Reflectance Distribution Functions), or shading models. 

Because these microfacets are transparent, some light that hits them travels into the surface 

and Diffuses. The light that makes it back out is roughly Lambertian most of the time, meaning 

that it spreads evenly in all directions. It is also attenuated by the pigmentation in the surface, 

hence creating what you perceive as Diffuse, and the color of an object. 

Note that at glancing angles, the reflectivity of a surface will always go to 1. (ReferImg 2.14) 

Cook-Torrance Shader 
 

 

Title-Img 2.15 Cook-Torrance Shader(Lambert 0.8). 

 
Source-blender.org 

Link- 

https://docs.blender.org/manual/en/dev/render/blender_render/materials/properties/specular_shaders.html?highlig 

ht=specular%20reflection 

Cook-Torrance is a basic SpecularShader that is most useful for creating shiny plastic 

surfaces. It is a slightly optimized version of Phong. 

Robert L. Cook (LucasFilm) and Kenneth E. Torrance (Cornell University) In their 1982 

paper A Reflectance Model for Computer Graphics (PDF), they described “a new reflectance 

model for rendering computer synthesized images” and applied it to the simulation of metal 
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and plastic. 

Option 

Hardness 

Size of the Specular highlight 

 

PhongShader 
 
 
 
 
 
 
 

 
. 

Title-Img 2.16 Phong Shader (Lambert 0.8). 
 
 

Source-blender.org 

Link 

https://docs.blender.org/manual/en/dev/render/blender_render/materials/properties/specular_shaders.html?highlig 

ht=specular%20reflection 

Phong is a basic Shader that is very similar to CookTorr, however, it is better for skin and 

organic surfaces. 

Bui TuongPhong (1942-1975) was a Vietnamese-born Computer Graphics pioneer that 

developed the first algorithm for simulating Specular phenomenon. His model included 

components not only for Specular lighting, but also Diffuse and ambient lighting. 

Option 

Hardness 

Size of the Specular highlight. 
 

 
BlinnShader 
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Title-Img 2. 17 Blinn Shader (Oren-Nayar Int 0.8, Rough 0.5). 

Source-blender.org 

Link 

https://docs.blender.org/manual/en/dev/render/blender_render/materials/properties/specular_shaders.html?highlig 

ht=specular%20reflection 

Blinn is a more ‘physical’ Specular Shader, often used with the Oren-Nayar Diffuse Shader. 

It can be more controllable because it adds a fourth option, an index of refraction, to the 

above mentioned three. 

James F. Blinn worked at NASA’s Jet Propulsion Laboratory and became widely known for 

his work on Carl Sagan’s TV documentary Cosmos. The model he described in his 1977 

paper Models of Light Reflection for Computer Synthesized Pictures (PDF) included 

changes in Specular intensity with light direction and more accurately positioned highlights on 

a surface. 

Options 

Hardness 

Size of the Specular highlight. The BlinnShader is capable of much tighter Specular highlights 

than PhongorCookTorr. 

IOR 

‘Index of Refraction’. This parameter is not actually used to compute refraction of light rays 

through the Material (a ray tracer is needed for that), however to correctly compute Specular 

reflection intensity and extension via Snell’s Law. 
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Toon Shader 
 

 
Title-Img 2. 18 Toon Specular Shader (Toon Diffuse, Int 0.8, Size & Smooth match). 

Source-blender.org 

Link- 

https://docs.blender.org/manual/en/dev/render/blender_render/materials/properties/specular_shaders.html?highl 

ight=specular%20reflection 

 
Toon Specular Shader matches the Toon Diffuse Shader. It is designed to produce the 

sharp, uniform highlights of cartoon cells. 

 
Options 

 
Size: Size of the Specular highlight. 

 
Smooth: Softness of the highlight’s edge. 

Ward Isotropic Shader 
 

Title- Img2.19 Ward isotropic Shader. 
 
 

Source-blender.org 

Link- 

https://docs.blender.org/manual/en/dev/render/blender_render/materials/properties/specular_shaders.html?highlig 

ht=specular%20reflection 
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Ward Isotropic is a flexible Specular Shader that can be useful for metal or plastic. 

Gregory J. Ward developed a relatively simple model that obeyed the most basic laws of 

physics. In his 1992 paper, “Measuring and modeling anisotropic reaction”, Ward introduced a 

Bidirectional Reflectance Distribution Function (BRDF) since then widely used in 

Computer Graphics because the few parameters it uses are simple to control. His model could 

represent both isotropicsurfaces (independent of light direction) and anisotropic surfaces 

(direction dependent). In Blender, the Ward Specular Shader is still called “Ward Isotropic” 

however is actually anisotropic. 

Option 

Slope 

Standard deviation for surface slope. Previously known as the root-mean-square or 

rms value, this parameter in effect controls the size of the Specular highlight, though using a 

different method to that of the other Specular Shaders. It is capable of extremely sharp 

highlights. 

Color Ramps Shading 

In many real-life situations, like skin or metals, the color of Diffuse and Specular reflections 

can differ slightly, based on the amount of energy a surface receives or on the light angle of 

incidence. The Ramp Shader options in Blender allow you to 

 
o set a range of colors for a Material, 

o define how the range will vary over a surface, 

o how it blends with the ‘actual color’ (typically from a Material or as output of a texture). 

Ramps allow you to precisely control the color gradient across a Material, rather than just a 

simple blend from a brightened color to a darkened color, from the most strongly lit area to the 

darkest lit area. As well as several options for controlling the gradient from lit to shadowed, 

ramps also provide ‘normal’ input, to define a gradient from surfaces facing the camera to 

surfaces facing away from the camera. This is often used for Materials of metallic car paint 

that change color based on viewing angle. 

Since texture calculations in Blender happen before shading, the Ramp Shader can 

completely replace texture or Material color. However, using the mixing options and Alpha 

values, it is possible to create an additional layer of shading in Blender Materials. 
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Options 
 

Title- Img 2.20 Ramps Panel. 
 

 
Source-blender.org Link- 

https://docs.blender.org/manual/en/dev/render/blender_render/materials/p  roperties/ramps.html 

For the first part of the color ramp option, see Color Ramp Widget.(Refer Img 2.20) 
 

Input 

The input menu contains the following options for defining the gradient: 
 

Shader 

The value as delivered by the Material’s Shader (Lambert, Cook Torrance) defines the color. 

Here the amount of light does not matter for color, only the direction of the light. 

Energy 

As Shader, now also lamp energy, color, and distance are considered. This makes the Material 

change color when more light shines on it. 

Normal 

The surface normal, relative to the camera, is used for the Ramp Shader. This is possible with 

a texture as well, however added for convenience. 

Result 

While all three previous options work per lamp, this option only works after shading 

calculations. This allows full control over the entire shading, including ‘Toon’ style 

results. Using alpha values here is most useful for tweaking a finishing touch to a Material. 

Blend 

A list of the various Color Blend Modes are available for blending the ramp Shader with 

the color from Input. 

Factor 

This slider denotes the overall factor of the ramp Shader with the color from Input. 

Shading Panel 

While all three previous options work per lamp, this option only works after shading 

calculations. This allows full control over the entire shading, including ‘Toon’ style results. 
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Using alpha values here is most useful for tweaking a finishing touch to a Material. 
 
 

A list of the various Color Blend Modes are available for blending the ramp Shader with the 

color from Input. 

This slider denotes the overall factor of the ramp Shader with the color from Input. In the 

separate Shading panel SIX MORE OPTIONS are available: 

 

 
Title- Img 2.21 Shading menu, default settings. 

Source-blender.org 

Link-https://docs.blender.org/manual/en/dev/render/blender_render/materials/p   roperties/ramps.html 

Emit 

Amount of light to emit. 

 
Ambient 

Amount of global ambient color the Material receives. Each Material has an Ambient slider 

that lets you choose how much ambient light that object receives. Set to 1.0 by default. 

Ambient Color 

You should set this slider depending on the amount of ambientlightyouthinktheobject will 

receive.Something deep in the cave will not get any ambient light, whereas something close 

to the entrance will get more. Notethat you cananimatethis effect, to change it as the object 

comesoutoftheshadowsandintothelight. 

 
Translucency 

Amount of light from the back side that shows through. 

 
Shadeless 

Disables the calculation of any shading. This makes the Material insensitive to light or shadow, 

resulting in a solid, uniform color for the whole object. 

Tangent Shading 

Use the Material’s tangent vector instead of the normal for shading, i.e. for anisotropic 

shading effects (like soft hair and brushed metal). 
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Cubic Interpolation 

Use cubic interpolation for Diffuse values, for smoother transitions between light areas and 

shadowed areas. Enhances the perceived contrast. 

 
 

 

 

Without Cubic 

enabled. 

 
 
 
 

 

With Cubic enabled 

Cubic enabled. 

Title- Img 2. 22 Shading menu, default settings. 

Source-blender.org 

Link-http://blender-manual.readthedocs.io/en/master/render/blender_render/materials/properti es/shading.html 
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Unit 4 Advanced Shader Techniques 
 
Transparency Panel 

Materials in Blender can be set to be transparent, so that light can pass through any objects 

using the Material. Transparency is controlled using an “alpha” channel, where each pixel has 

an additional value, range 0-1, in addition to its RGB color values. 

 If alpha=0, then the pixel is transparent, and the RGB values forthe 

surfacecontributenothingtothepixel’s appearance; 

 If alpha=1, the surface is fully opaque, and the color of the surface 

determines the final color of the pixel. 

 
Title-Img 2.23 Transparency Panel. 

Source-blender.org Link- 
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https://docs.blender.org/manual/en/dev/render/blender_render/materials/p  roperties/transparency.html 

In Blender, there are three ways in which the transparency of a Material can be set: 

1. Mask, 

2. Z-Buffer 

3. Ray-trace 

Each of these is explained in more detail below. The Material Preview option with a sphere 

object gives a good demonstration of the capabilities of these three options. 

Options 
 

 
Title- Img 2. 24 The Transparency Panel. 

 
Source-blender.org 

Link-https://docs.blender.org/manual/en/dev/render/blender_render/materials/p   roperties/transparency.html 
 

 
IOR 

 
In addition to the common options given above, the following property controls are available: 

Index of Refraction. Sets how much a ray traveling through the Material will be refracted, 

hence producing a distorted image of its background. 

Filter 

Amount of filtering for transparent ray trace. The higher this value, the more the base color of 

the Material will show. The Material will still be transparent; however, it will start to take on 

the color of the Material. Disabled (0.0) by default. 

Falloff 
How fast light is absorbed as it passes through the Material. Gives ‘depth’ and ‘thicknesses 

to glass. 
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Limit 
Materials thicker than this are not transparent. This is used to control the threshold after which 

the filter color starts to come into play. 

Depth 
Sets the maximum number of transparent surfaces a single ray can travel through. There is 

no typical value. Transparent objects outside the Depth range will be rendered pitch black if 

viewed through the transparent object that the Depth is set for. In other words, if you notice 

black areas on the surface of a transparent object, the solution is probably to increase its Depth 

value (this is a common issue with ray tracing transparent objects). You may also need to turn 

on transparent shadows on the background object. 

Gloss 
Settings for the glossiness of the Material. 

Amount 
The clarity of the refraction. Set this to something lower than zero to get a blurry refraction. 

Threshold 
Threshold for adaptive sampling. If a sample contributes less than this amount (as a 

percentage), sampling is stopped. 

Index of Refraction (IOR) 
 

 
Title- Img 2. 25 Influence of IOR of an Object on the distortion of the background: spheres 

of Water, Glass and Diamond (top to bottom). 

 
Source-blender.org 
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Link- 

https://docs.blender.org/manual/en/dev/render/blender_render/materials/properties/transparency.html 

There are different values for typical Materials: 

 Air: 1.000 (no refraction), 

 Alcohol: 1.329, 

 Glass: 1.517, 

 Plastic: 1.460, 

 Water: 1.333 and 

 Diamond: 2.417 

 

Fresnel 
 

 
 

With ray-traced transparency. 
With alpha buffered 

transparency. 

 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

Settings for Fresnel using ray- traced. 

Settings for Fresnel using Z 

transparency. 

 
 

 
Source-blender.org 

Link- 

Title- Img 2. 26 Fresnel Effect 

https://docs.blender.org/manual/en/dev/render/blender_render/materials/properties/transparency.html 
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Depth 
 

 

 
Title- Img 2. 27 Depth 

Source-blender.org Link- 

https://docs.blender.org/manual/en/dev/render/blender_render/materials/p  roperties/transparency.html 

 
Increasing Depth also considerably increases render time. Each time a light ray passes 

through a surface, the ray-tracing algorithm is called recursively. In the example above, each 

side of each glass has an exterior and an interior surface. Light rays thus have to pass through 

four surfaces for each glass. 

However not only that, at every point on a surface, some of the light can be reflected, or 

mirrored off the surface in various directions. This results in multiple rays needing to be 

calculated for each point (often referred to as a tree of rays). In each of the rendered images 

above there are 640×400=256 000 pixels. By increasing Depth, at least one tree of rays is 

added to each pixel. 
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Title- Img 2. 28 Transparent Shadows 

Source-blender.org 

Link-https://docs.blender.org/manual/en/dev/render/blender_render/materials/p   roperties/transparency.html 

 
Transparent shadows 

 
By default, the shadows of transparent objects are rendered solid black, as if the object was 

not transparent at all. However, in reality, the more transparent an object is, the lighter its 

shadow will be. 

In Blender, transparent shadows are set on the Materials that receive the shadows from the 

transparent object. This is enabled and disabled with the Receive Transparent button, in the 
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Material 

 Shadow panel. The shadow’s brightness is dependent on the Alpha value of the shadow 

casting Material. 

Alternatives to transparent ray-traced shadows can be found in the World tab, namely the 

Ambient Occlusion, Environment Lighting, and Gather panels. Alternatively, a texture can 

be used to control the Intensity value of the shadow-receiving Material. 

Mirror Reflection 

Mirror reflections are computed in the Blender Render and Cycles render engines using ray 

tracing. (NB: Reflections are not available in the Game Engine.) Ray tracing can be used to 

make a Material reflect its surroundings, like a mirror. 

The principle of ray-traced reflections is very simple: a ray is fired from the camera and travels 

through the scene until it encounters an object. 

 If the first object hit by the ray is not reflective, then the ray takes the color of the 

object. 

 If the object is reflective, then the ray bounces from its current location and travels up 

to another object, and so on, until a non-reflective object is finally met and gives the 

whole chain of rays its color. 

Eventually, the first reflective object inherits the colors of its environment, proportional to its 

Reflectivity value. Obviously, if there are only reflective objects in the scene, then the render could last 

forever. Hence a mechanism for limiting the travel of a single ray is set through the Depth value: this 

parameter sets the maximum number of bounces allowed for a single ray. 

 
Options 

 

Title- Img 2. 28 The Mirror Panel. 
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Source-blender.org Link- 

https://docs.blender.org/manual/en/dev/render/blender_render/materials/properties/mirror.html?highlight=mirror 

%20panel 
 

Enable ray-traced reflections 

Enable or disable ray-traced reflections 

Reflectivity 

Sets the amount of reflectiveness of the object. Use a value of 1.0 if you need a perfect mirror, 

or set it to 0.0 if you do not want any reflection. 

Mirror Color 

 
Title- Img 2. 29 Picking a mirror color. 

 

 
Source-blender.org Link- 

https://docs.blender.org/manual/en/dev/render/blender_render/materials/properties/mirror.html?highlight=mirror 

%20panel 
 

Color of mirrored reflection by default, an almost perfectly reflective Material like chrome, or 

a mirror object, will reflect the exact colors of its surrounding. However, some other equally 

reflective Materials tint the reflections with their own color. This is the case for well-polished 

copper and gold, for example. In order to replicate this within Blender, you have to set the 

Mirror Color accordingly. To set a mirror color, simply click the color button in the mirror 

panel and select a color. 

Options Fresnel 

Sets the power of the Fresnel effect. The Fresnel effect controls how reflective the Material is, 

depending on the angle between the surface normal and the viewing direction. Typically, the 

larger the angle, the more reflective a Material becomes (this generally occurs on the outline 

of objects). 

Blend 

A controlling factor to adjust how the blending happens between the reflective and non- 
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reflective areas. 

Depth 

Maximum allowed number of light inter-reflections. If your scene contains many reflective 

objects and/or if the camera zooms in on such a reflective object, you will need to increase 

this value if you want to see surrounding reflections in the reflection of the reflected object. 

In this case, a Depth of 4 or 5 is typically a good value. 

Max Distance 

Maximum distance of reflected rays away from camera (Z-Depth) in Blender Units. 

Reflections further than this range fade out to reduce compute time. 

Fade to 

The color that rays with no intersection within the Max Distance take. Material color can 

be best  for  indoor scenes, Sky color (World settings) for outdoorscenes. 

Title- Img 2.30 Suzanne in the Fun House 

Source-blender.org Link- 

https://docs.blender.org/manual/en/dev/render/blender_render/materials/properties/mirror.html?highlight=mirror 

%20panel 

Gloss 

In paint, a high-gloss finish is very smooth and shiny. A flat, or low gloss, finish disperses the 

light and gives a very blurry reflection. Also, uneven or waxed-however-grainy surfaces (such 

as car paint) are not perfect and therefore slightly need a Gloss greater than 1.0 

In the example to the right, the left mirror has a Gloss of 0.98, the middle is Gloss = 1.0, and 

the right one has Gloss of 0.90. Use this setting to make a realistic reflection, all the way up 

to a completely foggy mirror. You can also use this value to mimic depth of field in mirrors. 

Amount 

The shininess of the reflection. Values < 1.0 give Diffuse, blurry reflections and activate the 

settings below. 

Threshold 

Threshold for adaptive sampling. If a sampling contributes less than this amount (as 

percentage), sampling is stopped. Raising the threshold will make the adaptive sampler skip 
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more often, however, the reflections could become noisier. 

Samples 

Number of cone samples averaged for blurry reflection. More samples will give a smoother 

result, however will also increase render time. 

 
Anisotropic 

 

 
Title- Img 2. 31 Anisotropic tangent reflecting spheres with anisotropic set to 0.0, 0.75, 1.0. 

(.blend) 

Source-blender.org 

Link-https://docs.blender.org/manual/en/dev/render/blender_render/materials/p   roperties/mirror.html 

The shape of the reflection, from 0.0 (circular) to 1.0 (fully stretched along the tangent). If the 

Tangent Shading is on, Blender automatically renders blurry reflections as anisotropic 

reflections. When Tangent is switched on, the Anisotropic slider controls the strength of this 

anisotropic reflection, with a range of 1.0 (default) being fully anisotropic and 0.0 being fully 

circular, as is when tangent shading on the Material is switched off. 

 
Anisotropic ray-traced reflection uses the same tangent vectors as for tangent shading, so 

you can modify the angle and layout the same way, with the auto-generated tangents, or based 

on the mesh’s UV co-ordinates. 

Examples Fresnel 
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Title- Img 2. 32 Demonstration of Fresnel effect with values equal to (from top to bottom) 

0.0, 2.5 and 5.0. 

Source-blender.org Link- 

https://docs.blender.org/manual/en/dev/render/blender_render/materials/p  roperties/mirror.html 

 
Let us undertake a small experiment in order to understand what Fresnel is really about. After 

a rainy day, go out and stand over a puddle of water. You can see the ground through the 

puddle. If you kneel just in front of the puddle, your face close to the ground, and look again 

at a distant point on the puddle of water, the liquid surface part which is closer to you lets you 

see the ground, however if you move your gaze towards the other end of the puddle, then the 

ground is gradually masked until all you see is the reflection of the sky. This is the Fresnel 

effect: having a surface sharing reflective and non-reflective properties according to the 

viewing angle and the surface normal. 

In Demonstration of Fresnel effect with values equal to (from top to bottom) 0.0, 2.5 and 5.0, this 

behavior is demonstrated for a perfectly reflective Material (Mirror Reflectivity 1.0). 

 Fresnel 0.0 stands for a perfect mirror Material, 

 Fresnel 5. 0 could stand for a glossy Material. 

It is barely noticeable however in the lower picture, the Material is perfectly reflective around 

the edges. 

The smoothness of the Fresnel limit can be further controlled using the Blend slider. 
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Subsurface Scattering (SSS) 

Many organic and inorganic Materials are not totally opaque right at the surface, so light does 

not just bounce off the top surface. Instead, some light also penetrates the skin surface deeply, 

and scatters around inside, taking on the color of the insides and emerging back out at a 

different location. Human/animal skin, the skin of grapes, tomatoes, fruits, wax, gels (like 

honey, or Jello) and so on all have Subsurface Scattering (SSS), and photo-realism really 

cannot be achieved without it. 

It is important to understand that Subsurface Scattering and Diffuse are one and the same. 

The difference is in how far light can Diffuse beneath the surface before it is absorbed or 

transmitted back out. 

How it works 

Actually, calculating the light path beneath the surface of an object is not practical. However, 

it has been shown that it is not necessary to do this, and that one can use a different approach. 

Blender calculates SSS in two steps: 

Step 1: At first, the irradiance, or brightness of the surface is calculated, from the front side 

of the object as well as from its back side. This is pretty much the same as in a normal render. 

Ambient Occlusion, Radiosity, the type of Diffuse Shader, the light color, etc. are considered. 

 
Step 2: In the second step, the final image is rendered, however now the SSS Shader replaces 

the Diffuse Shader. Instead of the lamps, the calculated lightmap is used. The brightness of a 

surface point is the calculated “Average” of the brightness of its surrounding points. 

Depending on your settings the whole surface may be considered, and it is a bit more 

complicated than simply calculating the average, however do not bother too much with the 

math behind it. 

Instead, let us see what SSS does to a distinct light point. 
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No SSS. 

 

 

Small SSS radius. 

 

 

 

SSS radius enlarged. 

 

 

SSS with very large red 

radius value. 

Title- Img 2.33 SSS. 

 
Source-blender.org Link- 

https://docs.blender.org/manual/en/dev/render/blender_render/materials/properties/subsurface_scattering.html 

If you turn on SSS, the light is distributed over a larger area. The size of this area depends 

on the radius values. Instead of distributing all colors with the same amount, you may choose 

different radius values for each of the RGB colors. If you use a very large radius value for a 

color, its light is evenly distributed over the whole object. 

 
Enabling Subsurface Scattering 

 

 

Title- Img 2. 34 The SSS Panel. SSS is already enabled. 

Source-blender.org Link- 
https://docs.blender.org/manual/en/dev/render/blender_render/materials/p  roperties/subsurface_scattering.html 
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Step 1: Enable SSS by clicking on the Subsurface Scattering button. 

 
Step 2: Accessible at the top are various presets. When you select a preset, the Radius values, 

the RGB Radius and the IOR are set for you. The remaining options are not set (because they 

are mostly dependent on the size of your object). 

 
SubsurfaceScatteringdoes not need ray tracing. However, since it is dependent on the incident 

light and shadows, you need proper shadow calculation (which may need ray tracing). 

 
Developing your own SSS Material 

The Traditional Approach 

A more common however less intuitive approach is to use “layering”. This is a simplified 

version of the layering approach. See the external links for more information: 

Step 1: 

Set the SSS color on a value of your choice, normally the predominant color of the object. If 

you want to use different radii for the colors, do not make it too dark. 

Step 2: 

Set the scale factor. If you want to see much translucency you need small objects or large 

scale values. 

Step 3: 

Set the radius values. 

Step 4: 

Adjust the brightness with the Frontand Backvalues. 

 
A more intuitive approach 

Step 1 

Set the Scattering color to 0.5 

Step 2 

Set the Front weight to 2.0 

Step 3 

Set the scale factor based on the size of your object relative to the scene. If you want to see much 

translucency you need small objects or large scale values. 

Step 4 

Set the radius values appropriately. 
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Examples 

Skin 
 

 

Scale: 1. 

 

 

Scale: 2. 

 

 

Scale: 3. 

 

 

Scale: 4. 

 

 

Scale: 5. 

 
Title-Img 2.35 Increasing SSS scale (blend-file) 

Source-blender.org Link- 

https://docs.blender.org/manual/en/dev/render/blender_render/materials/p  roperties/subsurface_scattering.html 

 
Strands 

The Strand section of the Material tab is specific to the rendering of Hair particles. There 

are two different strand methods available: 

Polygon strands 

This is the default (old) method. The strands are rendered as flat polygons. The number of 

polygons depend on the Steps settings in the Particles system tab. 

Strand Primitive 

You activate Strand Primitive with the button Strand render in the Render panel of the 

particle system. The hair curves are not stored as polygons; only the key points are stored, 

which are then converted to polygons on the fly. A second difference is the way transparency 

works. Rather than rendering using the existing system, all strand segments in a part are sorted 

front to back and rendered in that order. 

Polygon strands 

 
 Work well with greater width, so you can use them as an alternative to billboards because 

the strands may have an animated shape. 

 Can be textured with a UV-Texture along the strands. 

 Are seen by ray tracing. 
 
 

 
Strand Primitives 
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Are more memory efficient and faster, to make rendering of large amounts of fur and grass 

possible. For good performance, the render steps button should be lowered (e.g.2 should 

be good enough fur), since the result will be a smoothed curve anyway. You need 1 to 2 render 

steps less than steps in the 3D View. Also, using more render parts helps to reduce memory 

usage. 

 
 Have a distance of vision reduction (in the Render panel under Child Simplification) for 

children from faces. 

 May be faded out towards the tip without an additional texture. 

 Are not ray traced. So, they are not visible through ray- transparent Materials or in a 

ray mirror (you can use Environment Mapping for that). 

 Have shape problems if they are rendered with a greater width. 

 Cannot carry a UV-Texture along the strand. 

 
Strands Shading 

 

 
Title- Img 2.36 Strands Panel. 

Root Tip 

Source-blender.org Link- 

https://docs.blender.org/manual/en/dev/render/blender_render/materials/p  roperties/subsurface_scattering.html 
 

Strands are rendered with the Material of the underlying face/vertex, including shading with 

a UV-Texture. Since you can assign more than one Material to each face, each particle system 

may have its own Material and the Material of the underlying face can be different from the 

Material of the strands. 

Additionally, strands can be shaded along the strand (from root to tip) with a mono- 

dimensional texture; only polygon strands can carry a two-dimensional UV-Texture. 

Options: 

The options for strand shading are in the Strands section of the Materialtab. (Refer Img 2.37) 
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Width of the hair at the root. Width of 42the hair at the tip. 

Minimum 

This is the minimum thickness (in pixels) of the strands. Strands below that size are not 

rendered smaller, however are faded to alpha (well, the fading works only for strand 

primitives). This gives a much better rendering result for thin hair. 

Blender Units 

Normally strands are quite thin; the thickness is given in screen pixels. If you use Blender 

Units (BU) you may set the root value up to 2 BU, and the tip value up to 1 BU. You have 

to consider the overall object size, because the smallest possible size is 0.001 BU. So if you 

use 1 BU for 1 meter the smallest possible size would be 1 mm (too thick for thin hair). 

Use Tangent Shading 

Calculates the light as if the strands were very thin and round. This makes the hair appear 

brighter and shinier. Disabling the “Tangent Shading” option will still render nicely, 

however resembles more solid strands, as though made of metal or wood. 

Shape Slider 

 
This slider allows you to control the interpolation. Default (0.0) is a linear interpolation 

between Root and Tip. A negative value will make the strand narrower (spiky), a positive 

value will make it fatter. 

 

Title- Img 2. 37 Various Shape settings. From left to right, 0 (root and tip are equal in the first), 

0, -0.4, -0.9, 0.4, 0.9. 

 
Source-blender.org Link- 

https://docs.blender.org/manual/en/dev/render/blender_render/materials/p  roperties/strands.html 

 
Width Fade 

To fade out along the width of the strand. This works only for Strand Primitives. 0.0 is no 

fading at all, 1.0 linear fading out. 

UV Layer 



131  

You can texture polygon strands with a UV-Texture. Fill in the name of the UV-Set (not the 

texture) here. You also must load the texture in the Texture tab and Material tab (Mapping: 

UV) you may use every Influence setting you like – especially the alpha value; 

Refer Img 2.38 ->From left to right, 0 (root and tip are equal in the first), 0, -0.4, -0.9, 0.4, 

0.9.). 

Surface Diffuse 

Computes the strand normal, taking the normal at the surface into account. This eases the 

coloring and lighting of hair a lot, especially for Strand Primitives. Essentially hair reacts 

similar to ordinary surfaces and do not show exaggerated strong and large Specular highlights. 

Distance 

The distance in Blender Units over which to blend in the normal at the surface (if you want to 

use Surface Diffuse only for Grass/Fur at greater distances). 

Texturing along the Strand 

Strands can be textured along the strand, i.e. from root to tip. To do that you must select 

Strand/Particle in the Coordinates select menu in the Mapping panel of the Material tab. 

 
Pretty much the most important setting is shown in Image 2.39 ->Fading a strand to alpha. 

How to fade the tip of a strand to alpha to make nice, fuzzy-looking hair. Normally you would 

use a linear blend texture for this. 
 

 

 

Fading a strand to alpha. 

 

 

The render result. 

 
Title- Img 2. 38Texturing along the strand 

Source-blender.org Link- 

https://docs.blender.org/manual/en/dev/render/blender_render/materials/p  roperties/strands.html 
 

 
You may of course set any attribute you like, especially color. Be careful with Specularity; 

hairs tend to get too shiny. 

Strand Render Simplification 
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If you use Strand Primitives (Strand render button) and haveactivated Interpolated Children, 

the Child Simplification option appears. The strand render has options to remove child strands 

as theobject’s facesbecomesmaller. 

 

 
Title- Img 2. 39 Strand render child simplification. 

Source-blender.org Link- 

https://docs.blender.org/manual/en/dev/render/blender_render/materials/p  roperties/strands.html 

 
Material Options Panel 

 

 
Title- Img 2. 40 Material Options panel 

Source-blender.org Link- 

https://docs.blender.org/manual/en/dev/render/blender_render/materials/p  roperties/options.html 

 
Shadows Panel 

This panel provides a series of control options concerning how objects using this Material 

will appear in the rendered image. All controls are set default to “Off” unless otherwise stated. 

 
The Shadows that appear in a scene are affected by a combination of the layout of objects, 

the shape of the objects, the Materials of the objects, and the lighting. In Blender, the Display 

Mode (Single Texture, Multitexture, or GLSL) also affects the appearance of shadows. 
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Title- Img 2. 41 Shadow Panel. 
 

Source-blender.org 

Link- 

https://docs.blender.org/manual/en/dev/render/blender_render/materials/properties/shadows.html?highlight=shad 

ows%20panel 

 
 

The Shadow panel in the Materials Properties editor(Refer Img 2.42) controls the effects that 

the Material can have on the shadows that appear in the scene. The various properties are 

described in the sections below. 

 

 
Title- Img 2. 42 Scene with all shadow properties off. 

 
Source-blender.org Link- 

https://docs.blender.org/manual/en/dev/render/blender_render/materials/properties/shadows.html?highlight=sha 

dows%20panel 

Options 

The following properties can be set for each individual Material with which objects in the 

scene are shaded. The effects are illustrated with rendered images for a simple scene (Refer 

Img 2.43) consisting of two “posts”, one with red (totally non-transparent) Material one with 

green (partially transparent) Material set up on a light blue plane to receive the shadows. 

The illustrations were all taken in Blender Render engine, with Multitexture mode. 
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Shadow Receiving Object Material 

The following options affect the Material that receives shadows: 

Receive 

Allows this Material to receive full-intensity shadows (Refer Img 2.44 Plane with Receive.). 
 

Receive Transparent 

Allows this Material to receive shadows whose intensity is modified by the transparency and 

color of the shadow-casting object (Refer Img 2.44 Plane with Receive and Receive 

Transparency.). 

 
 

 

Title- Img 2. 43Shadow receiving object material 

 
Source-blender.org Link- 

https://docs.blender.org/manual/en/dev/render/blender_render/materials/properties/shadows.html?highlight=shad 

ows%20panel 

 
Shadow Casting Object Material 

 
The following options affect the Material that casts shadows: 

Cast Only 

Causes objects with the Material to only cast a shadow, and not appear in renders. (Refer Img 

2.45 - Posts with Cast Only.). 

Casting Alpha 

Sets the Alpha of shadow casting. Used for irregular and deep shadow buffering. 

Shadows Only 

Renders shadows as Materials alpha value, making Materials transparent, except for areas 

where it receives shadows from other objects, and it retains its own transparency (Refer Img 
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Posts with Shadows Only. 

 
 
 
 
 
 
 
 
 
 

Posts with Cast Only. 

2.45 - Posts with Shadows Only). Note the faint image of the partly- transparent post. 
 

Shadow Only Type 

Set the type of shadows used when Shadows only is enabled. 

 Shadow and Distance

 Shadow Only

 Shadows and Shading

 

 
Title- Img 2. 44 Shadow & cast 

Source-blender.org Link- 

https://docs.blender.org/manual/en/dev/render/blender_render/materials/properties/shadows.html?highlight=sha 

dows%20pane 

 
Buffered Shadow Options 

In addition to the shadow options described above, there are further Material properties which 

control buffered shadow features. See Section On-Spot Buffered Shadows for further 

discussion of these techniques. 

 

Unit summary 
In this Unit, we have learnt what is the Material and how to 

 Use Shaders, Colors

 Preview those Shaders with Specular and Ramps in your Material editor

 Edit the Properties of the Shaders

 Work on Transparency settings to create Reflection and Refractions using Index 

tables to create Mirrors and Glasses

 Work on Subsurface Scattering which helps the objects to create scattering of lights 

and shadows within the objects.
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After learning of this Unit, you can download the Open Source Software available on the 

internet for free of cost to practice the possibilities of creating Materials. 

Assignment 
Createa Simple Living Roomwithfewobjectslike Chairs, Tables, FlowerVases,MetalObjects, 

Papers/Files/Books,Glassesetc.,and assign Shaders to the scene. Use Index of Refraction 

table https://en.wikipedia.org/wiki/List_of_refractive_indices 

 
Use these key words “living room”, “3d Shaders” on https://www.google.com to collect the 

reference images to build your shadingscenes. 

Assessment 

 Define Diffuse Shader

 Differentiate between Lambert Shader and Toon Shader

 Write notes about Specular Shaders with Illustrations

 Explain the Process of making a Glass Shader

 List the IOR values of any 5 common Materials based on Liquids, Transparent 

Materials, Opaque Materials, Gemstones and Metals

 Write notes about Subsurface Scattering and its usage in the real-time situations

 Describe the use of Strands Shader

 Define Shadows in 3D Mode

 

 

Resources 
While studying this course, you can browse the internet links for video tutorials and to download the 
relevant texture maps to assign on the objects that you have created and use the same for your assignments. 

 wiki.blender.org

 archive.org

 www.blender.org

 docs.blender.org
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Unit 5 Shading Organic Models 
 

Introduction 

Our eyes have been trained to believe that an image is real if it shows Artifacts that result 

from the Mechanical Process of photography. 

Three examples of these Artifacts are 

1. Motion Blur 

2. Depth of Field 

3. Lens Flares 

We will learn about Motion Blur and Depth of Field in the next Unit 04. 

We will learn about Lens Flares in this Unit, which can be produced with special Materials 

and Shader. A simulated lens flare tells the viewer that the image was created with a camera, 

which makes the viewer think that it is authentic. 

Many things can happen to the light as it passes through the volume, which will influence the 

final color that arrives at the camera. This represents physical interactions that happen in the 

real world. Most of these are dependent on the density of the volume, which can either be a 

constant density throughout, or varied, controlled by a texture. 

It is by controlling the density that one can get the typical ‘Volumetric’ Effects such as clouds 

or thick smoke or fire using Volume Rendering. 

Outcomes 

Upon completion of this unit you will be able to: 

 Create Special Effects for your 3D Scenes using the Materials and Shaders;

 Identify the different type of Material effects available in Blender to create

Authentic Photo Effects; 

 Create Volume Renders for light that passes through Materials;

 Create Fire and Fog Effects

 Design various styles of rendering using Special Materials and Shaders
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Terminology 
 

 
Alpha: This is the Transparency information of the Shader. 

Diffuse Color: The color of the Halo itself. 

Size: Sets the dimension of the Halo. 

Seed: If non-zero, it will randomize the ring dimension and line location. 

To use, give any (integer) number to start the random-number 

generator. 

Hardness: Sets the hardness of the Halo. Like specular hardness 

Vertex 

Normal: 

Use the vertex normal to specify the dimension of the Halo. 

Halo Rendering 

 

Title- Img3.1 Activating Halo rendering. 

 
Source-blender.org Link- 

https://docs.blender.org/manual/en/dev/render/blender_render/materials/special_effects/halo.html?highlight=activat 

ing%20halo%20rendering 

 
Halo Material renders each object’s points as glowing dots or some little clouds of light. 

Although they are not really lights, because they do not cast light into the scene like a lamp. 

These are called Halos because you can see them, however, they do not have any substance. 

Halos are rendered with Vertex Shaders and not with Face Shaders. 

This Material is useful for simulating special effects, like Particle effects or Lens Flares. 
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Options 
 
 
 

Title- Img 3. 2 Halo panels. 

Source-blender.org 

Link- 

https://docs.blender.org/manual/en/dev/render/blender_render/materials/special_effects/halo.html?highlight=activat 

ing%20halo%20rendering 

 
To enable Halos, Step 1: Press the Halo button in the Material menu’s top panel. As 

you would see in the 3D View, the Mesh faces are no longer rendered. Instead just the 

Vertex is rendered, since that is where each Halo will originate. Halos can be hard to 

find in a crowded scene, so name it well for easy location in the outliner. In the roperties 

Editors, we normally find the Diffuse, Specular, and Shading panels. Now, we see 

Panels relative to the Halo characteristics: 

Halo Panel 
 

Alpha The transparency. 

Diffuse Color The color of the Halo itself. 

Seed If non-zero, it randomizes the ring dimension and line location. To use, 

give any (integer) number to start the random-number generator. 

Size Sets the dimension of the Halo 

Hardness Sets the hardness of the Halo. Like specular hardness 

Add Determine how much the Halo colors are ‘added to’, rather than mixed 

with, the colors of the objects behind and together with other Halos. By 

increasing Add, the Halo will appear to light up objects that move 

behind it or through the Halo field. (Refer Img 3.3) 
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Title- Img 3. 3 Effect of Add. Source-blender.org 

Link- 

https://docs.blender.org/manual/en/dev/render/blender_render/materials/special_effects/halo.html?highlight=activat 

ing%20halo%20rendering 

 
Texture Gives Halo a texture. By default, textures are applied to objects with 

Object coordinates and reflects on the Halos by affecting their color 

based on the color of the vertex originating the Halo. Enable this 

feature to have the texture take effect within the Halo, and hence 

to have it with varying colors or transparencies; this will map the 

whole texture to every Halo. This technique proves very useful 

when you want to create a realistic rain effect using particle 

systems, or similar. 

Vertex Normal Use the vertex normal to specify the dimension of the Halo. 

Extreme Alpha Boosts alpha. 

 
Shaded 

 
Let Halo receive light and shadows from external objects. When 

shaded is enabled, the Halo will be affected by local light; a lamp will 

make it brighter and affect its diffuse color and intensity. 

Soft Softens the edges of the Halos at intersections with other geometry. In 

addition, several other special effects are available. To enable some of 

these effects, set the number of points/rings, or set the color of each 

effect individually: 
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You cannot use color ramps. Lines, Rings and an assortment of special effects are available 

with the relevant toggle buttons, which include Flare, Rings, Lines, Star, Texture, Extreme 

Alpha, and Shaded. Halo Variations shows the result of applying a Halo Material to a single 

vertex mesh. 

 

Title- Img 3. 4 Halo Variations 

Source-blender.org 

Link- 

https://docs.blender.org/manual/en/dev/render/blender_render/materials/special_effects/halo.html?highlight=activat 

ing%20halo%20rendering 

 
Flare Panel Enabling Flare Renders the Halo as a lens flare. 

Size Sets the factor by which the flare is larger than the Halo. 

Boost Give the flare extra strength. 

Seed Specifies an offset in the flare seed table. 

Subflares Sets the number of subflares. 

Subsize Sets the dimensions of the subflares, dots, and circles. 

 
Lens Flares 

Our eyes have been trained to believe that an image is real if it shows Artifacts that result 

from the Mechanical Process of photography. 

Three examples of these Artifacts are 

1. Motion Blur 

2. Depth of Field 

3. Lens Flares 
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We will learn about Motion Blur and Depth of Field in the next Unit 04. 

Now, we learn about Lens Flares in this Unit, which can be produced with special Materials 

and Shader. A simulated lens flare tells the viewer that the image was created with a 

camera, which makes the viewer think that it is authentic. 

We create Lens Flares in Blender from a mesh object using first the Halo button and then 

the Flare options in the Shaders Panel of the Material settings. Try turning on Rings and 

Lines, however, keep the colors for these settings fairly subtle. Play with the Flares: 

number and Fl. seed: settings until you arrive at something that is pleasing to the eye. You 

might need to play with Boost: for a stronger effect. 

Note that this tool does not simulate the physics of photons traveling through a glass lens; it’s 

just an eye candy. 

Blender’s Lens Flarelooksniceinmotion, anddisappearswhen another object occludes the flare 

mesh. 

 
 
 
 
 
 
 
 
 
 
 
 

 
Title- Img 3. 4Lens Flare. Source-blender.org 

Link- 

https://docs.blender.org/manual/en/dev/render/blender_render/materials/special_effects/halo.html?highlight=activat 

ing%20halo%20rendering 

Halo Texturing 

By default, textures are applied to objects with Object coordinates and reflects on the Halos 

by affecting their color, as a whole, on the basis of the color of the vertex originating the Halo. 

To have the texture take effect within the Halo, and hence to have it with varying colors or 

transparencies press the Texture button; this will map the whole texture to every Halo. This 

technique proves very useful when you want to create a realistic rain effect using particle 

systems, or similar. 
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Another Option is Shaded. When shaded is enabled, the Halo will be affect by local light; a 

lamp will make it brighter and affect its diffuse color and intensity. 

Examples 
 

Dot-Matrix Display 

 
Let us use a Halo Material to create a dot-matrix display: 

Step 1: To begin, add a grid with the dimensions 32×16. Then add a camera and adjust your 

scene so that you have a nice view of the billboard. 

Step 2: Use a 2D image program to create some red text on a black background, using a simple 

and bold font, you can just save the picture on your hard drive as Dot-matrix image texture and 

show an image 512 pixels wide by 64 pixels high, with some black space at both sides. 

Title- Img 3. 5Dot matrix image texture. Source-blender.org 

Link- 

https://docs.blender.org/manual/en/dev/render/blender_render/materials/special_effects/halo.html?highlight=activat 

ing%20halo%20rendering 

 
Step 3: Add a Material for the billboard, and set it to the type Halo. Set the Halo Size 

to 0.06 and when you render the scene you should see a grid of white spots. 

Step 4: Add a Texture, then change to the Texture Buttons and make it an image texture. When 

you load your picture, and render again you should see some red tinted dots in the grid. (Refer 

Img 3.6) 

Step 5: Return  to  the Material  Buttons  and  adjust the size X 

parameter to about 0.5 then render again; the text should now be centered on the Billboard. 

Step 6: To remove the white dots, adjust the Material color to a dark red and render. You 

should now have only red dots; however, the billboard is still too dark. To fix this enter Edit 

Mode for the board and copy all vertices using the Shift-D shortcut (take care not to move 

them!). Then adjust the brightness with the Add value in the Halo panel. (Refer Img 3.7) 
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Title- Img 3. 6Dot Matrix display 

 
Source-blender.org Link- 

https://docs.blender.org/manual/en/dev/render/blender_render/materials/special_effects/halo.html?highlight 

=activating%20halo%20rendering 
 

You can now animate the texture to move over the billboard, using the Offset X value in the 

Texture tab of the Mapping panel. (You could use a higher resolution for the grid, however, if 

you do you must adjust the size of the Halos by shrinking them, or they will overlap. (Refer 

Img 3.7 Dot Matrix display). 

Volume Rendering 
 

 
Title- Img 3. 7Activation volume rendering. 
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Source-blender.org Link- 

https://docs.blender.org/manual/en/dev/render/blender_render/materials/special_effects/volume.h 

tml?highlight=activation%20volume%20rendering 

 

 
Title- Img 3. 8Volume rendering. 

Source-blender.org Link- 

https://docs.blender.org/manual/en/dev/render/blender_render/materials/special_effects/volume.html?highlight=activati 

on%20volume%20rendering 

Volume Rendering is a method for rendering light as it passes through participating media, within 

a 3D region. The implementation in Blender a physically based model, which represents the 

various interactions of light in a volume relatively realistically. 

 
Rendering a volume is different than Solid Render. For volume light enters a 3D region of space (defined 

as the volume) that may be filled with small particles, such as smoke, mist or clouds. The light bounces 

around off the various molecules, being scattered or absorbed, until some light passes through the volume 

and reaches the camera. For that volume to be visible, the renderer must figure out how much Material the 

light has passed through and how it has acted and reacted within that volume, the volume object needs to 

contain a 3D region of space, for example a manifold closed mesh, such as a cube, not just a flat 

surface like a plane. To get an image, the renderer must step through that region, andseehowmuch‘stuff’is 

there(density)toseehowlight is absorbed or scattered or whatever. This can be a time-consuming process 

since it must check a lot of points in space and evaluate the density at each. 

 
Options 

 
 
 
 
 
 
 
 

 
Title- Img 3. 9 Constant density vs textured density. Source-blender.org 
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Link- 

https://docs.blender.org/manual/en/dev/render/blender_render/materials/special_effects/volume.html?highlight=activati 

on%20volume%20rendering 

 
Many things can happen to the light as it passes through the volume, which will influence the final 

color that arrives at the camera. These represent physical interactions that happen in the real world, 

and most of these are dependent on the density of the volume, which can either be a constant 

density throughout, or varied, controlled by a texture. It is by controlling the density that one can 

get the typical ‘volumetric’ effects such as clouds or thick smoke. 

Density 

The base density of the Material. Other densities from textures are added on top. 
 
Density Scale 

A global multiplier to increase or decrease the apparent density. This can be useful for getting 

consistent results across different scene scales. 

Shading 
 

 

 
Title- Img 3. 10 Spot lamp scattering in a constant volume. 

 
Source-blender.org 

Link- 

https://docs.blender.org/manual/en/dev/render/blender_render/materials/special_effects/volume.html?highlight=activati 

on%20volume%20rendering 
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When light enters a volume from an external source, it does not just pass straight through. Light 

gets scattered off tiny particles in the volume, and some proportion of that light reaches the camera. 

This property makes it possible to see light beams as they travel though a volume and are scattered 

towards the eye. 

Options 

 

Title- Img 3. 11 Shading options. 

Source-blender.org 

Link- 

https://docs.blender.org/manual/en/dev/render/blender_render/materials/special_effects/volume.html?highlight=activati 

on%20volume%20rendering 

Scattering 

 
The amount of light that is scattered out of the volume. The more light that is scattered out of the 

volume, the less it will penetrate through the rest of the volume. Raising this parameter can have 

the effect of making the volume seem denser, as the light is scattered out quickly at the ‘surface’ 

of the volume, leaving the areas internal to the volume darker, as the light does not reach it. 

Note in the examples below, the less light that is scattered out of the volume, the more easily it 

penetrates throughout the volume and to the shadow. 

 
 

 

Scattering: 

0.5. 

 

 

Scattering: 

1.0. 

 

 

Scattering: 

2.0. 

 

 

Scattering: 

5.0. 

Title- Img 3. 12 Scattering Source-blender.org 
 
 
Link- 

https://docs.blender.org/manual/en/dev/render/blender_render/materials/special_effects/volume.html?hi 

ghlight=activation%20volume%20rendering 
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Title- Img 3. 13 Isotropic and Anisotropic scattering. 

 
Source-blender.org Link- 

https://docs.blender.org/manual/en/dev/render/blender_render/materials/special_effects/volume.html?highlight=activati 

on%20volume%20rendering 

 
Types of Scattering 

 
 The default method for scattering light in a volume is for the light to be deflected evenly in all 

directions, also known as Isotropic scattering.

 In real life, different types of media can scatter light in different angular directions, known 

as Anisotropic scattering.

 Back-scattering means that light is scattered more towards the incoming light direction.
 
 Forward-scattering means it is scattered along the same direction as the light is traveling.

 

 
Asymmetry 

 
Asymmetry controls the range between back-scattering (-1.0) and forward-scattering (1.0). The 

default value of 0.0 gives Isotropic scattering (even in all directions). 

 
Transmission 

 
Transmission is a general term for light that is transmitted throughout a volume. 
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This transmitted light can be the result of various interactions, for example: 

 the left-over result of incoming light after it has reflected/scattered out of the volume
 
 the left-over result of light after being absorbed by the volume (and converted to heat)

 
Here, the transmission color is used to set the result color that light becomes after it is transmitted 

through the volume. 

Transmission Color 

The resultant color of light that is transmitted through the volume. 

Note in the examples below, as more light is scattered out of the volume, there is less available 

to be transmitted through. 

 

 

 

 

Transmission 

color: 

Yellow, 

Scattering: 

0.5. 

 

 

Transmissio 

n color: 

Yellow, 

Scattering: 

1.0. 

 

 

Transmissio 

n color: 

Yellow, 

Scattering: 

2.0. 

 

 

Transmissio 

n color: 

Yellow, 

Scattering: 

5.0. 

Title- Img 3. 14 Transmission of color. Source-blender.org 

Link- 

https://docs.blender.org/manual/en/dev/render/blender_render/materials/special_effects/volume.html?highlight=activati 

on%20volume%20rendering 

 Emission
 

Some volumes can emit light where there was none before, via chemical or thermal processes, 

such as fire. This light is generated from the volume itself and is independent of light coming 

from external sources. 

Currently, this emitted light does not affect other volumes or surfaces (like surface Material 

type, ‘Emit’ option). 

 Emission Color
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The color of light that is emitted by the volume. 

 

Emission 
 
 
An intensity multiplier for the emitted color, for scaling up and down. 

 

 

 

Emission 

0.25, 

Scattering: 0.5. 

 

 

Emission 

0.25, 

Scattering: 1.0. 

 

 

Emission 

0.25, 

Scattering: 2.0. 

 

 

Emission 

0.25, 

Scattering: 5.0. 

Title- Img 3. 15 Emission 

 
Source-blender.org Link- 

https://docs.blender.org/manual/en/dev/render/blender_render/materials/special_effects/volume.html?highlight=activati 

on%20volume%20rendering 

 
Reflection 

 
The Reflection parameters can be used to tint or scale the light that is scattered out of the volume. 

This affects only the light that has come from lamps and been scattered out, it does not affect the 

color of transmitted or emitted light and is. 

These settings are not physically correct, because they do not conserve energy. This means the 

light scattering out does not affect the remaining light, that is transmitted throughout the rest of the 

volume. 

For example, if the orange components of the light are scattered out of the volume towards the 

camera, only the inverse of that (blue) will remain to continue penetrating through the 

volume,causing the volume to take on a multi-colored appearance, which can be difficult to use. 

To make it a bit easier to plainly set the color of the volume, you can use the reflection 

parameters to quickly set an overall tint. 

 
 Reflection Color

 
The color of light that is scattered out of the volume. 
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 Reflection

 
An intensity multiplier for the reflection, for scaling up and down. 

 

 

 

 

 

 

 

 

 

Reflection: Reflection: Reflection: Reflection: 

Green, Green, Green, Green, 

Scattering: Scattering: Scattering: Scattering: 

0.5. 1.0. 2.0. 5.0. 

 

 

 

 

 

 

 

 

Reflection: Reflection: Reflection: Reflection: 

Green, Green, Green, Green, 

Transmissio Transmissio Transmissio Transmissio 

n: Yellow, n: Yellow, n: Yellow, n: Yellow, 

Scattering: 0.5. Scattering: 1.0. Scattering: 2.0. Scattering: 5.0. 

 
Title- Img 3. 16 Reflection 

Source-blender.org Link- 

https://docs.blender.org/manual/en/dev/render/blender_render/materials/special_effects/volume.html?highlight=activati 

on%20volume%20rendering 

 
Lighting 
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Title- Img 3.17 Lighting options. Source-blender.org 
 

Lighting Mode  

Shadeless Shadeless is the simplest, useful for thin, wispy mist or steam. 

Shadowed Shadowed is similar, however, with shadows of external objects. 

Shaded Shaded uses a volumetric single-scattering method, for self-shading 

the volume as light penetrates through. 

Multiple Scattering Allows multiple scatter calculations. 

Shaded + Multiple 

Scattering 

Combines Shaded and Multiple Scattering functionality. 

Shaded Options  

External Shadows Receive shadows from sources outside the volume (temporary). 

Light Cache Pre-calculate the shading information into a voxel grid, speeds up 

shading at slightly less accuracy. 

Resolution Resolution of the voxel grid, low resolutions are faster, high 

resolutions use more memory. 

Multiple Scattering Options 

Diffusion Diffusion factor, the strength of the blurring effect. 

Spread Proportional distance over which the light is diffused. 

Intensity Multiplier for multiple scattered light energy. 

Transparency The transparency settings are the same as Solid 

Render except you have less settings. For volume 

rendering you only have: 

 Mask 

 Z Transparency 

 Raytrace 
 

 
Link- 

https://docs.blender.org/manual/en/dev/render/blender_render/materials/special_effects/volume.html?highlight=activati 

on%20volume%20rendering 

 
Several shading modes are available, providing a range of options between fast to render and 

physically accurate. 
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Integration 
 

 

Title- Img 3. 18 Integration options. Source-blender.org 

Link- 

https://docs.blender.org/manual/en/dev/render/blender_render/materials/special_effects/volume.html?highlight= 

activation%20volume%20rendering 
 

Step Calculation 

Method 

Method of calculating the step through the volume. 

Randomized Randomized method of calculating the step. 

Constant Constant method of calculating the step. 

Step Size Distance between subsequent volume depth samples. Step Sizes 

determine how noisy the volume is. Higher values result in lower 

render times and higher noise. 

 
Depth Cutoff 

Stop ray marching early if transmission drops below this 

luminance threshold. Higher values will give a speedup in dense 

volumes at the expense of accuracy. 
 
 

 
Options 

 

Title- Img 3. 19Material volume options. 

 
Source-blender.org Link- 

https://docs.blender.org/manual/en/dev/render/blender_render/materials/special_effects/volume.html?highlight=activati 

on%20volume%20rendering 

 
 Traceable
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Allow this Material to calculate ray tracing. 

 Full Oversample

Force this Material to render full shading/textures for all anti-aliasing samples. 

 Use Mist

Use mist with this Material (in world settings). 

 Light Group

Limit lighting of this Material to lamps in this group. 

 Exclusive

Material uses this group exclusively. Lamps are excluded from other scene lighting. 

Smoke and Fire 

Create the Material The Material must be a Volumetric Material with a Density of 0, and 

a high-Density Scale. 

 

Title- Img 3. 20The Material Settings. 
 
 
Source-blender.org Link- 

https://docs.blender.org/manual/en/dev/render/blender_render/materials/special_effects/volume.html?highlight=activati 

on%20volume%20rendering 
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Smoke requires a complex Material to render correctly. 

Step 1: Select the big cube 

Step 2: Go to the Material tab. 

Step 3: Change the Material to ‘Volume’ S 

Step 4: Set the density to 0. If you set the density to values bigger than 0 the domain 

cube will be filled with the volume Material. 

The other settings willaffectthesmoke, though. We’llcoverthose later. 

Add the Texture 

 
In addition, Smoke requires its own texture, you can use a Volumetric Texture known as Voxel 

Data. You must remember to set the domain object and change the influence. 

 

Title- Img 3. 21The texture settings.Source-blender.org 

Link- 

https://docs.blender.org/manual/en/dev/render/blender_render/materials/special_effects/volume.html?highlight=activati 

on%20volume%20rendering 

Step 1: Go to the Texture tab 
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Step 2: Change the Type to VoxelData. 

Step 3: Under the Voxel Data-Settings, set the Domain Object to our domaincube (it should be listed 

just as ‘Cube’ since we are using Blender’s default cube. 

Step 4: Under Influence check ‘Density’ and leave it at1.000 (Emission should be automatically 

checked, too). 

Now you should be able to render single frame. You can choose to color your 

smoke as well, by turning Emission Color back on. 

Title- Img 3. 22Finished Result. 
 
Source-blender.org 

Link- 

https://docs.blender.org/manual/en/dev/render/blender_render/materials/special_effects/volume.html?highlight=activati 

on%20volume%20rendering 

 
Smoke Simulator with fire texture 

 
You can also turn your smoke into fire with another texture! 

 

 

Title- Img 3. 23 The Fire Material. 
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Source-blender.org Link- 

https://docs.blender.org/manual/en/dev/render/blender_render/materials/special_effects/volume.html?highlight=activati 

on%20volume%20rendering 

 
To make fire, 

Step 1: Turn up the Emission Value in the Materials panel 

Step 2: Add another texture (Keep the old texture or the smoke will not show) 

Step 3: Give it a fiery color ramp, which colors are based on the alpha 

Step 4: Change the influence on Emission and Emission color 

Step 5: Change the blend to Multiply 
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Title- Img 3. 24 The fire texture settings. 

Source-blender.org 

Link- 

https://docs.blender.org/manual/en/dev/render/blender_render/materials/special_effects/volume.html?highlight=activati 

on%20volume%20rendering 
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Title- Img 3. 25 The fire render. 

Source blender.org 

Link- 

https://docs.blender.org/manual/en/dev/render/blender_render/materials/special_effects/volume.html?highlight=activati 

on%20volume%20rendering 

 
Wire Render 

 

 
Title-Img 3. 26Wire Render. 

Attribution- Source-blender.org 

Link- 

https://docs.blender.org/manual/en/dev/render/blender_render/materials/special_effects/wire.html?highlight=wire%2 

0render 

 
The Wire Render option in the Materials section provides a way of showing a rendered mage of 

the edges in an object. Each edge is rendered as a single-pixel image of the edges which make up 

the mesh. The colors, alpha and other relevant properties of the lines are selected with the same 

control panels as provided by the Surface rendered image. 
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Title-Img 3. 27 Wire Render. 

Source-blender.org Link- 

https://docs.blender.org/manual/en/dev/render/blender_render/materials/special_effects/wire.html?highlight=wire%20re 

nder 

Unit summary 
In this Unit, you have learnt how to 

 Use Special Effects Materials 

 Create Add-on effects to your 3D Objects like create Glow, Halo, Streaks Lens 
flare and blurs 

 Create Photorealistic effects to your 3D Scene, also known as Post render effects 
in many other applications. 

 Use Integrating effects such as Halo texturing, Volume rendering by using lights 

 Create fire, smoke and transparency in your 3D Project 

 Create Special render style using Wire Render 

After learning of this Unit, you can download the Open Source Software available on the 

internet for free of cost to practice the possibilities of creating Materials. 
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Assignment 

Create a Simple Study Room with few objects like Chair and Study Tables in the corner of the 

room along with a Table Lamp, few books, pencils, pens beside and assign Normal Shaders and 

Special Shaders to the scene. 

Use these key words “Study room”, “3D Volume light effects” on https://www.google.com to 

collect the reference images to build your shading scene. 

Assessment 
 Write down the steps to create Stars in Halo Effects

 Explain the process of making a Lens Flare

 Describe Halo Textures with examples

 Write the use of Volume Rendering

 Explain Light Scattering in Volume Render

 Explain the process of creating Fire and Smoke using Volume Render

 State how to use Wire Render

 Define Reflection and Refraction in Scattering of Volume Materials.
 
 

Resources 
While studying this course, you can browse the internet links for video tutorials and to download 

the relevant texture maps to assign on the objects that you have created and use the same for your 

assignments. 

Links to Download Open Projects 

The iconic Blender Institute Open Movies. Featuring all the production files, assets, artwork, and 

never-seen-before content. 

https://cloud.blender.org/open-projects 

 wiki.blender.org

 archive.org

 www.blender.org

 docs.blender.org
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Unit 1 Introduction to Texture-1 
 
Introduction 

In Computer Graphics Imaginary (CGI), Texture Mapping is a method to add detail to surfaces 

by projecting images and patterns onto those surfaces. 

The projected images and patterns can be set to affect not only color, however, also specularity, 

reflection, transparency, and even fake 3-dimensional depth. Most often, the images and 

patterns are projected during render time, however, Texture Mapping is also used to sculpt, paint 

and deform objects. 

In this Unit, you will learn more about Textures and Mapping. 

Outcomes 

 
Upon completion of this unit you will be able to: 

 Create appropriate Textures for 3D Objects 

 List the different type of mapping techniques 

 Design various blending modes to mix textures with Shaders 

 Create more natural effect using Bump, Normal and Displacement mapping 
techniques 

 Organize the maps for various texture types and Procedural mapping for complex 3D 
scenes 

 
Terminology 

 

CGI: Computer Graphics Imaginary 

Environment 

maps: 

It take a render of the 3D scene and apply it to a texture, to use for 

faking reflections. 

Hue: Specifies how the hue rotation of the image. 

360° are mapped to (0 to 1). The hue shift of 0 (-180°) and 1 (+180°) 

have the same result. 

 
Saturation: 

A saturation of 0 removes hues from the image, resulting in a 

grayscale image. A shift greater 1.0 increases saturation. 

 
Value: 

Value is the overall brightness of the image. De/Increasing values 

shift an image darker/lighter. 



165  

 

 
Factor: 

Controls the amount of influence the node exerts on the output 

image. 

Image: Standard image input. 

Properties: The transformations are relative shifts. In the Shader and texture 

context the following properties are available as input sockets. 

 
Material Textures 

 
The Material settings that you have seen so far produce smooth, uniform objects, however, such 

objects are not particularly true to reality, where uniformity tends to be uncommon and out of 

place. In order to deal with this unrealistic uniformity, Blender allows the user to apply “textures” 

which can modify the reflectivity, specularity, roughness and other surface qualities of a Material. 

 
 

Title-Img 4. 1 Textures Layer on base Material. 

Source-blender.org Link- 

https://docs.blender.org/manual/en/dev/render/blender_render/textures/introduction.html?highlight=textures%20layer% 

20base%20material 

 
 
Textures are like additional layers on top of the base Material. Textures affect one or more 

aspects of the Object’s Net Coloring. The net color you see is a sort of layering of effects, as 

shown in the example image (Refer Img 4. 1). The layers are: 

 Your Object, lit with ambient light based on your world settings.

 
 Your Base Material, which colors the whole surface in a uniform color that reacts to light, 

giving different shades of the diffuse, specular, and mirror colors based on the way light 

passes through and into the surface of the object.
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 A Primary Texture Layer that overlays a purple marble coloring.

 
 A Second Cloud Texture that makes the surface transparent in a misty/foggy sort of way 

by affecting the Alpha value.

 These two textures are mixed with the base Material to provide the net effect: a cube of 

purplish-brown fog. (Net Mixed Textured Effect)

 

Title-Img 4. 2 Some Metal Textures. 

Source-blender.org Link- 

https://docs.blender.org/manual/en/dev/render/blender_render/textures/introduction.html?highlight=textures%20layer% 

20base%20material 

 
This notion of using more than one texture, to achieve a combined effect, is one of the “hidden 

secrets” of creating realistic-looking objects. If you carefully “look at the light” while examining 

any real-life object, you will observe that the final appearance of that object is best described as 

the combination, in different ways and in different amounts, of several distinct underlying visual 

characteristics. These characteristics might be more (or less) strongly apparent at different 

angles, under different lighting conditions, and so forth. Blender allows you to achieve this in 

many ways. 

You can use “a stack of texture layers” as described in this Unit, or you can also use arbitrarily- 

complex networks of “texture nodes” as discussed here. 

Texture Panel 

 
In the Properties Editor, choose the Texture Tab: this will show the Texture Panel. 
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Title-Img 4. 3 Texture Panel. 

Source-blender.org Link- 

https://docs.blender.org/manual/en/dev/render/blender_render/textures/introduction.html?highlight=textures%20layer% 

20base%20material 

 
Texture Context The radio button selects the texture data type, that is, the kind of texture that is 

being edited. 

World 

World Background. 

Material/Lamp 

Material type is described in the following section. Lamps Textures in the lightning section. Brush 

Brush textures are applied in Painting & Sculpting. 

Textures Stack Active Texture 

The Texture slots are displayed in a List Views & Presets. The order in the stack defines how 

textures are overlayed in the rendered image. The checkbox enables/disables the selected texture. 

Texture Data-Block Texture 

The Texture Data-Block Menu for the selected texture slot. 

Texture Type 

Choose the type of texture that is used for the current texture data-block.These types are described in 

detail in this Unit. 

Assigning a Texture 

This page just shows how to add a texture to a slot. The Texture Panel is explained on the previous 

page. 
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Title-Img 4. 4 Texture Panel. 

Source-blender.org 

Link-http://blender-manual- 

i18n.readthedocs.io/ja/latest/render/blender_render/textures/assigning_a_tex  ture.html 
 

 
Creating a new Texture Data-Block in a new Texture Slot Step 1: 

Select an empty slot 

Step 2: click on the Newbutton. This will do two 

things: 

 It will create a new texture data-block.

 Also, it will add a new slot in the textures stack.

 
Creating a new Texture Data-Block in a non-empty slot Step 1: 

Select a non-empty slot 

Step 2: Click on the Plus button. This will do two 

things: 

 It will create a new texture data-block, with a new name, by making a copy of the texture 

data-block assigned to the selected slot.

 It will assign this new data-block to the selected slot.

 
Sharing a Texture Data-Block in a non-empty slot 

 
Step 1: Select a non-empty slot 

Step 2: Click on the Browse button. This will open a menu showing all the available Texture data- 

blocks in this file. 

Step 3: Choose a texture data-block in the menu to assign it to the selected slot. 
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This will share the chosen texture with more than one object, hence the Number of users shown in 

the texture data-block will increase by one. 

 
Texture Properties 

 

Title-Img 4. 5 Texture Preview Panel. 

Source-blender.org 

Link-http://blender-manual- i18n.readthedocs.io/ja/latest/render/blender_render/textures/options.html?hi 

ghlight=Texture%20Preview%20Panel 

The Texture Preview Panel provides a quick pre-visualization of how the texture looks on its 

own, without mapping. 

Preview 

Choose to display only the flat texture, only the Material Preview, or both side-by-side. 

 
Texture, Material/World, Both Show Alpha 

Show alpha in preview: 

 If Alpha: Use is checked in the Image Sampling Panel, the image’s alpha channel is 

displayed. 

 If Alpha: Use is unchecked, an alpha channel based on averaged RGB values is displayed 

like it would be used by the Alpha slider in the Influence Panel. 

Colors 
 

 
Title-Img 4. 6 Colors Panel. 
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Source-blender.org 

Link-http://blender-manual- i18n.readthedocs.io/ja/latest/render/blender_render/textures/options.html?hi 

ghlight=Texture%20Preview%20Panel 

The Ramp button activates a color ramp which allows you to remap the colors of a texture to new 

ones. 

The color of a texture can be modified with the Brightness, Contrast, and Saturation buttons. 

All textures with RGB-Values, including Images and Environment Maps, may be modified with the 

RGB sliders. 

R, G, B Tint the color of a texture by brightening each Red, Green and Blue 

channel. 

Brightness Change the overall brightness/intensity of the texture. 

Contrast Change the contrast of the texture. 

Saturation Change the saturation of the texture. 

 

 
Mapping 

Textures need mapping coordinates, to determine how they are applied to the object. The mapping 

specifies how the texture will ultimately wrap itself to the object. 

For example, a 2D image texture could be configured to wrap itself around a cylindrical shaped 

object. 

 
 

Title-Img 4. 7 Mapping Panel. 

Source-blender.org Link- 

https://docs.blender.org/manual/en/dev/render/blender_render/textures/pro  perties/mapping.html 
 
 

Coordinates 

Mapping works by using a set of coordinates to guide the mapping process. These coordinates 

can come from anywhere, usually the object to which the texture is being applied to. 
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Global The scene’s global 3D coordinates. This is also useful for animations; if you 

move the object, the texture moves across it. It can be useful for letting 

objects appear or disappear at a certain position in space. 

Object Uses an object as source for coordinates. Often used with an Empty, this is an 

easy way to place a small image at a given point on the object. This object 

can also be animated, to move a texture around or through a surface. 

Object Select the name of an object. 

Generated The original unreformed coordinates of the object. This is the default option 

for mapping textures. 

UV UV mapping is a very precise way of mapping a 2D texture to a 3D surface. 

Each vertex of a mesh has its own UV co-ordinates which can be unwrapped 

and laid flat like a skin. You can almost think of UV coordinates as a 

mapping that works on a 2D plane with its own local coordinate system to the 

plane on which it is operating on. This mapping is especially useful when 

using 2D images as textures, as seen in UV Mapping. You can use multiple 

textures with one set of UV coordinates. 

Layer UV layer to use for mapping. 

Strand/Particle Uses normalized 1D strand texture coordinate or particle age (X) and trail 

position (Y). Use when texture is applied to hair strands or particles. 

Window The rendered image window coordinates. This is well suited to blending two 

objects. 

Normal Uses the direction of the surface’s normal vector as coordinates. This is very 

useful when creating certain special effects that depend on viewing angle. 

Reflection Uses the direction of the reflection vector as coordinates. This is useful for 

adding reflection maps. You will need this input when Environment 

Mapping. 

Stress Uses the difference of edge length compared to original coordinates of the 

mesh. This is useful, for example, when a mesh is deformed by modifiers. 

Tangent Uses the optional tangent vector as texture coordinates. 

Flat  



172  

 

Flat mapping gives the best results on single planar faces. It does produce interesting 

effects on the sphere, however, compared to a sphere-mapped sphere the 

result looks flat. On faces that are not in the mapping plane the last pixel of 

3D Animation 121 the texture is extended, which produces stripes on the cube 

and cylinder. 

Cube 
Cube Cube mapping often gives the most useful results when the objects 

are not too curvy and organic (notice the seams on the sphere). 

Tube 
Tube mapping maps the texture around an object like a label on a bottle. 

The texture is therefore more stretched on the cylinder. This mapping is of 

course very good for making the label on a bottle or assigning stickers to 

rounded objects. However, this is not a cylindrical mapping so the ends of the 

cylinder are undefined. 

Sphere 
Sphere mapping is the best type for mapping a sphere, and it is perfect for 

making planets and similar objects. It is often very useful for creating organic 

objects. It also produces interesting effects on a cylinder. 

 

Inheriting coordinates from the parent object 

From Dupli 

Duplis instance from vertices, faces, or particles, inherit texture coordinates from their parent. 

Coordinate Offset, Scaling and Transformation 

Offset 

The texture co-ordinates can be translated by an offset. Enlarging of the Offset 

moves the texture towards the top left. 

Size 

These buttons allow you to change the mapping of axes between the texture’s own coordinate 

system, and the mapping system you choose (Generated, UV, and etcetera.) More precisely, to 

each axis of the texture corresponds one of four choices that allow you to select to which axis in 

the mapping system it maps! This implies several points: 

 
 For 2D textures (such as images), only the first two rows are relevant, as they have no Z data. 

 
 You can rotate a 2D picture a quarter turn by setting the first row (i.e. X texture axis) to Y, 

and the second row (Y texture axis) to X. 

 When you map no texture axis (i.e. the three “void” buttonsareset), you willgetasoliduniform 

texture, as you use zero dimension (i.e. a dot, or pixel) of it (and then Blender extends or repeats 
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this point’s color along all axes.) 

 
 When you only map one texture axis (i.e. two “void” buttons are enabled) you will get a 

“striped” texture, as you only use one dimension (i.e. a line of pixel) of it, (and then Blender 

stretches this line along the two other axes). 

 The same goes, for 3D textures (i.e. procedural ones), when one axis is mapped to nothing, 

Blender extends the plan (“slice”) along therelevant third axis. 

 
Texture Blending Modes 

Blending Modes are different methods of controlling how the texture influences Material 

properties. While a blending mode defines, the specific operation performed, blending factor 

controls the amount, the overall “strength” of this operation. For textures, such blending factor is 

set via sliders in the Influence Panel. 

Blend Blending operation to perform. 

 
RGB to Intensity 

 
With this option enabled, an RGB texture (affects color) is used as an intensity texture (affects a 

value). 

Blend Color 

If the texture is mapped to Color, what color is blended in according to the intensity of the 

texture? 

Negative 

The effect of the Texture is negated. Normally white means on, black means off, Negative 

reverses that. 

Stencil 

The active texture is used as a mask for all following textures. This is useful for semitransparent 

textures and “Dirt Maps”. Black sets the pixel to “untexturable”. The Stencil mode works similar 

to a layer mask in a 2D program. The effect of a stencil texture cannot be overridden, only 

extended. You need an intensity map as input. 

Destination Value 

The value (not for RGB) with which the Intensity texture blends with the current value. Two 
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examples: 

 
 The Emit value is normally 0. With a texture mapped to Emit you will get maximal effect, 

because DVar is 1 by default. If you set DVar to 0 no texture will have any effect. 

 If you want transparent Material, and use a texture mapped to Alpha, nothing happens with 

the default settings, because the Alpha value in the Material Panel is 1. So you have to set 

DVar to 0 to get transparent Material (and of course Z Transparency also). This is a common 

problem for beginners. Or do it the other way round: set Alpha to 0 and leave Dvar on 1. Of 

course, the texture is used inverted then. 
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Unit-2 Introduction to Mapping-1 
Types of Maps 

There are two types of Maps. 

1. Bump Maps 
 

2. Normal Maps 

Bump Maps and Normal Maps both serve the same purpose: they simulate the impression of a 

detailed 3D surface, by modifying the shading as if the surface had lots of small angles, rather 

than being completely flat. Because it is just modifying the shading of each pixel, this will not 

cast any shadows and will not obstruct other objects. If the camera angle is too flat to the surface, 

you will notice that the surface is not really shaped. 

Both Bump Maps and Normal Maps work by modifying the normal angle (the direction pointing 

perpendicular from a face), which influences how a pixel is shaded. Although the terms Bump 

Map and Normal Map are often used synonymously, there are certain differences. 

Bump maps 

 
These are textures that store an intensity, the relative height of pixels from the viewpoint of the 

camera. The pixels seem to be moved by the required distance in the direction of the face normal. 

(The“bump” consists only of a displacement, which takes place along the existing, and unchanged, 

normal-vector of the face.) You may either use grayscale pictures or the intensity values of a RGB- 

Texture (including images). 

Normal maps 

 
These are images that store a direction, the direction of normal directly in the RGB values of an 

image. They are much more accurate, as rather than only simulating the pixel being away from 

the face along a line, they can simulate that pixel being moved at any direction, in an arbitrary 

way. The drawbacks to normal maps are that unlike bump maps, which can easily be painted by 

hand, normal maps usually must be generated in some way, often from higher resolution geometry 

than the geometry you are applying the map to. 

Normal maps in Blender store a normal as follows: 

 Red maps from (0 - 255) to X (-1.0 - 1.0) 

 Green maps from (0 - 255) to Y (-1.0 - 1.0) 

 Blue maps from (0 - 255) to Z (0.0 - 1.0) 

 
Since normal all points towards a viewer, negative Z-values are not stored (they would be invisible 
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anyway). In Blender, we store a full blue range, although some other implementations also map 

blue colors (128 - 255) to (0.0 - 1.0). The latter convention is used in “Doom 3” for example. 

Workflow 

The steps involved in making and using Bump and Normal Maps are: 

Step 1: Model a highly detailed (“hi-poly”) model. 

Step 2: Bake the Bump and/or Normal maps. 

Step 3: Make a low-poly, less detailed model. 

Step 4: Map the map to the low-poly model using a common coordinate 

system. 

Consult the Modeling section for how to model a highly detailed model using the Mesh tools. 

How much detail you put in is totally up to you. The more ridges and details (knobs, creases, 

protrusions) you put in, the more detailed your map will be. (Step 1) 

Baking a map, simply put, is to take the detail of a high polygon mesh, and apply it to a similar 

object. The similar object is identical to the high-poly mesh except with less vertices. Use the 

Render Bake feature in Blender to accomplish this. (Step 2) 

Modeling a low-poly using Blender’s Mesh editing tools. In general, the same or similar faces 

should exist that reflect the model. For example, a highly detailed ear may have 1000 faces in the 

high-poly model. In the low-poly model, this may be replaced with a single plane, oriented in the 

same direction as the detailed earmesh.(Tip: Blender’s multi-resolution mesh modeling feature can 

be used to good effect here.) (Step 3) 

Mapping is the process of applying a texture to the low-poly mesh. Consult the Textures Mapping 

section for more information on applying a texture to a mesh’s Material. Special considerations for 

Bump and Normal Maps is: (Step 4) 

 When using a Bump map, map the texture to Normal and enable No RGB. 

 When using a Normal map, map the texture to Normal. 

 
The coordinate systems of the two objects must match. For example, if you bake using a UV map 

of the high-poly model, you must UV map the low poly model and line up its UV coordinates to 

match the outline of the high-poly image. 

Displacement Maps 

Displacement mapping allows a texture input to manipulate the position of vertices on rendered geometry. 

Unlike Normal or Bump mapping, where the shading is distorted to give an illusion of a bump (discussed 

on the previous page), Displacement Maps create real bumps, creases, ridges, etc in the actual 
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mesh. Thus, the mesh deformations can cast shadows, occlude other objects, and do everything 

that changes in real geometry can do, however,, on the other hand, requires a lot more vertices 

to work. 

Options 

In the Influence Panel, the strength of the displacement is controlled by the 

Displace and Normal sliders: 

 If a texture provides only normal information (e.g. Stucci), vertices move according to the 

texture’s normal data. The normal displacement is controlled by the Normal slider. 

 If a texture provides only intensity information (e.g. Magic, derived from color), vertices 

move along the directions of their normal (a vertex has no normal itself, it is the resulting 

vector of the adjacent faces). White pixels move outward in the direction of the normal, black 

pixels move in the opposite direction. The amount of displacement is controlled with the 

Displace slider. 

The two modes are not exclusive. Many texture types provide both information (Clouds, Wood, 

Marble, and Image). The amount of each type can be mixed using the respective sliders. Intensity 

displacement gives a smoother, more continuous surface, since the vertices are displaced only 

outward. Normal displacement gives a more aggregated surface, since the vertices are displaced 

in multiple directions. 

The depth of the displacement is scaled with an object’s scale, however, not with the relative size 

of the data. This means if you double the size of an object in object mode, the depth of the 

displacement is also doubled, so the relative displacement appears the same. If you scale inside 

Edit Mode, the displacement depth is not changed, and thus the relative depth appears smaller. 

Subdivision Surface Meshes 

Rendered face size is controlled with render subdivision level. Displacement really likes smooth 

normal. 

Manually (Edit Mode) subdivided meshes 

Control render faces with number of subdivides. (This can be combined with the above methods). 

Displaces exactly the same Simple Subdivision Surface, however, the overhead of drawing extra 

faces can slow down editing. 

Meta Objects 

Control render faces with render wire size. Small wire == more faces. 

 
The following are available, however, currently do not work well. It is recommended that you 
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convert these to meshes before rendering. 

Open NURBS Surfaces 

Control render faces with U/V Surface Resolution. Higher numbers give more faces. (Note normal 

errors). 

Closed NURBS Surfaces 

Control with Surface Resolution controls. (Note the normal errors, and how implicit seam shows). 

 
Curves and Text 

Control with Surface Resolution controls. Higher gives more render faces. (Note that the large flat 

surfaces have few render faces to displace). 

 
Texture Types 

The term Image Texture simply means that a graphic image, which is a pixel grid composed of 

R, G, B, and sometimes Alpha values. It is used as the input source to the texture. As with other 

types of textures, this information can be used in a number of ways, not only as a simple “decal”. 

 
Video textures are some kind of Image textures and based on movie file or sequence of successive 

numbered separate images. They are added in the same way that image textures are. 

When the Texture Type Image or Movie is selected, three new Panels present themselves allowing 

to control most aspects of how image textures are applied: 

1. Image, 

2. Image Sampling, and 

3. Image Mapping. 

 

UV Textures vs. Procedural Textures 

 
A Material Texture, that has a Map Input of UV, and is an image texture that is mapped to Color, 

is equivalent to a UV Texture. It provides much more flexibility, because it can be sized and 

offset, and the degree to which it affects the color of your object can be controlled in the Map To 

Panel. In addition, you can have different images for each texture channel; one for color, one for 

alpha, one for normals, one for specularity, one for reflectivity, etc. 

Procedural textures, like Clouds, are incredibly simple and useful for adding realism and details 

to an image. 

 

UV Texture Procedural Texture 
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Image maps to precise 

coordinates on the selected 

faces of the mesh. 

Pattern is generated dynamically, and is mapped to the entire 

mesh (or portion covered by that Material). 

Image maps once to a range of 

mesh faces specifically 

selected. 

Maps once to all the faces to which that Material is assigned; 

either the whole mesh or a portion. 

Image is mapped 

once to faces. 

Size XYZ in the Map Input allows tiling the texture many times 

across faces. Number of times depends on size of mesh. 

Affect the color and Can also affect normal (bumpiness), 

The alpha of the object. reflectivity, emit, displacement, and a dozen other aspects of the 

mesh’s appearance; can even warp or stencil subsequent 

textures. 

Can have many for a mesh. Can be layered, up to 10 textures can be applied, layering on one 

another. Many mix methods for mixing multiple channels 

together. 

Any Image type (still, video, 

rendered). Generated test grid 

available. 

Many different types: clouds, wood grain, marble, noise, and 

even magic. 

Provides the UV layout for 

animated textures. 

Noise is the only animated procedural texture. 

Takes very limited 

graphics memory 

Uses no or little memory; instead uses CPU compute power. 

 

So, in a sense, a single UV texture for a mesh is simpler, however, more limited than using multiple 

textures (mapped to UV coordinates), because they do one specific thing very well: adding image 

details to a range of faces of a mesh. They work together if the procedural texture maps to the UV 

coordinates specified in your layout. 

 
As discussed earlier, you can map multiple UV textures to different images using the UV 

Coordinate mapping system in the Map Input Panel. 

Options 

Image 

In the Image Panel, we tell Blender which source file to use. 

Image Sampling 
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In the Image Sampling Panel, we can control how the information is retrieved from the 

image. 
 

 

 

Background image. 

 

 

Foreground image. 

 
Title-Img 4. 8 Image Sampling 

Source-blender.org Link- 

https://docs.blender.org/manual/en/dev/render/blender_render/textures/type  s/image/options.html 
 
 
The two images presented here are used to demonstrate the different image options. 

 Background image is an ordinary JPG-file, 

 
 Foreground image is a PNG-file with various alpha and grayscale values. 

 
The vertical bar on the right side of the foreground image is an 

Alpha blend, the horizontal bar has 50% alpha. 
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Foreground image with Use 

alpha. The alpha values of the 

pixels are evaluated. 

 

 

 

Foreground image with 

Calculate alpha. 

Title-Img 4. 9 Image Sampling 

Source-blender.org Link- 

https://docs.blender.org/manual/en/dev/render/blender_render/textures/type  s/image/options.html 

 
Alpha 

Options related to transparency. 

Use 

Works with PNG and TGA files since they can save transparency information (Foreground Image 

with Use Alpha). Where the alpha value in the image is less than 1.0, the object will be partially 

transparent and stuff behind it will show. 

 
Calculate 

Calculate an alpha based on the RGB values of the Image. Black (0, 0, 0) is transparent, white (1, 

1, 1) opaque. Enable this option if the image texture is a mask. Note that mask images can use 

shades of gray that translate to semi- transparency, like ghosts, flames, and smoke/fog. 

 
Invert 

Reverses the alpha value. Use this option if the mask image has white where you want it 

transparent and vice-versa. 

Flip X/Y Axis 

Rotates the image 90 degreescounterclockwise when rendered. 
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Title-Img 4. 10 Image Sampling Panel 

Source-blender.org Link- 

https://docs.blender.org/manual/en/dev/render/blender_render/textures/type  s/image/options.html 

 
Normal Map 

This tells Blender that the image is to be used to create the illusion of a bumpy surface, with each 

of the three RGB channels controlling how to fake a shadow from a surface irregularity. Needs 

specially prepared input pictures. 

Derivative Map 

Use red and green as derivative values. 

MIP Map 

MIP Maps are pre-calculated, smaller, filtered Textures for a certain size. A series of pictures is 

generated, each half the size of the former one. This optimizes the filtering process. By default, 

this option is enabled and speeds up rendering (especially useful in the Game Engine). When this 

option is OFF, you generally get a sharper image, however, this can significantly increase 

calculation time if the filter dimension (see below) becomes large. Without MIP Maps, you may 

get varying pictures from slightly different camera angles, when the Textures become very small. 

This would be noticeable in an animation. 

MIP Map Gaussian filter 

Used in conjunction with MIP Map, it enables the MIP Map to be made smaller based on color 

similarities. In the Game Engine, you want your textures, especially your MIP Map textures, to be 

as small as possible to increase rendering speed and frame rate. 

Interpolation 

 
This option interpolates the pixels of an image. This becomes visible when you enlarge the picture. 
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By default, this option is on. Turn this option off to keep the individual pixels visible and if they 

are correctly anti-aliased. This last feature is useful for regular patterns, such as lines and tiles; 

they remain ‘sharp’ even when enlarged considerably. When you enlarge this10×10 pixel Image 

 the difference with and without Interpolation is clearly visible. Turn this image off if you are 

using digital photos to preserve crispness. 

 

Enlarged Image texture without and with Interpolation 

 

 

 

 

 
Title-Img 4. 11Enlarged Image texture without and with Interpolation  

Source-blender.org Link- 

https://docs.blender.org/manual/en/dev/render/blender_render/textures/type  s/image/options.html 

 
Filter 

The filter size used in rendering, and also by the options MipMap and Interpolation. If you notice 

gray lines or outlines around the textured object, particularly where the image is transparent, turn 

this value down from 1.0 to 0.1 or so. 

Texture Filter Type 

Texture filter to use for image sampling. Just like a pixelrepresents a picture element, a 

texelrepresents a texture element. When a texture (2D texture space) is mapped onto a 3D model 

(3D model space), different algorithms can be used to compute a value for each pixel based on 

samplings from several texels. 

Box 

A fast and simple nearest-neighbor interpolation known as Monte Carlo integration 

EWA (Elliptical Weighted Average) 
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One of the most efficient direct convolution algorithms developed by Paul Heckbert and Ned 

Greene in the 1980s. For each Texel, EWA samples, weights, and accumulates texels within an 

elliptical footprint and then divides the result by the sum of the weights. 

Eccentricity 

Maximum Eccentricity. Higher values give less blur at distant/oblique angles, however, is slower 

FELINE (Fast Elliptical Lines) 

Uses several isotropic probes at several points along a line in texture space to produce an 

anisotropic filter to reduce aliasing artifacts without considerably increasing rendering time. 

Probes 

Number of probes to use. An integer between 1 and 256. Further reading: McCormack, J; 

Farkas, KI; Perry, R; Jouppi, NP (1999) Simple and Table Feline: Fast Elliptical Lines for 

Anisotropic Texture Mapping, WRL 

Area 

Area filter to use for image sampling. 

Eccentricity 

Maximum Eccentricity. Higher values give less blur at distant/oblique angles, however, is 

slower. 

Filter Size 

The filter size used by MIP Map and Interpolation. 

 
Minimum Filter Size 

Use Filter Size as a minimal filter value in pixels. 

Image Mapping 

 

Title-Img 4. 12Image Mapping Panel 
 

 
Source-blender.org Link- 

https://docs.blender.org/manual/en/dev/render/blender_render/textures/type  s/image/options.html 

 
Extend 
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In the Image MappingPanel, we can control how the image is mapped or projected onto the 3D 

model 

Extension 

Outside the image the colors of the edges are extended. 

Clip 

Clip to image size and set exterior pixels as transparent. Outside the image, an alpha value of 0.0 

is returned. This allows you to ‘paste’ a small logo on a large object. 

Clip Cube 

Clips to cubic-shaped area around the images and sets exterior pixels as transparent. The same as 

Clip, however, nowthe‘Z’ coordinate is calculated as well. An alpha value of 0.0 is returned 

outside a cube-shaped area around the image. 

Repeat 

The image is repeated horizontally and vertically. 

Mirror 

Mirror on X/Y axes. This buttons allow you to map the texture as a mirror, or automatic flip of 

the image, in the corresponding X and/or Y direction. 

Checker 

Checkerboards quickly made. You can use the option size on the Mapping Panel as well to create 

the desired number of checkers Even / Odd Set even/odd tiles 

 
Distance 

Governs the distance between the checkers in parts of the texture size. 

 
Crop Minimum / Crop Maximum 

The offset and the size of the texture in relation to the texture space. Pixels outside this space are 

ignored. Use these to crop, or choose a portion of a larger image to use as the texture.Procedural 

Textures 
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Introduction 

 

Title-Img 4. 13Texture type list 

Source-blender.org Link- 

https://docs.blender.org/manual/en/dev/render/blender_render/textures/type  s/procedural/introduction.html 

The Texture Type list in the Texture Panel of the Texture buttons. (Non-procedural textures 

darkened out) 

Procedural textures are textures that are defined mathematically. They are generally relatively 

simple to use, because they do not need to be mapped in a special way. This does not mean that 

procedural textures cannot become very complex. 

 
These types of textures are ‘real’ 3D. By that, we mean that they fit together perfectly at the edges 

and continue to look like what they are meant to look like even when they are cut; as if a block of 

wood had really been cut in two. Procedural textures are not filtered or anti-aliased. This is hardly 

ever a problem: the user can easily keep the specified frequencies within acceptable limits. 

Common options 

Noise Basis 

Each noise-based Blender texture (with the exception of Voronoi and simple noise) has a Noise 

Basis setting that allows the user to select which algorithm is used to generate the texture. This 

list includes the original Blender noise algorithm. The Noise Basis settings makes the procedural 
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textures extremely flexible (especially Musgrave). 

The Noise Basis governs the structural appearance of the texture: 
 

 

 

Blender 

Original 

. 

 

 

 

Voronoi F1. 

 

 

 

Voronoi F2-F1. 

 

 

 

Original Perlin. 

 

 

 

Voronoi F2. 

 

 

Voronoi 

Crackle 

. 

 

 

Improved 

Perlin. 

 

 

 

Voronoi F3. 

 

 

 

Cell Noise. 

 

 

Voronoi F4. 

  

Title-Img 4. 14Noise basis 

Source-blender.org Link- 

https://docs.blender.org/manual/en/dev/render/blender_render/textures/type  s/procedural/introduction.html 

 
There are two more possible settings for Noise Basis, which are relatively similar to Blender 

Original: Improved Perlinand Original Perlin. 

Nabla 

Almost all procedural  textures  in Blender use derivatives for calculating normal for 
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Texture Mapping (with an exception Blend and Magic). This is important for Normal and 

Displacement Maps. The strength of the effect is controlled with the Nabla Number button. 

Blend 
 

Title-Img 4. 8 Blend Texture Panels. 

Source-blender.org Link- 

https://docs.blender.org/manual/en/dev/render/blender_render/textures/types/procedural/blend.html?highlight=blend%2 

0texture%20panels 

 
Often used for 

 
This is one of the most frequently used procedural textures. You can use blend textures to blend 

other textures together (with Stencil), or to create nice effects (especially with the Mapping: 

Normal trick). 

Note 

 
Remember that if you use a ramp to create a custom blending, you may have to use 

No RGB, if the Mapping value needs an intensity input. 

Result(s)Intensity. 

 
The Blend texture generates a smoothly interpolated progression. 

Options 
 

Progression Profile of blend. 

Easing A flowing, non-linear progression. 

Spherical A progression with the shape of a three-dimensional ball. 

Quadratic Sphere A quadratic progression with the shape of a three- 

dimensional ball. 
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Soft, Sharp, Sharper 

 

Radial A radial progression: Horizontal / Vertical. The direction of the 

progression is flipped a quarter turn. 

 

 

 

Title-Img 4. 9 Marble Texture Panels. 

 

Marble 

Source-blender.org Link- 

https://docs.blender.org/manual/en/dev/render/blender_render/textures/type  

s/procedural/marble.html?highlight=marble%20texture%20panels 

 
 Often used for 

Marble, Fire, Noise with a structure. 

 Result(s) 

 
Intensity value only. Bands are generated based on the sine, saw, or triangular formula and noise 

turbulence. 

Bands are generated based on the sine, saw, or triangular formula and noise turbulence. 

 
Options 

 
Marble 

 
Type 

Three settings for soft to more clearly defined Marble. 

 

Noise basis 
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Sine, Saw, Triangle 

Soft, Hard 

Shape of wave to produce bands. 

 

Noise Type 

The noise function works with two methods. 
 

Size 

The dimensions of the noise table 

 
Depth 

The depth of the Marble calculation. A higher value results in greater calculation time, 

however, also in finer details. 

Turbulence 

The turbulence of the sine bands. 
 
 

 

Title-Img 4. 10 Noise Texture Panel. 

 

Noise 

Source-blender.org Link- 

https://docs.blender.org/manual/en/dev/render/blender_render/textures/type  s/procedural/noise.html 
 
 
Although this looks great, it is not Perlin Noise! This is a true, randomly generated Noise. This 

gives a different result every time, for every frame, for every pixel. 

Options 

There are no options for this noise. 

 Often used for 

 
White noise in an animation. This is not well suited if you do not want an 
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animation. For Material displacement or bump, use clouds instead. 

 
 Result(s) 

 
Intensity. 

Wood 

 

Title-Img 4. 11 Wood Texture Panels. 

Source-blender.org Link- 

https://docs.blender.org/manual/en/dev/render/blender_render/textures/type  

s/procedural/wood.html?highlight=wood%20texture%20panels 

 
 Often used for 

 
Woods and ring-shaped patterns. 

 Result(s) 

 
Intensity only. 

 
Options 

 

 

Noise Basis Shape of wave to produce bands Sine, Saw, Triangle 

Wood Type Set the bands to either straight or ring-shaped, with or 

without turbulence. Bands, Rings, Band Noise, Ring 

Noise 

Noise Type There are two methods available for the Noise function Soft, Hard 

Size Dimension of the Noise table 

Turbulence Turbulence of the Band Noise and Ring Noise types 
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Environment Maps 

Environment maps take a render of the 3D scene and apply it to a texture, to use for faking 

reflections. If you want to achieve a very realistic result, raytraced reflections are a good solution. 

Environment Maps are another way to create reflective surfaces, however, they are not so simple 

to set up. 

So why should one use Environment Maps? 

 The main reason is probably that they can be much faster than raytracing reflections. In 

certain situation, they need to be calculated only once, and may be reused like any ordinary 

texture. You may even modify the precalculated Environment Map in an image editor. 

 Environment maps can also be blurred and render even faster, because the resolution can 

then be lowered. Blurring a reflection with the raytracer always adds to the render time, 

sometimes quite a lot. 

 Halos (a visualization type for particles) are not visible to raytraced reflections, so you need 

to setup environment maps to reflect them. 

 Keypoint strands (another visualization type for particles) are also not visible to raytraced 

reflections, so you need to setup environment maps to reflect them. 

Just as we render the light that reaches the viewing plane using the camera to define a viewpoint, 

we can render the light that reaches the surface of an object (and hence, the light that might 

ultimately be reflected to the camera). Blender’s environment mapping renders a cubic image 

map of the scene in the six cardinal directions from any point. When the six tiles of the image are 

mapped onto an object using the Reflection input coordinates, they create the visual complexity 

that the eye expects to see from shiny reflections. 

 
Options Important 

For correct results, the mapping of an environment map texture must be set to Reflection (reflection 

co-ordinates) in the Map Input Panel of the Material tab. 

Blender allows three types of environment maps, as you can see in Img 4.19 Reflecting plane 

Environment Map settings.: 



193  

 

Title-Img 4. 12 Reflecting plane Environment Map settings. 

Source-blender.org Link- 

https://docs.blender.org/manual/en/dev/render/blender_render/textures/type 

s/environment.html?highlight=reflecting%20plane%20environment%20map%2 0settings 

 
Static 

The map is only calculated once during an animation or after loading a file. 

Animated 

The map is calculated each time a rendering takes place. This means moving Objects are displayed 

correctly in mirroring surfaces. 

Image File 

When saved as an image file, environment maps can be loaded from disk. This option allows the 

fastest rendering with environment maps, and also gives the ability to modify or use the 

environment map in an external application. 

When using planar reflections, if the camera is the only moving object and you have a reflecting 

plane, the Empty must move too and you must use Animated environment map. If the reflecting 

object is small and the Empty is in its center, the environment map can be Static, even if the object 

itself rotates since the Empty does not move. If, on the other hand, the Object translates the Empty 

should follow it and the environment map be of Animated type. 

Specials 

Clear Environment Map 

Clears the currently rendered environment map from memory. This is useful to refresh a Static 

environment maps and you have changed things in your scene since the last time the environment 

map was rendered. Animated environment maps do this automatically on every render. 

Save Environment Map 

Saves the currently stored static environment map to disk as an image file. This can be loaded 
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again with Load. 

Clear All Environment Map 

Does the same as Free Data, however, with all environment maps in the scene. This is a useful 

shortcut when using recursive environment maps (when the Depth is greater than 0). 

Viewpoint Object 

Environment maps are created from the perspective of a specified object. Thelocationofthisobject 

willdeterminehow‘correct’ the reflection looks, though different locations are needed for different 

reflecting surfaces. Usually, an Empty is used as this object: 

 For planar reflections, the object should be in a location mirrored from the camera, on the 

other side of the plane of reflection (see Examples). This is the most accurate usage of 

Environment maps. 

 For spherical reflections, the object should be in the center of the sphere. Generally, if the 

reflecting sphere’s object center point is in the center of its vertices, you can just use the name of the 

actual sphere object as the Viewpoint Object 

 For irregular reflections, there is no hard and fast rule, you will probably need to experiment 

and hope that the inaccuracy does not matter. 

Ignore Layers 

The layers are to exclude from the environment map creation. Since environment maps work by 

rendering the scene from the location of the Viewpoint Object, you will need to exclude the actual 

reflecting surface from the environment map, otherwise it will occlude other objects that should 

be reflected on the surface itself. 

Eg. If you are rendering an environment map from the center of a sphere, all the environment map 

will show by default is the inside of the sphere. You will need to move the sphere to a separate 

layer, then exclude that layer from the environment map render, so that the environment map will 

show (and hence reflect) all the objects outside the sphere. 

Resolution 

The resolution of the cubic environment map render. Higher resolutions will give a sharper texture 

(reflection), however, will be slower to render. 

 
Depth 

The number of recursive environment map renders. If there are multiple reflecting objects using 

environment maps in the scene, some may appear solid, as they will not render each other’s 

reflections. In order to show reflections within reflections, the environment maps need to be made 
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multiple times, recursively, so that the effects of one environment map can be seen in another 

environment map. See Examples. 

Clipping Start/End 

The clipping boundaries of the virtual camera when rendering the environment map. Sets the 

minimum and maximum distance from the camera that will be visible in the map. 

 
Minimum Filter Size 

Use Filter Size as a minimal filter value in pixels. 

Examples 

In this example, an empty is used as the Viewpoint Object of the reflecting plane’s environment 

map. It is located in the specular position of the camera with respect to the reflecting surface. (This 

is possible, strictly speaking, only for planar reflecting surfaces.) 

Environment Map Sampling 

Filter Box 

Box Filter 

EWA 

Elliptical Weighted Average. One of the most efficient direct convolution algorithms 

developed by Paul Heckbert and Ned Greene in the 1980s. For each Texel, EWA samples, 

weights, and accumulates texels within an elliptical footprint and then divides the result by the 

sum of the weights. 

Eccentricity 

Maximum eccentricity (highergives less blur at distant/oblique angles, however, is 

also slower) 

FELINE 

FELINE (Fast Elliptical Lines), uses several isotropic probes at several points along a line in 

texture space to produce an anisotropic filter to reduce aliasing artifacts without considerably 

increasing rendering time. 
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Planar reflection example. 

 

Sphere on a reflecting 

surface. 

 

Title-Img 4. 13 Reflecting plane Environment Map settings. 

Source-blender.org Link- 

https://docs.blender.org/manual/en/dev/render/blender_render/textures/type  s/environment.html 

 
 
Probes 

Maximum number of samples (higher gives less blur at distant/oblique angles, however, 

is also slower) 

Area Eccentricity 

Maximum eccentricity (higher gives less blur at distant/oblique angles, however, is also 

slower) 

Filter Size 

The amount of blurring applied to the texture. Higher values will blur the environment map to fake 

blurry reflections. 

Minimum Filter Size 

Use Filter Size as a minimal filter value in pixels. 

 
Examples 

In this example, an empty is used as the Viewpoint Object of the reflecting plane’s environment 

map. It is located in the specular position of the camera with respect to the reflecting surface. (This 

is possible, strictly speaking, only for planar reflecting surfaces.) 

Ideally, the location of the empty would mirror the location of the camera across 

the plane of the polygon onto which it is being mapped. 

The following images show the effect of the Depth. The first render has depth set to 0. This means 

the environment map on the plane has rendered before the environment map of the sphere, so the 
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sphere’s reflection is not shown. By raising the Depth, the environment map is rendered 

recursively, in order to get reflections of reflections. 
 

 

 

Reflecting sphere on a 

reflecting surface. 

 

Reflecting sphere on a reflecting 

surface with multiple reflections. 

Title-Img 4. 14 Reflecting sphere 
 

 
Source-blender.org Link- 

https://docs.blender.org/manual/en/dev/render/blender_render/textures/type  s/environment.html 

 
Limitations 

 
Because environment maps are calculated from the exact location of the Viewpoint Object’s 

object center, and not from actual reflecting surface, they can often be inaccurate, especially with 

spheres. In the following image, the rectangular prism and the smaller spheres are touching the 

sides of the large reflecting sphere; however, because the environment map is calculated from the 

center of the sphere, the surrounding objects look artificially far away. 

Title-Img 4. 15 Inaccurate spherical reflection, the colored objects are artificially offset. 
 

 
Source-blender.org Link- 

https://docs.blender.org/manual/en/dev/render/blender_render/textures/type  s/environment.html 
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Introduction to Nodes 
In addition to creating Materials as just described using all the settings on all the Materials Panels, 

Blender allows you to create a Material by routing basic Materials through a set of nodes. Each 

node performs some operation on the Material, changing how it will appear when applied to the 

mesh, and passes it on to the next node. In this way, very complex Material appearances can be 

achieved. 

You should already be familiar with general Material concepts and how to create 

Materials/textures using the Material menu. You should also have a general understanding of the 

texture coordinate systems available in Blender (e.g. Generated, UV, etc.). Also, many aspects of 

a node will be skipped here because in later sections you will see the function expanded upon. 

Each section builds off the previous. 

To start, the node system does not make the Material menu obsolete. Many features and Material 

settings are still only accessible through the Material Panel (e.g. Ray Mirror). However, with the 

advent of nodes, more complex and fantastic Materials can be created since we now have greater 

control. 

Just in case you are not (yet) familiar with the concepts: when you create a system of nodes, you 

are describing a data-processing pipeline of sorts, where data “flows from” nodes which describe 

various sources, “flows through” nodes which represent various processing and filtering stages, 

and finally “flows into” nodes which represent outputs or destinations. You can connect the nodes 

to one another in many different ways, and you can adjust “knobs,” or parameters, that control the 

behavior of each node. This gives you a tremendous amount of creative control. And, it will very 

quickly become intuitive. 

Having said all that, let us begin with a normal Material. 

Here we have the standard Material added to a cube mesh. We could, as we have in the past, add 

color and other settings to this Material and it would certainly look nice. however, let us say we 

are just not getting what we are looking for? What if we want to control the creation more tightly 

or add more complexity? Here is where nodes come in. 

Making this node map is accomplished by working in a Node Editor. This section covers: 

 Enabling Material Nodes. 

 
 The Node Editor, its basic controls, and working with nodes. 

 
 The specific types of nodes available for Materials. 

 
 



199  

Accessing the Node Editor 

First, let’s enter the node editor and make sure that the node editor has the Material node button 

(the sphere icon) pressed, not the composite or texture node buttons. 

Enabling Node Materials 

 
Let us take the base Material and hit the Nodes button next to the Material name in the Material 

Panel or the node editor. You will see a change in the Material Panel. 

 

Title-Img 4. 16Use Material nodes button. 

Source-blender.org Link- 

https://docs.blender.org/manual/en/dev/render/blender_render/materials/no  des/introduction.html 
 
 
What you have just done is told Blender to make the Material you were on to become the node 

tree. Most of the Panels we normally find in the Material menu are now gone. 

If you switch to the Compositing screen with Ctrl-Left, if you are on the default screen, you will 

find a Node Editor on the top half of the screen. When you enabled Material nodes, a Material node 

and an output node were automatically added to the node editor. 

 

Title-Img 4. 17Default nodes. 

Source-blender.org Link- 

https://docs.blender.org/manual/en/dev/render/blender_render/materials/no  des/introduction.html 
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You can also split the 3D View in the default screen in two and change one into a Node Editor. 

It is important to note that you can add a new Material (which you can edit and change like any 

other Material in the Material Panel), add an already created Material or append a Material from 

another blend-file, and also use the Material that you used to create the node tree. 

 

Title-Img 4. 18A first Material added to the node setup. 

Source-blender.org Link- 

https://docs.blender.org/manual/en/dev/render/blender_render/materials/no  des/introduction.html 

 
Here, we added a new Material in the Node editor “Material.001”, and as we did, we can access 

the properties of this Material in the Material’s menu. 

Node Types 

 
Gamma Node 

 

Title-Img 4. 19A first Material added to the node setup. 
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Source-blender.org Link- 

https://docs.blender.org/manual/en/dev/render/cycles/nodes/types/color/gamma.html?highlight=gamma%20node 
 
 
 
Gamma Node. 

Use this node to apply a gamma correction. 

 
Inputs 

 
Image Standard image input. 

Gamma An exponential brightness factor. 

Properties This node has no properties. 

 
Outputs 

 
Image Standard image input. 

 
Examples 

 

Title-Img 4. 20 Example of Gamma node. 
 

 

Source-blender.org Link- 

https://docs.blender.org/manual/en/dev/render/cycles/nodes/types/color/ga  mma.html?highlight=gamma%20node 

 
Hue Saturation Value Node 
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Title-Img 4. 21Hue Saturation Node. 

Source-blender.org Link- 

https://docs.blender.org/manual/en/dev/render/blender_render/materials/nodes/types/color/hue_saturation.html?highlig 

ht=saturation%20node 

This node applies a color transformation in the HSV color space. Called “Hue Saturation Value” 

in Shader and texture context. 

 

Inputs  

Factor Controls the amount of influence the node exerts on the output image. 

Image Standard image input. 

Properties The transformations are relative shifts. In the Shader and texture context the 

following properties are available as input sockets. 

Hue Specifies how the hue rotation of the image. 360° are mapped to (0 to 1). The 

hue shift of 0 (-180°) and 1 (+180°) have the same result. 

Saturation A saturation of 0 removes hues from the image, resulting in a grayscale image. 

A shift greater 1.0 increases saturation. 

Value Value is the overall brightness of the image. De/Increasing values shift an 

image darker/lighter. 

Outputs 
 

Image Standard image output. 
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Hue/Saturation 

Tips 

Some things to keep in mind that might help you use this node better: 

Hues are vice 

versa 

A blue image, with a Hue setting at either end of the spectrum (0 or 1), is 

output as yellow (recall that white, minus blue, equals yellow). A yellow 

image, with a Hue setting at 0 or 1, is blue. 

Hue and 
Saturation 
work together. 

So, a Hue of 0.5 keeps the blues the same shade of blue, however, Saturation 
can deepen or lighten the intensity of that color. 

Gray & White 
are neutral hues A gray image, where the RGB values are equal, has no hue. Therefore, this 

node can only affect it with Value. This applies to all shades of gray, from 
black to white; wherever the values are equal. 

Changing the 
effect over time The Hue and Saturation values can be animated with a Time Node or by 

animating the property. 

HSV Example 
 

Title-Img 4. 22 A basic example. 

Source-blender.org 

Link- 
https://docs.blender.org/manual/en/dev/render/blender_render/materials/nodes/types/color/hue_saturation.html?highligh 
t=saturation%20node 

Invert Node 
 

Title-Img 4. 23Invert Node. 

Source-blender.org Link- 
https://docs.blender.org/manual/en/dev/compositing/types/color/invert.html?  highlight=invert%20node 
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This node inverts the colors in the input image, producing a negative. 

 

Inputs  

Factor Controls the amount of influence the node exerts on the output 
image. 

Color Standard image input. 

Properties In the compositing context, this node has the following properties. 

RGB De/activation of the color channel inversion. 

Alpha De/activation of the alpha channel inversion. 

Outputs  

Color Standard image output. 
 
Mix Node 

 

Title-Img 4. 24Mix Node 

 
Source-blender.org 

Link- 
https://docs.blender.org/manual/en/dev/render/blender_render/materials/nodes/types/color/mix_rgb.html?highlight=mix 
%20node 

 
This node mixes images by working on the individual and correspondingpixelsofthetwoinput 
images.Called“MixRGB”in the Shader and texture context. 

 
 

Inputs  

Factor Controls the amount of influence the node exerts on the output 

image. 

Image The background image. The image size and resolution sets the 

dimensions of the output image. 

Image The foreground image. 

Properties  

Mix The Blend types could be selected in the select menu. Add, 

Subtract, Multiply, Screen, Divide, Difference, Darken, Lighten, 
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 Overlay, Dodge, Burn, Hue, Saturation, Value, Color, Soft Light, 

Linear Light 

Use Alpha If activated, by clicking on the Color and Alpha icon, the Alpha 

channel of the second image is used for mixing. When deactivated, 

the default, the icon background is a light gray. The alpha channel 

of the base image is always used. 

Clamp Limit the highest color value to not exceed 1. 

Output  

Image Standard image output. 
 

 
Examples 

Below are samples of common mix modes and uses, mixing a color or checker with a mask. 
 

Title-Img 4. 25 Some explanation of the mixing methods above might help you use the Mix node effectively. 
 

 
Source-blender.org 

Link- 

https://docs.blender.org/manual/en/dev/render/blender_render/materials/nodes/types/color/mix_rgb.html?highlight=mix 

%20node 
 

 
Add Adding blue to blue keeps it blue, however, adding blue to red makes purple. 

White already has a full amount of blue, so it stays white. Use this to shift a 
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 color of an image. Adding a blue tinge makes the image feel colder. 

Subtract Taking Blue away from white leaves Red and Green, which combined make 

Yellow. Taking Blue away from Purple Leaves Red. Use this to desaturate 

an image. Taking away yellow makes an image bluer and more depressing. 

Multiply Black (0.00) times anything leaves black. Anything times White (1.00) is 

itself. Use this to mask out garbage, or to colorize a black-and-white image. 

Hue Shows you how much of a color is in an image, ignoring all colors except 

what is selected: makes a monochrome picture (style ‘Black & Hue’). 

Mix Combines the two images, averaging the two. 

Lighten Like bleach makes your whites whiter. Use with a mask to lighten up a little. 

Difference Kinda cute in that it takes out a color. The color needed to turn Yellow into 

White is Blue. Use this to compare two very similar images to see what had 

been done to one to make it the other; sorta like a change log for images. 

Darken With the colors set here, is like looking at the world through rose-colored 

glasses. 

Contrast Enhancement 

Here is a small map showing the effects of two other common uses for the RGB Curve: Darken and 

Contrast Enhancement. You can see the effect each curve has independently, and the combined 

effect when they are mixed equally. 

 

Title-Img 4. 26 Example node setup showing “Darken”, “Enhance Contrast” and “Mix” nodes for composition. 

Source-blender.org Link- 

https://docs.blender.org/manual/en/dev/render/blender_render/materials/no  

des/types/color/mix_rgb.html?highlight=mix%20node 

As you can hopefully see, our original magic monkey was overexposed by too much light. To cure 

an overexposure, you must both darken the image and enhance the contrast. 

In the top RGB curve, Darken, only the right side of the curve was lowered; thus, any X input 

along the bottom results in a geometrically less Y output. The Enhance Contrast RGB (S shaped) 
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curve scales the output such that middle values of X change dramatically; namely, the middle 

brightness scale is expanded, and thus, whiter whites and blacker blacks are output. To make this 

curve, simply click on the curve and a new control point is added. Drag the point around to bend 

the curve as you wish. The Mix node combines these two effects equally, and Suzanne feels much 

better. 

Watermark images 

In the olden days, a pattern was pressed into the paper mesh as it dried, creating a mark that 

identified who made the paper and where it came from. The mark was barely perceptible except 

in just the right light. Probably the first form of subliminal advertising. Nowadays, people 

watermark their images to identify them as personal intellectual property, for subliminal 

advertising of the author or hosting service, or simply to track their image’s proliferation throughout 

the web. 

Blender provides a complete set of tools for you to both encode your watermark and to tell if an 

image has your watermark. 

 
Encoding Your Watermark in an Image 

First, construct your own personal watermark. You can use your name, a word, or a shape or image 

not easily replicated. While neutral gray works best using the encoding method suggested, you are free 

to use other colors or patterns. It can be a single pixel or a whole gradient; it is up to you. In the example 

below, we are encoding the watermark in a specific location in the image using the Translate node; 

this helps later because we only have to look at a specific location for the mark. We then use the 

RGB to BW node to convert the image to numbers that the Map Value node can use to make the image 

subliminal. In this case, it reduces the mark to one-tenth of its original intensity. The Add node adds 

the corresponding pixels, make the ones containing the mark ever-so-slightly brighter. 

Title-Img 4. 27Embedding your mark in an Image using a Mark and Specific Position. 

 

 
Source-blender.org Link- 
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https://docs.blender.org/manual/en/dev/render/blender_render/materials/no  

des/types/color/mix_rgb.html?highlight=mix%20node 

Of course, if you want people to notice your mark, do not scale it so much, or make it a 

contrasting color. There are also many other ways, using other mix settings and fancier rigs. Feel 

free to experiment! 

Decoding an Image for your Watermark 

When you see an image that you think might be yours, use the node map below to compare it to your 

stock image (pre-watermarked original). In this map, the Mix node is set to Difference, and the Map 

Value node amplifies any difference. The result is routed to a viewer, and you can see how the original 

mark stands out, clear as a bell: 

 

Title-Img 4. 28 Checking an image for your watermark. 
 

 
Source-blender.org Link- https://docs.blender.org/manual/en/dev/render/blender_render/materials/no 

des/types/color/mix_rgb.html?highlight=mix%20node 

Various image compression algorithms lose some of the original; the difference shows as noise. 

Experiment with different compression settings and marks to see which works best for you by 

having the encoding map in one scene, and the decoding map in another. Use them while 

changing Blender’s image format settings, reloading the watermarked image after saving, to get 

an acceptable result. In the example above, the mark was clearly visible all the way up to JPEG 

compression of 50%. 
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RGB Curves Node 
 
 
 

Title-Img 4. 29RGB Curves Node. 

Source-blender.org Link- 

https://docs.blender.org/manual/en/dev/compositing/types/color/rgb_curves.  html?highlight=rgb%20curves%20node 
 
 
This node allows color corrections for each color channel and levels adjustments in the 

compositing context. 
 

Inputs  

Factor Controls the amount of influence the node exerts on the output image. 

Image Standard image input. 

Black Level Defines the input color that is (linear) mapped to black. 

White Level Defines the input color that is (linear) mapped to white. 

Properties  

Channel Clicking on one of the channels displays the curve for each. C (Combined 

RGB), R (Red), G (Green), B (Blue), L (Luminance) 

Curve A Bézier curve that varies the input levels (x-axis) to produce an output 

level (y-axis). 

Outputs  

Image Standard image output. 
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Examples 

Here are some common curves you can use to achieve desired effects: 
 

Title-Img 4. 30 From left to right: 1. Lighten 2. Negative 3. Decrease Contrast 4. Posterize. 

Attribution- Source-blender.org 

Link- 

https://docs.blender.org/manual/en/dev/compositing/types/color/rgb_curves.html?highlight=rgb%20curves%20node 
 

 
Color correction using Curves 

 

 

 
Title-Img 4. 31Color correction with curves. 

 

 
Source-blender.org Link- 

https://docs.blender.org/manual/en/dev/compositing/types/color/rgb_curves.  html?highlight=rgb%20curves%20node 
 
In this example, the image has way too much red in it, so we run it through an RGB node and 

reduce the Red channel by about half. 

We added a middle dot, so we could make the line into a sideways exponential curve. This kind 

of curve evens out the amount of a color in an image as it reaches saturation. Also, read on for 
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examples of the Darken and Contrast Enhancement curves. 

Color correction using Black/White Levels 
 

 

 

 
Title-Img 4. 32Color correction with Black/White Levels. 

Source-blender.org 

Link-https://docs.blender.org/manual/en/dev/compositing/types/color/rgb_curves.   

html?highlight=rgb%20curves%20node 

Manually adjusting the RGB curves for color correction can be difficult. Another option for color 

correction is to use the Black and White Levels instead, which really might be their main purpose. 

In this example, the White Level is set to the color of a bright spot of the sand in the background, 

and the Black Level to the color in the center of the fish’s eye. To do this efficiently it is best to 

bring up the UV/Image editor showing the original input image. You can thenusethelevels’ color 

picker to easily choose the appropriate colors from the input image, zooming into pixel level if 

necessary. The result can be fine-tuned with the RGB curves like in the previous example. 

The curve for C is used to compensate for the increased contrast that is a side-effect of setting 

Black and White Levels. 

Effects 
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Title-Img 4. 33Changing colors. 

Source-blender.org Link- 

https://docs.blender.org/manual/en/dev/compositing/types/color/rgb_curves.  html?highlight=rgb%20curves%20node 
 
 
Curves and Black/White Levels can also be used to completely change the colors of an image. 

Note that e.g. setting Black Level to red and White Level to blue does not simply substitute black 

with red and white with blue as the example image might suggest. Levels do color scaling, not 

substitution, however, depending on the settings they can result in the described color substitution. 

(What really happens when setting Black Level to pure red and White Level to pure blue is that 

the red channel gets inverted, green gets reduced to zero and blue remains unchanged.) 

Because of this, the results of setting arbitrary Black/White Levels or RGB curves is hard to 

predict, however, can be fun to play with. 

Unit summary 
In this Unit, we have learnt what is Texture and how to 

 map those textures onto your 3D Objects 

 use texture Panels and assign textures with various mapping types 

 create complex shading texture using blending techniques both with colors and 

maps making it more procedural and along with environmental mapping with 

reflection and refractions. 

After learning of this Unit, you can download the Open Source Software available on 

the internet for free of cost to practice the possibilities of creating Materials and 

Texturing. 

Assignment 
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 Texture the 3D Scene appropriately with good high-resolution maps available online, make it 

morepersonalizedthewayyou would decorate your room.

 Use thesekeywords “bedroom designs”, “bedroom furniture” onwww.google.com tocollectthe 

referenceimagetobuild your shadingscene.

Assessment 
 Explain the process of assigning a Texture to 3D Object

 Write a note on Mapping and Warping

 List and Explain the projection types in Texture map

 Differentiate Bump and Normal Maps

 Write a note on Displacement Map

 List any five types of Procedural Textures.

 Name the different types of Node in Blender

 Decode an image for your Watermark
 

 

Resources 
While studying this course, you can browse the following 

internet links for video tutorials and to download the relevant texture maps to assign on the objects 

that you have created and use the same for your assignments. 

Links to Download Open Projects 

The iconic Blender Institute Open Movies. Featuring all the production files, assets, artwork, and 

never-seen-before content. 

https://cloud.blender.org/open-projects 

 wiki.blender.org 

 archive.org 

 www.blender.org 

 docs.blender.org 
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Unit-3 Introduction to Rigging 

Introduction 

Rigging is a process done prior to the Animation. Rigging is a process of taking a static 

mesh, creating an internal digital skeleton, creating a relationship between the mesh and the 

skeleton (known as skinning, enveloping or binding) and adding a set of controls that the animator 

can use to push and pull the character around as if he/she is a puppeteer. 

Most commonly, characters are Rigged before they are animated because if a character 

model doesn't have a Rig, they can't be deformed and moved around. Process of Rigging also 

involves Rigging character or creatures and Objects like car, plane, or a robot. 

In this Unit, you will learn about the process of Rigging and how it is important in designing 

3D animation. 

 

Outcomes 

Upon completion of this unit you will be able to 

 Explain the Usage of Constraints

 Plan for Adding or Removing Constraints

 Describe the Functions of Header

 Explain the term Header, Target, Space, Influence

 Create IK Constraint

 Create Spline IK Constraint

Terminology 
 

 
Constraints Constraints are a fantastic way to add 

sophistication and complexity to a Rig : 

Header A Header sits at the top of every Constraint. 

Target The Target field lets you link the Constraint to a Target Object of 

your choosing : 

Space The frame of reference is called the “space” of the Constraint 

:  

World space Transformation, Rotation and Scale are oriented to the world axes 

Local Space Transformation, Rotation and Scale are oriented to 

the parent Object axe : 
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Influence 

: The influence slider determines how much the Constraint will affect 

the constrained Object 

 
IK Solver Constraint 

 
: 

The Inverse Kinematics Constraint implements the inverse 

kinematics armature posing technique 

 
Spline IK Constraint 

: The Spline IK Constraint aligns a chain of Bones along a curve 

Stretch to Constraint 
 

: 

The Stretch To Constraint causes its owner to rotate and scale its Y 

axis towards its Target. 

Action Constraint 
 

: 

It allows you to control an Action using the transformations of 

another Object. 

Child of Constraint 
 

: 

Child of Constraint is the Constraint version of the standard 

parent/children relationship 

 
Working with Constraints 

Constraints control the behavior of one Object with data from another. It can make the eyes of a 
tennis player track a tennis ball bouncing across the court. It allows the wheels on a bus to all rotate 
together. It helps a dinosaur’s legs bend at the knee automatically. It makes it easy for a hand to 
grip the hilt of a sword and the sword to swing with the hand. 

Constraints, in Blender, work with Object and Bone. 

 

Object Constraint 
 

Title-Img 1. 1 Object Constraints 

Source-blender.org 

Link :https://docs.blender.org/manual/en/dev/rigging/constraints/introduction.html 

Bone Constraint 
 

Title-Img 1. 2 Bone Constraints 

Source-blender.org 

Link https://docs.blender.org/manual/en/dev/rigging/constraints/introduction.html 

Constraints work in combination with each other to form a Constraint Stack. 
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Title-Img 1. 3 Constraint Stack 

Source-blender.org 

Link : https://docs.blender.org/manual/en/dev/rigging/constraints/introduction.html 

The Constraint Stack is evaluated from top to bottom. 

Constraints are a fantastic way to add sophistication and complexity to a Rig. However, be careful 

not to rush in too quickly, piling up Constraint upon Constraint until you lose all sense of how they 

interact with each other. 

Adding/Removing a Constraint 
 

Title-Img 1. 4 Adding/Removing Constraint 

Source-blender.org 

Link:https://docs.blender.org/manual/en/dev/rigging/constraints/interface/adding_ 

removing.html 

To add a Constraint in the Constraints Panel: 

 Step 1: Click on the “Add Constraint” menu. (Refer Img 1.4)
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To add a Constraint in 3D View: 
 Step 2: Select the Object you would like to constrain.

 Step 3: Press Ctrl-Shift-C and choose a Constraint from the pop-up menu.

If the chosen Constraint needs a Target, Blender will add an empty automatically as the Target 

and position it at the center of the constrained Object. 

 
To add a Constraint in 3D View and simultaneously give it a Target: 

 Step 1: Select the Target first and then shift-select the Object you would like to constrain.

 Step 2: Press Ctrl-Shift-C and choose a Constraint from the pop-up menu.

To remove a Constraint: 

 Step 1: Click on the “X” button in the header.

To remove all Constraints from all selected Object(s): 

 Step 2: Click Object ‣ Constraints ‣ Clear Object Constraints in 3D View Header.

 Step 3: Or Pose ‣ Constraints ‣ Clear Pose Constraints (for Bone Constraints).

 Step 4: Or, press Ctrl-Alt-C.

Header 

Every Constraint has a header. The interface elements of the header are explained below using a 

Copy Location Constraint as an example. (Refer Img 1.5) 
 

Title-Img 1. 2 A Header sits at the top of every Constraint. 

Source-blender.org 

Link : https://docs.blender.org/manual/en/dev/rigging/constraints/interface/header. 

 

Expansion Arrow (pointing down or Right) 

Show or Hide the settings of the Constraint. Tidy up the Constraint stack by hiding Constraints 

that do not currently need attention. Constraints will continue to affect the scene even when hidden. 
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 “Copy Location” (first occurrence)
The type of Constraint is determined when a new Constraint is created to help in the process 
of Rigging. 

 “Copy Location” (second occurrence)
Give the Constraint a meaningful name in this field, something that describes its intent. 
Meaningful names help to understand what each Constraint is supposedto do. 

The red background is a warning that the Constraint is not yet functional. The background will 

turn grey when the Constraint is functioning. When this Copy Location Constraint has a valid 

Target in the “Target Field” it will turn grey and begin to function. 

 Eyeball (open or closed)

Enable or Disable (Mute/Unmute) the Constraint. Disabling a Constraint will stop its 
effect on the scene. 

Disabling a Constraint is useful for turning off a Constraint without losing all its settings. Disabling 
means you can enable the Constraint later with the settings intact. Disabling is like setting the 
influence slider to 0.0. 

 Up/Down Arrows

Move a Constraint up or down in the Constraint stack. Since the stack is evaluated from 
top to bottom, moving a Constraint in the stack can significantly affect the final outcome 
of the stack. 

 
If there is only one Constraint in the stack, the arrows will not be drawn. If the Constraint 
is at the top of the stack, only the down arrow will be drawn. If the Constraint is at the 
bottom of the stack, only the up arrow will be drawn. 

Delete the Constraint from the stack. The settings will be lost. The Constraint will no longer 
affect the final outcome of the stack. 

Target 

The Target field lets you link the Constraint to a Target Object of your choosing. This link 

provides data to the Constraint so that it can begin to function. For example, the Copy Location 

Constraint needs location data to function. Fill in the Target field, and the Copy Location 

Constraint will begin to use location data from the Target Object. 

The Target field must be filled in for the Constraint to function. (Refer Img 1.6) 

By default, the Target will use the Object Center as the Target point. 

 If the Target field links to a Mesh or Lattice Object, a Vertex Group field will appear. Enter



219  

the name of a vertex group and the Constraint will Target the median point of this vertex group 

instead of the Object center. 

 If the Target field links to an Armature, a Bone fieldwill appear along with a Head or Tail 

slider. Enter the name of a Bone and the Constraint will Target the Bone instead of the entire 

armature Object center. Slide the slider and the Constraint will Target the head, the tail or 

somewhere in-between.

 

 
Title-Img 1. 3 Target Field. 

Source-blender.org 

Link-https://docs.blender.org/manual/en/dev/rigging/constraints/inter face/common.html 

 

Space 

Constraints need a frame of reference in order to function. This frame of reference is called the 

“space” of the Constraint. Choosing one space vs. another will change this frame of reference 

and substantially alter the behaviour of a Constraint. (Refer Img 1.7) 

To understand how changing the space will change the behaviour of the Constraint, consider 

experimenting with two empties. Makesure they display as arrows so that you can see the local 

axes for each empty. Make sure to size one empty a little larger than the other so that they are 

both always visible even if directly on top of each other. Then add a Constraint to one empty that 

Targets the other and experiment thoroughly by moving, rotating and scaling the Target in many 

different ways. 
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Title-Img 1. 4. Space 

Source-blender.org 

Link:https://docs.blender.org/manual/en/dev/rigging/constraints/interface/c ommon.html 

This Constraint is set to use World Space as the frame of referencefor both its Target Space and 
its Owner Space. 

Influence 

The influence slider determines how much the Constraint willaffect the constrained Object. 
 

 
Title-Img 1. 5 Influence 

Source-blender.org 

Linkhttps://docs.blender.org/manual/en/dev/rigging/constraints/interface/c ommon.html 

 
 An influence of 0.0 will have no effect.

 An influence of 1.0 will have the full effect.

 Values between (0.0 and 1.0), will have a partial effect, however, be careful. These partial 

effectscan be difficult to control, especially as the Constraint stack grows in complexity.

The influence value is animatable, allowing Constraints to be turned off, or partially on as 
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needed. (Refer Img 1.8) 

IK Solver Constraint 

The Inverse Kinematics Constraint implements the inverse kinematics armature posing 
technique. Hence, it is only available for Bones. (Refer Img 1.9) 

 To quickly create an IK Constraint with a Target, select a Bone in pose mode, and press Shift- 
I.

 

Options 
 

Title-Img 1. 6Inverse Kinematics panel. 

Source-blender.org 

Link-https://docs.blender.org/manual/en/dev/rigging/constraints/tracking/ik_solver.html 
 

 
 Target

Must be an armature. 

 
 Bone

A Bone in the armature. 

 Pole Target

Object for pole rotation. 

 Iterations

Maximum number of solving iterations. 

 Chain Length

How many Bones are included in the IK effect? Set to 0 toinclude all Bones. 

 Use Tail
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Include Bone’s tail as last element in chain. 

 Stretch

Enable IK stretching. 

 Weight
 Position

 For Tree-IK: Weight of position control for thisTarget.

 Rotation

 Chain follow rotation of Target.

 Target

Disable for Target-less IK. 

 Rotation

Chain follows rotation of Target. 

 

Spline IK Constraint 

The Spline IK Constraint aligns a chain of Bones along a curve. By leveraging the ease and 

flexibility of achieving aesthetically pleasing shapes offered by curves and the predictability and 

well- integrated control offered by Bones, Spline IK is an invaluable tool in the Riggers’ toolbox. 

It is particularly well suited for Rigging flexible body parts such as tails, tentacles, and spines, 

as well as inorganic items such as ropes. (Refer Img 1.10) 

 
To set up Spline IK, it is necessary to have a chain of connected Bones and a curve to constrain 

these Bones to: 

 Step 1: With the last Bone in the chain selected, add a Spline IK Constraint from the Bone 

Constraints tab in the Properties Editor.

 Step 2: Set the ‘Chain Length’ setting to the number of Bones in the chain (starting from and 

including the selected Bone) that should be influenced by the curve.

 Step 3: Finally, set Target to the curve that should control the curve.
 

 
Options 
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Title-Img 1. 7. Spline IK panel. 

Source-blender.org 

Link :https://docs.blender.org/manual/en/dev/rigging/constraints/tracking/s pline_ik.html 
 
 
 Target

The type of the Target curve. 

 Spline Fitting

 Chain Length
 

How many Bones are included in the chain. 

 Even Division

Ignore the relative length of the Bones when fitting to thecurve. 

 Chain Offset

Offset the entire chain relative to the root joint. 

 Chain Scaling

 Y stretch

Stretch the Y axis of the Bones to fit the curve. 

 XZ Scale Mode

o None 

Do not scale the X and X axes. 

o Bone Original 

Use the original scaling of the Bones. 

o Volume Preservation 
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Scale of the X and Z axes is the inverse of the Yscale. 

 Use Curve Radius

Average radius of the endpoints is used to tweak the X andZ scaling of the Bones, on top of 
the X and Z scale mode. 

 

Stretch to Constraint 

The Stretch To Constraint causes its owner to rotate and scale itsY axis towards its Target. So, 

it has the same tracking behavior as the Track To Constraint. However, it assumes that the Y 

axis willbe the tracking and stretching axis, and does not give you the option of using a different 

one. 

It also optionally has some raw volumetric features, so the owner can squash down as the Target 

moves closer, or thin out as the Target moves farther away. Note that it is not the real volume of 

the owner which is thus preserved, however, rather the virtual one defined by its scale values. 

Hence, this feature works evenwith non-volumetric Objects, like empties, 2D meshes or 

surfaces,and curves. 

 
With Bones, the “volumetric” variation scales them along their own local axes (remember that 
the local Y axis of a Bone is aligned with it, from root to tip). (Refer Img 1.11) 

 
Options 

 

Title-Img 1. 8 Stretch To panel. 

Source-blender.org 

Link: https://docs.blender.org/manual/en/dev/rigging/constraints/track ing/stretch_to.html 
 

 
 Target (Mesh Object Type)
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This Constraint uses one Target, and is not functional (redstate) when it has none. 

 Vertex Group

When Target is a mesh, a new field is display where avertex group can be selected. 

 Target (Armature Object Type)

This Constraint uses one Target, and is not functional (redstate) when it has none. 

 Bone

When Target is an armature, a new field for a Bone isdisplayed. 

 Head/Tail
When using a Bone Target, you can choose where alongthis Bone the Target point lies. 

 Rest Length

This number button sets the rest distance between theowner and its Target, i.e. the distance at 
which there is no deformation (stretching) of the owner. 

 Reset

When clicked, this small button will recalculate the Rest Length value, so that it corresponds to 
the actual distance between the owner and its Target (i.e. the distance before this Constraint is 
applied). 

 Volume

These buttons control which of the X and/or Z axes should be affected (scaled up/down) to 
preserve the virtual volume while stretching along the Y axis. If you enable the none button, the 
volumetric features are disabled. 

 Plane

These buttons are equivalent to the Up ones of the TrackTo Constraint: they control which of 
the X or Z axes should be maintained (as much as possible) aligned with the global Z axis, while 
tracking the Target with the Y axis. 

 

Relationship 

Action Constraint 

The Action Constraint is powerful. It allows you to control anAction using the transformations 

of another Object. 

The underlying idea of the Action Constraint is very similar to the one behind the Drivers, except 

that the former uses a whole action (i.e. a bunch a F-Curves of the same type), while the latter 

controls a single F-curve of their “owner” 

Note that even if the Constraint accepts the Mesh action type, only the Object, Pose and 

Constraint types are really working, as Constraints can only affect Objects’ or Bones’ transform 

properties, and not meshes’ shapes. Also, note that only the Object transformation (location, 
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rotation, scale) is affected by the action, if the action contains keyframes for other properties they 

are ignored, as Constraints do not influence those. 

As an example, let us assume you have defined an Object action (it can be assigned to any Object, or even 

no Object at all), and have mapped it on your owner through an Action Constraint, so that moving the 

Target in the (0.0 to 2.0) range along its X-Axis maps the action content on the owner in the (0 to 100) 

frame range. This will mean that when the Target’s X property is 0.0 the owner will be as if in frame 0 of 

the linked action; with the Target’s X property at 1.0 the owner will be as if in frame 50 of thelinked 

action, etc. (Refer Img 1.12) 

Options 

 
Title-Img 1. 9 Action panel. 

Source-blender.org 

Linkhttps://docs.blender.org/manual/en/dev/rigging/constraints/relationship/action.html 

 Target

This Constraint uses one Target, and is not functional (redstate) when it has none. 

 Bone

When Target is an armature Object, use this field to selectthe Target Bone. 

 Transform Channel

This selector controls which transform property (location, rotation or scale along/around one of 
its axes) from the Target to use as “action driver”. 

 Target Space

This Constraint allows you to choose in which space toevaluate its Target’s transform properties. 

 To Action

Select the name of the action you want to use. 

 
 Object Action

Bones only, when enabled, this option will make the constrained Bone use the “Object” part of the 
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linked action, instead of the “same-named pose” part. This allowsyou to apply the action of an 
Object to a Bone. 

 Target Range Min/Max

The lower and upper bounds of the driving transform property value. 

 
 Action Range Start/End

The starting and ending frames of the action to be mapped. 

Child of Constraint 
 

Child of Constraint is the Constraint version of the standard parent/children relationship 

between Objects (the one establishedthrough the Ctrl-P shortcut, in 3D Views). 

Parenting with a Constraint has several advantages and enhancements, compared to the traditional method: 

(Refer Img 1.13) 

You can have several different parents for the sameObject (weighting their respective influence 

with the Influence slider). 

As with any Constraint, you can key (i.e. animate)its Influence setting. This allows the Object 

which has a Child of Constraint upon it to change over time which Target Object will be 

considered theparent, and therefore have influence over the Child of Constraint Object. 

 
Options 

 
Title-Img 1. 10 Child Of panel 

Source-blender.org 

Link- https://docs.blender.org/manual/en/dev/rigging/constraints/relationship/child_of.html 

 Target

The Target Object that this Object will act as a child of. ThisConstraint uses one Target, and is not 
functional (red state)when it has none. If Target is an armature or a mesh, a newname field appears 
where a name of a Bone or a Vertex Group can be selected. 

 Location X, Y, Z

Each of these buttons will make the parent affect or not affect the location along the corresponding 
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axis. 

 Rotation X, Y, Z

Each of these buttons will make the parent affect or not affect the rotation around the corresponding 
axis. 

 Scale X, Y, Z

Each of these buttons will make the parent affect or not affect the scale along the corresponding 
axis. 

 Set Inverse

By default, when you parent your owner to your Target,the Target becomes the origin of the 
owner’s space. This means that the location, rotation and scale of the owner are offset by the same 
properties of the Target. In other words, the owner is transformed when you parent it to your 
Target. This might not be desired! So, if you want to restore your owner to its before-parenting 
state, click on the Set Inverse button. 

 Clear Inverse

This button reverses (cancels) the effects of the above one,restoring the owner/child to its default 
state regarding its Target/parent. 

 
Technical Note 

If you use this Constraint with all channels on, it will use a straight matrix multiplication for the 
parent relationship, not decomposing the parent matrix into loc /rot/size. This ensures any 
transformation correctly gets applied, also for combinations ofrotated and non-uniform scaled 
parents. 

 

Unit summary 
In this Unit, you have learnt what is Rigging and how to 

 Use the Constraints

 
 Do Adding or Removing Constraints

 
 Describe the Functions of Header

 
 Explain the term Header, Target, Space, Influence

 
 Edit the Properties of the Header panel, working on Parentand Child relationship

 
 Create IK Constraint

 
 Create Spline IK Constraint
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After learning this Unit, you can download the Open Source Software available on the internet 

for free of cost to practice the possibilities of creating Rig. 

 

Assignment 
 Create a basic Mechanical Rig referring to the YouTube video link

 

Assessment 
 Define Constraints. 

 State the Differentiate between Local space and World space. 

 Write notes on Adding and Deleting Constraints withexamples. 

 Describe the Process of making a Parent Constraint. 

 Write a brief note on the uses of Header. 

 Explain Parent and Child Constraint. 

 Write down the process of Creating Spline IK. 

 Define Stretch Constraint 

 
Fill in the Blanks 

 
 

1.   is a good first Constraint to explore in thebeginning. 

2.  sits at the top of every Constraint. 

3.  Enables or Disables (Mute/Unmute) theConstraint. 

4.  allows you to control an Action using thetransformations of 
another Object. 

5. The slider determines how much theConstraint will affect the 
constrained Object. 

 

Resources 
While studying this Unit, you can browse the internet links for online video tutorials and several 

books and training DVDs available in the Blender Store and on the Blender Cloud. 

 wiki.blender.org

 archive.org

 www.blender.org

 docs.blender.org
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Unit-4 Introduction to Working with Armature 

Introduction 
An Armature in Blender is similar to the Armature of a real skeleton. Just like a real skeleton, 
an Armature can consist ofmany Bones. These Bones can be moved around and anythingthat 
they are attached to or associated with will move and deform in a similar way. An “Armature” is 
a type of Object used for rigging. Armature Object borrows many ideas from real life skeletons. 

As Armatures are designed to be posed, either for a static oranimated scene, they have a specific 
state, called “rest position”. This is the Armature’s default “shape”, the default 
position/rotation/scale of its Bones, as set in Edit mode. 

In Edit mode, you will always see your Armature in rest position, whereas in Object and Pose 
mode, you usually get the current “pose” of the Armature (unless you enable the Rest Position 
button of the Armature panel). 

This unit will describe how you can work with Armatures in Blender. 

Outcomes 
Upon completion of this unit you will be able to: 

 Explain the Usage of Bones

 List the types of Armature structure

 Manage to Edit an Armature

 Arrange Linking Objects to Bone

 Set up Mesh and Armature using Skinning

 Create Poses for the Rigged Character

Terminology 
 

Armatures : Armature is the Object type used for rigging and it borrows many 
ideas from real life skeletons 

Roll : Activating Axes checkbox on the will show localaxes for each Bone’s 

tip. 

Bones Influence : Basically, a Bone controls geometry when 
vertices “follow” the Bone 

Armature Layers : Each Armature has 32 “Armature layers” which allow you to organize 

your Armature by “regrouping” sets of Bones into layers. 

Octahedral Bone : This is the default visualization, well suited formost of editing tasks. 

Stick Bone : This is the simplest and most non-intrusivevisualization. 

B-Bone Bone : This visualization shows the curves of “smooth” multi-segmented 

Bones; see the Bendy Bones for details. 

Envelope Bone : This visualization materializes the Bone deformation 

influence. 

Pose Library : The Pose Library panel is used to save, apply,and manage different 
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  Armature poses. 

Ghost : In traditional cartoon creation animators use tracing paper, to see 

several frames preceding the one they are working. 

Shadow : Controls how objects using this Material castand receive shadows. 

Structure : Armatures mimic real skeletons. They are made from Bones, which are 

(by default) rigid elements. 

Chains of Bones : Bone can be the parent of several children, andhence be part of 
several chains at the same 
time. 

 
Working with Armature 
First, let us try to add the default Armature in Blender. 

 Step 1: Open a default scene.

 Step 2: Delete all Objects in the scene.

 Step 3: Make sure the cursor is in the world originwith Shift-C.

 Step 4: Press Numpad1 to see the world in Frontview.

 Step 5: Add a Single Bone (Add ‣ Armature ‣ SingleBone).

 Step 6: Press Numpad Delete to see the Armatureat maximum zoom.
 

 
Title-Img 2. 1 The default Armature. 

Source- blender.org 

Link- https://docs.blender.org/manual/en/dev/rigging/armatures/intro duction.html 

 
Armature Object 

As you can see, an Armature is like any other Object type inBlender: 

 It has a center, a position, a rotation and a scale factor.
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 It has an Object Data data-block that can be edited in Edit Mode.

 It can be linked to other scenes, and the same Armature data can be reused on multiple 

Objects.

 All animation you do in Object Mode is only working on thewhole Object, not the

Armature’s Bones (use the PoseMode to do this). 

 As Armatures are designed to be posed, either for a static or animated scene, they have 

a specific state, called “rest position”. This is the Armature’s default “shape”, the 

default position/rotation/scale of its Bones, as set in Edit Mode.

 In Edit Mode, you will always see your Armature in rest position, whereas in Object 

Mode and Pose Mode, you usually get the current “pose” of the Armature (unless you 

enable the Rest Position button of the Armature panel).

Bones Structure 

 

Title-Img 2. 2 The elements of a Bone. 

Source- blender.org 

Link- https://docs.blender.org/manual/en/dev/rigging/armatures/bones/stru cture.html 

 
They have three elements: 

 
1. “Start joint” named Root or Head, 

2. “Body” itself, 

3. “End joint” named Tip or Tail. 

 
With the default Armature in edit-mode, you can select the root and the tip, and move them as you 
do with mesh vertices. Both root and tip (the “joints”) define the Bone by their respective position. 

They also have a radius property, only useful for the envelope deformation method. 

Roll 

Activating Axes checkbox on the Armature tab ‣ Display panel, will show local axes for each 
Bone’s tip. The Y axis is always aligned along the Bone, oriented from root to tip. So, this is the 
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“roll” axis of the Bones. 

Bones Influence 
 

 
Title-Img 2. 3 A Bone in Envelope visualization, in Edit Mode. 

Source-blender.org 

Link- https://docs.blender.org/manual/en/dev/rigging/armatures/bones/stru cture.html 

 
Basically, a Bone controls geometry when vertices “follow” the Bone. This is like how the 
muscles and skin of your finger follow your finger-Bone when you move a finger. 

To do this, you must define the strength of influences a Bone has on a certain vertex. 

The simplest way is to have each Bone affecting those parts of the geometry that are within a given 
range from it. This is called the Envelope Technique, because each Bone can control only the 
geometry “enveloped” by its own influence area. 

If a Bone is visualized as Envelope, in Edit Mode and in Pose Mode you can see the area of 
influence, which depends on: 

 The Distance Property and

 The Root’s Radius and the Tip’s Radius.
 

Title-Img 2. 4 Our Armature in Envelope visualization, in Pose Mode. 

Source- blender.org 

Linkhttps://docs.blender.org/manual/en/dev/rigging/armatures/bones/st ructure.html 
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Selection of Bones 

You can select and edit Bones of Armatures in Edit Mode and in Pose Mode. Here, we will see 
how to select Bones in Edit Mode. Selecting Bones in Pose Mode is similar to selecting in Edit 
Mode with a few specific differences that will be detailed in the posing part. 

Similar to vertices/edges selection in meshes, there are two ways to select whole Bones in Edit 
Mode: 

 Directly, by selecting the Bone’s body.

 Selecting both of its joints (roots and tip).

This is an important point to understand, because selecting Bones’joints only might lead to non- 
obvious behavior, with respect to which Bone you actually select. 

Selecting Bone Joints 

To select Bones’ joints, you have the standard selectionmethods. 

 Inverse selection 

As stated above, you must remember that these selection tools are for Bones’ joints only, not the 
Bones’ bodies. 

For example, the Inverse selection option Ctrl-I inverts the selection of Bones’ joints, not of 
Bones. 

Remember that a Bone is selected only if both its joints areselected. So, when the selection status 
of Bones’ joints is inverted, a new set of Bones is selected. 

 

Title-Img 2. 5 Two Bones selected. 

Source- blender.org 

Link- https://docs.blender.org/manual/en/dev/rigging/armatures/bones/se lecting.html 
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Title-Img 2. 6 The result of the inverse selection Ctrl-I the Bones 

joints selection has been inverted, and not the Bones selection. 

Source- blender.org 

Linkhttps://docs.blender.org/manual/en/dev/rigging/armatures/bones/se lecting.html 

 
Selecting connected Bone Joints 

Another Example: when you select the root of a Boneconnected to its parent, you also implicitly 

select the tip ofits parent (and vice versa). 

 
Selecting Bones 

By RMB clicking on a Bone’s body, you will select it (and hence you will implicitly select its root 

and tip). 

Using Shift-RMB, you can add to/remove from the selection. 

You also have some Advanced Selection options, based on their relations. 

You can select at once all the Bones in the chain which the active (last selected) Bone belongs to 

by using the linked selection tool, L. 

Linked Bones selection 
 

 
Title-Img 2. 7 A single selected Bone. 
Source- blender.org 
Link:https://docs.blender.org/manual/en/dev/rigging/armatures/bones/sele cting.html 
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Title-Img 2. 8 Its whole chain selected with L. 

Source- blender.org 

Link- https://docs.blender.org/manual/en/dev/rigging/armatures/bone s/selecting.html 

 
 Mirror Shift-Ctrl-M

 Flip the selection from one side to another.

 Pick Shortest Path Ctrl-RMB

 Selects the path from the active Bone to the Boneunder the mouse

 Deselecting connected Bones

There is a subtlety regarding connected Bones. 

When you have several connected Bones selected, if you deselect one Bone, its tip will be deselected, 

however, not its root, if it is also the tip of another selected Bone. 

To understand this, look at Img 2.9 Bone deselection in a selected chain. 

Bone deselection in a selected chain. 
 

Title-Img 2. 9 A selected chain. 

Source- blender.org 

Link- https://docs.blender.org/manual/en/dev/rigging/armatures/bones/sele cting.html 
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Title-Img 2. 10 Two selected Bones. 

Source- blender.org 

Link- https://docs.blender.org/manual/en/dev/rigging/armatures/bones/sele cting.html 

 
 After Shift-RMB -clicking “Bone.003”:

 “Bone.003” ‘s tip (which is same as “Bone.004” ‘s root) is deselected.

 “Bone” is “Bone.003” ‘s parent. Therefore “Bone.003” ‘s root is same as the tip of 

“Bone”. Since “Bone” is still selected, its tip is selected. Thus, the root of “Bone.003” 

remains selected.

 Mouse Clicks

 Reference

 Mode: Edit Mode

 Hotkey: Ctrl-LMB

 
If at least one Bone is selected, Ctrl-LMB -clicking adds a new Bone. 

About the new Bone’s tip: 

After you Ctrl-LMB -clicked it becomes the Active Element in the Armature, 

It appears to be right where you clicked, however, (As in mesh editing) it will be on the plane 

parallel to the viewand passing through the 3D cursor. 

The position of the Root and the parenting of the newBone depends on the Active Element. 

 
Active Element 

 
If the Active Element is a Bone 

The new Bone’s Root is placed on the Active Bone’s tip 

The new Bone is parented and connected to the Active Bone (check the Outliner in Img 2.11 Ctrl- 

clicking when the Active Element is a Bone.). 
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Title-Img 2. 11 Ctrl-clicking when the Active Element is a Bone. 

Source- blender.org 

Linkhttps://docs.blender.org/manual/en/dev/rigging/armatures/bones/editi ng/bones.html 
 
 
If the Active Element is a Tip 

The new Bone’s root is placed on the Active Tip 

The new Bone is parented and connected to the Bone owning the Active Tip (check the Outliner 

in Img 2.12 Ctrl- clicking when the Active Element is a tip.). 

 
Title-Img 2. 12 Ctrl-clicking when the Active Element is a tip. 

Source- blender.org 

Link- https://docs.blender.org/manual/en/dev/rigging/armatures/bones/editi ng/bones.html 

 

If the Active Element is a Disconnected Root: 

The new Bone’s root is placed on the Active Root 

The new Bone is not parented to the Bone owning the Active Root (check the Outliner in Img 2.13 Ctrl- 

clicking when the Active Element is a disconnected root.). 

And hence the new Bone will not be connected to any Bone 
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X 

 

Title-Img 2. 13 Ctrl-clicking when the Active Element is a disconnected root. 

Source-blender.org 

Link-https://docs.blender.org/manual/en/dev/rigging/armatures/bone s/editing/bones.html 

 

If the Active Element is a Connected Root: 
The new Bone’s root is placed on the Active Root 

The new Bone is parented and connected to the parent of the Bone owning the Active Root (check 

the Outliner in Img 2.14 Ctrl-clicking when the Active Element is a connected root.). 

This should be obvious because if the Active Element is a connected root then the Active Element 

is also the tip of the parent Bone, so it is the same as the second case. 

As the tip of the new Bone becomes the Active Element, you can repeat these Ctrl-RMB several 

times, to consecutively add several Bones to the end of the same chain. 

 

Title-Img 2. 14 Ctrl-clicking when the Active Element is a connected root. 

Source-blender.org 

Link-https://docs.blender.org/manual/en/dev/rigging/armatures/bones/editi ng/bones.html 

Delete Selected Bone(s) 
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Hotkey: 

This tool deletes selected Bones, selected joints are ignored. 
 
 

 
If you delete a Bone in a chain, its child(ren) will be automatically re-parented to its own 

parent, however, not connected, to avoid deforming the whole Armature. 
 
Merge Bones 

 
Hotkey: Alt-M 

You can merge together several selected Bones, as long as they form a chain. Each sub-chain 

formed by the selected Bones will give one Bone, whose root will be the root ofthe root Bone, 

and whose tip will be the tip of the tip Bone. 

Subdivide Bones 

 
You can subdivide Bones, to get two or more Bones where there was just one Bone. The tool will 

subdivide all selected Bones, preserving the existing relationships: the Bones created from a 

subdivision always form a connected chain of Bones. 

Naming Conventions 

Naming conventions in Blender are not only useful for you in finding the right Bone, however, 

also to tell Blenderwhen any two of them are counterparts. 

In case your Armature can be mirrored in half (i.e. it is bilaterally symmetrical), it is worthwhile 

to stick to a left/right naming convention. This will enable you to use some tools that will 

probably save your time and effort(like the X-Axis Mirror editing tool we saw above...). 
 

Title-Img 2. 15 An example of left/right Bone naming in a simple rig. 
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Source-blender.org 

Link-https://docs.blender.org/manual/en/dev/rigging/armatures/bones/editi ng/naming.html 

Structure 

Armatures mimic real skeletons. They are made out of Bones, which are (by default) rigid 

elements. However, you have more possibilities than with real skeletons: In addition to the 

“natural” rotation of Bones, you can also translate and even scale them! And your Bones do not 

have to be connected to each other; they can be completely free if you want. However, the most 

natural and useful setups imply that some Bones are related to others, forming so-called “chains of 

Bones”. 

 

 
Title-Img 2. 16 Example of a very basic Armature. 

Source- 

Link- http://blender-manual- i18n.readthedocs.io/ja/latest/rigging/armatures/structure.html 
 

 
Chains of Bones 

The Bones inside an Armature can be completely independent from each other (i.e. the 

modification of one Bone does not affect the others). However, this is not oftena useful set up: To 

create a leg, all Bones “after” the thigh Bone should move “with” it in a well-coordinated manner. 

This is exactly what happens in Armatures by parenting a Bone to the next one in the limb, you 

create a “chains of Bones”. These chains can be ramified. For example, five fingers attached to a 

single “hand” Bone. 
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Skinning 

In Blender, you have two main skinning types: 

1. You can Parent/Constrain Objects to Bones - then, when you transform the Bones in 

Pose Mode, their “children” Objects are also transformed, exactly as with a standard 

parent/children relationship... The “children” are never deformed when using this method. 

2. You can Using the Armature Modifier on entire Mesh, and then, some parts of this Object 

to some Bonesinside this Armature. This is the more complex and powerful method, and 

the only way to really deform the geometry of the Object, i.e. to modify its vertices/control 

points relative positions. 

Armature Deform Parent 

Hotkey: Ctrl-P 
Armature Deform Parenting is a way of creating and setting up an Armature Modifier. 

To use Armature Deform Parenting, you must 

 Step 1: First select all the child Objects that will beinfluenced by the Armature 

 Step 2: Lastly, select the Armature Object itself. 

 Step 3: Once all the child Objects and the Armatureare selected press Ctrl-P 

 Step 4: Select Armature Deform in the Set ParentTo pop-up menu. 

 
The Armature will be the parent Object of all the other child Objects and each child Object will 

have an Armature Modifier with the Armature associated (Object field). 

 

Title-Img 2. 17 Bone associated with Mesh Object. 

Source- 

Link- https://docs.blender.org/manual/en/dev/rigging/armatures/skinning/pa renting.html 
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With Empty Groups 

When parenting, it will create empty vertex groups on the child Objects (if they do not already 

exist) for and named after each deforming Bone in the Armature. The newly created vertex groups 

will be empty this means they will not have any weights assigned. Vertex groups will only be 

created for Bones which are setup as deforming (Properties Editor ‣ Bone ‣ Deform Panel). 

You can then manually select the vertices and assign them to a particular vertex group that you are 

choosing to have Bones in the Armature influence. 

Choose this option if you have already created (and weighted) allthe vertex groups the mesh 

requires. 

Example 

For example, if you have an Armature which consists of three Bones named “Bone A”, “Bone B” 

and “Bone C” and cube mesh called “Cube”. If you parent the cube to the Armature the cube 

will get three new vertex groups created on it called “Bone A”, “Bone B” and “Bone C”. Notice 

that each vertex group is empty. 
 

 
Title-Img 2. 18 Cube in Edit Mode using Armature Deform with empty groups. 

Source 

Link- https://docs.blender.org/manual/en/dev/rigging/armatures/skinning/pa renting.html 

 

With Automatic Weights 
With Automatic Weights, parenting works similar to With Empty Groups, however, it will not 

leave the vertex groups empty. It calculates how much influence a particular Bone would have on 

vertices based on the distance from those vertices to a particular Bone (“Bone heat” algorithm). 

This influence will be assigned as weights in the vertex groups. 
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This method of parenting is certainly easier setup; however, it can often lead to Armatures which 

do not deform child Objects in ways you would want. Overlaps can occur when it comes to 

determining which Bones should influence certain vertices when calculating influences for more 

complex Armatures and child Objects. Symptoms of this confusion are that when transforming 

the Armature in Pose Mode parts of the child Objects do not deform as you expect; If Blender 

does not give you the results you require you will have to manually alter the weights of vertices in 

relation to the vertex groups they belong to and have influence in. 

With Envelope Weights 

With Envelope Weights, parenting works in a similar way like Automatic Weights. The difference 

is that the influences are calculated based on the Bone Envelopes settings. It will assign to each 

vertex groups the vertices that are inside its Bone’s influence volume, weighted depending on their 

distance to this Bone. 

This means newly included/excluded vertices or new envelope settings will not be taken into 

account. You will have to apply Armature Deform with Envelope Weights parenting again. 
 

Title-Img 2. 19 Two sets of Armatures each with three Bones. 

Source- 

Link-https://docs.blender.org/manual/en/dev/rigging/armatures/skinning/parenting.html 

Unit summary 
In this Unit, you have learnt 

 To Create and edit different types of Bones and apply it todifferent mesh 

 Types of Armature structure 

 To Edit an Armature 

 To Arrange Linking Objects to Bone 
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 To Set up Mesh and Armature using Skinning 

 To Create Poses for the Rigged Character 

 To Skin the mesh to the Bones 

 To Add and remove influence for a Bone 

 After learning this Unit, you can download the Open Source Software available on 

the internet for free of cost topractice the possibilities of creating 3D Objects. 

Assignment 
Create a Basic Primitive Human Rig referring to the Youtube video link 

Assessment 
 Explain Armature in Blender 

 Describe the Deforming Bones 

 Write a brief note on Bone influence 

 Explain five different Processes of Editing Bones 

 Write a brief note on Bone structure 

 Explain the process of skinning with examples 

 
Fill in the Blanks 

1.  are directly involved in altering the positions of vertices associated with 
their Bones. 

2.  can be seen when the Bone is in edit mode. 
 

3. Using command on the keyboard, you can add to/remove from the 
selection. 

4. If at least one Bone is selected, clicking adds a new Bone. 

 
5. In 3D View, clicking will add a new Bone to your 

Armature. 

Resources 
While studying this Unit, you can browse the internet links for online video tutorials and several 

books and training DVDs available in the Blender Store and on the Blender Cloud. 

 wiki.blender.org 

 archive.org 

 www.blender.org 

 docs.blender.org 



 

 
 
 

 

 

 


